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Notice:
OMRON products are manufactured for use according to proper procedures by a qualified operator
and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautions in this manual. Always heed
the information provided with them. Failure to heed precautions can result in injury to people or dam-
age to the product.

DANGER Indicates information that, if not heeded, is likely to result in loss of life or serious injury.

WARNING Indicates information that, if not heeded, could possibly result in loss of life or serious injury.

Caution Indicates information that, if not heeded, could result in relatively serious or minor injury, dam-
age to the product, or faulty operation.

OMRON Product References
All OMRON products are capitalized in this manual. The word “Unit” is also capitalized when it refers
to an OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “Ch,” which appears in some displays and on some OMRON products, often means
“word” and is abbreviated “Wd” in documentation in this sense.

The abbreviation “PLC” means Programmable Controller and the abbreviation “PC” means personal
computer and are not used as abbreviations for anything else.

The abbreviation “PSB” stands for Protocol Support Board and is also used to indicate the Commu-
nications Board.

Visual Aids
The following headings appear in the left column of the manual to help you locate different types of
information.

Note Indicates information of particular interest for efficient and convenient operation
of the product.

1, 2, 3... 1. Indicates lists of one sort or another, such as procedures, checklists, etc.

 OMRON, 1997
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any
form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permis-
sion of OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is
constantly striving to improve its high-quality products, the information contained in this manual is subject to change
without notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no
responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the informa-
tion contained in this publication.
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About this Manual:

This manual describes the installation and operation of the Protocol Support Tool and includes the sec-
tions described below.

This is one of two manuals provided for the Protocol Support Boards. The other manual is the C200HW-
COM01 to C200HW-COM06-E Communications Board Operation Manual, and it is provided separately.
The C200HX/C200HG/C200HE Operation Manual and Installation Guide may also be required when de-
veloping actual applications.

This manual is intended for the following personnel:

Personnel in charge of installing FA devices
Personnel designing FA systems
Personnel managing FA facilities

Please read this manual carefully and be sure you understand the information provided before attempting
to install and/or operate the Protocol Support Tool. Be sure to read the precautions provided in the
following section.

Section 1 Introduction outlines the Protocol Macro function and the SYSMAC-PST.

Section 2 Environment/Installation/Uninstallation/Starting/Editing outlines the functions of
SYSMAC-PST and describes the operating environment, installation procedure, and the setting of the
usage environment.

Section 3 Protocol Macro describes details of the Protocol Macro functions.

Section 4 Using the Protocol Macro Function describes various precautions in using the Protocol Mac-
ro function.

Section 5 Other Functions describes monitoring PLC words and tracing transmission lines.

Section 6 Hardware Configuration describes the hardware settings that can be configured for
SYSMAC--PST.

Section 7 Protocol Creation and Ending describes how to edit and manage protocols and sequences.

Section 8 Editing Send & Receive message and Receive Matrices describes editing and managing
send/receive messages and receive matrices.

Section 9 Managing Protocol Data describes how to manage, save, and retrieve protocol data that has
been created, and how to transfer the protocol data to the PLC.

Section 10 Trace/Monitor describes monitoring PLC words and the transmission line tracing.

Section 11 Help System describes the on--line help services provided with SYSMAC--PST.

Section 12 Troubleshooting describes the symptoms of errors and the methods for handling them.

Appendix A Creating the Protocol Applications shows some examples of data transmission between
personal computers using the Protocol Macro function.

WARNING Failure to read and understand the information provided in this manual may result in
personal injury or death, damage to the product, or product failure. Please read each
section in its entirety and be sure you understand the information provided in the section
and related sections before attempting any of the procedures or operations given.

!
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PRECAUTIONS

This section provides general precautions for using the Programmable Controller (PLC) and related devices.

The information contained in this section is important for the safe and reliable application of the PLC. You must read
this section and understand the information contained before attempting to set up or operate a PLC system.

1 Intended Audience xiv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2 General Precautions xiv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
3 Safety Precautions xiv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4 Operating Environment Precautions xiv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5 Application Precautions xv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6 Software Operating Procedures xvi. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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1 Intended Audience
This manual is intended for the following personnel, who must also have knowl-
edge of electrical systems (an electrical engineer or the equivalent).
• Personnel in charge of installing FA systems.
• Personnel in charge of designing FA systems.
• Personnel in charge of managing FA systems and facilities.

2 General Precautions
The user must operate the product according to the performance specifications
described in the operation manuals.
Before using the product under conditions which are not described in the manual
or applying the product to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement
machines, safety equipment, and other systems, machines, and equipment that
may have a serious influence on lives and property if used improperly, consult
your OMRON representative.
Make sure that the ratings and performance characteristics of the product are
sufficient for the systems, machines, and equipment, and be sure to provide the
systems, machines, and equipment with double safety mechanisms.
This manual provides information for programming and operating OMRON
PLCs. Be sure to read this manual before attempting to use the software and
keep this manual close at hand for reference during operation.

WARNING It is extremely important that a PLC and all PLC Units be used for the specified
purpose and under the specified conditions, especially in applications that can
directly or indirectly affect human life. You must consult with your OMRON
representative before applying a PLC System to the abovementioned
applications.

3 Safety Precautions

WARNING Never attempt to disassemble any Units while power is being supplied. Doing so
may result in serious electrical shock or electrocution.

WARNING Never touch any of the terminals while power is being supplied. Doing so may
result in serious electrical shock or electrocution.

4 Operating Environment Precautions
Do not operate the control system in the following places.
• Where the PLC is exposed to direct sunlight.
• Where the ambient temperature is below 0°C or over 55°C.
• Where the PLC may be affected by condensation due to radical temperature

changes.
• Where the ambient humidity is below 10% or over 90%.
• Where there is any corrosive or inflammable gas.
• Where there is excessive dust, saline air, or metal powder.
• Where the PLC is affected by vibration or shock.
• Where any water, oil, or chemical may splash on the PLC.

Operating Environment Precautions 4
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Caution The operating environment of the PLC System can have a large effect on the
longevity and reliability of the system. Improper operating environments can
lead to malfunction, failure, and other unforeseeable problems with the PLC
System. Be sure that the operating environment is within the specified condi-
tions at installation and remains within the specified conditions during the life of
the system.

5 Application Precautions
Observe the following precautions when using the PLC.

WARNING Failure to abide by the following precautions could lead to serious or possibly
fatal injury. Always heed these precautions.

• Always ground the system to 100 Ω or less when installing the system to pro-
tect against electrical shock.

• Always turn off the power supply to the PLC before attempting any of the fol-
lowing. Performing any of the following with the power supply turned on may
lead to electrical shock:

• Mounting or removing any Units (e.g., I/O Units, CPU Unit, etc.) or memory
cassettes.

• Assembling any devices or racks.

• Connecting or disconnecting any cables or wiring.

Caution Failure to abide by the following precautions could lead to faulty operation or the
PLC or the system or could damage the PLC or PLC Units. Always heed these
precautions.

• Use the Units only with the power supplies and voltages specified in the opera-
tion manuals. Other power supplies and voltages may damage the Units.

• Take measures to stabilize the power supply to conform to the rated supply if it
is not stable.

• Provide circuit breakers and other safety measures to provide protection
against shorts in external wiring.

• Do not apply voltages exceeding the rated input voltage to Input Units. The
Input Units may be destroyed.

• Do not apply voltages exceeding the maximum switching capacity to Output
Units. The Output Units may be destroyed.

• Always disconnect the LG terminal when performing withstand voltage tests.

• Install all Units according to instructions in the operation manuals. Improper
installation may cause faulty operation.

• Provide proper shielding when installing in the following locations:

• Locations subject to static electricity or other sources of noise.

• Locations subject to strong electromagnetic fields.

• Locations subject to possible exposure to radiation.

• Locations near to power supply lines.

• Be sure to tighten Backplane screws, terminal screws, and cable connector
screws securely.

• Do not attempt to take any Units apart, to repair any Units, or to modify any
Units in any way.

Application Precautions 5
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Caution The following precautions are necessary to ensure the general safety of the sys-
tem. Always heed these precautions.

• Provide double safety mechanisms to handle incorrect signals that can be
generated by broken signal lines or momentary power interruptions.

• Provide external interlock circuits, limit circuits, and other safety circuits in
addition to any provided within the PLC to ensure safety.

6 Software Operating Procedures
Observe the following precautions when using the Support Tool.

WARNING Confirm safety at the destination node before transferring a protocol to another
node or editing the I/O area. Doing either of these without confirming safety may
result in injury.

Caution Check the user protocol for proper execution before actually running it in the
Unit. Not checking the protocol may result in an unexpected operation.

Caution Confirm that no adverse effect will occur in the system before changing the oper-
ating mode of the PLC. Not doing so may result in an unexpected operation.

Caution Confirm that no adverse effect will occur in the system before changing the pres-
ent value of any word in the memory area. Not doing so may result in an unex-
pected operation.

Caution Confirm that no adverse effect will occur in the system before transferring the
communications port A/B settings to the Protocol Support Boards (PSB).

Caution The SYSMAC-PST and SYSMAC-CPT cannot be connected online when using
both at the same time. If the SYSMAC-CPT has been started and connected on-
line, therefore, set the SYSMAC-CPT offline and then connect the SYSMAC-
PST online. When connecting the SYSMAC-CPT online, set the SYSMAC-PST
offline and then connect the SYSMAC-CPT online.

Software Operating Procedures 6
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1-1 Protocol Support Tool Outline
The Protocol Support Tool is the software for creating a procedure (or protocol)
for sending or receiving data to or from general-purpose external devices con-
nected to a Protocol Support Board (PSB) through RS-232C or RS-485/422.
A protocol consists of a set of communications sequences. The system sends a
protocol to the PSB, specifies the sequence number of the protocol using the
PMCR instruction on the CPU unit, and executes the communications se-
quence.
The communications sequence consists of several steps and allows the user to
iterate, branch, or end these steps according to the result of the process.

Protocol Support Board

Protocol
Support
Board
Service

1-2 Features
1-2-1 Features of the Protocol Macro Function
Support for a wide range of communications protocols

Supports communications with almost all external general-purpose devices that
have RS-232C or RS-422/485 ports and support half-duplex and start-stop syn-
chronization mode (refer to Section 4-1 for restrictions).

Creation of send frames and receive (expected) frames according to the desired communications
frame specifications

Enables creation of almost all send frames (frames composed of commands,
data, and so on) and receive (expected) frames (frames composed of re-
sponses and so on) according to the communications frame (message) specifi-
cations of external devices.

Support for operation functions relating to communications
Supports error check code calculation, frame length calculation during trans-
mission process, and numeral data conversion between ASCII and HEX.

Support for the send and receive time monitoring function
Supports the receive wait monitoring, receive finish monitoring, and send finish
monitoring functions. This function lets you specify whether to finish send/re-
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ceive process or to start retry process when those monitoring times are exceed-
ed.

Support for retry process
Lets you specify, only by specifying the number of retries, whether to automati-
cally execute send/receive retries when an error occurs.

Integration of variables for read/write process with PLC into send frames and receive (expected)
frames

Enables integration of variables for read process from PLC’s I/O memory into
send frames (messages) themselves. Data in the PLC that has been read during
transmission process can be used for addresses (destinations) or data. This
function also enables integration of variables for write process to PLC’s I/O
memory into receive frames (messages) themselves. Addresses (destinations)
or data can be written into the PLC during receive process.

Easy realization of rich functions including 1:N communications and switching data write
destinations, using repetition variables

Lets you specify repeat variables for send/receive process (repeat counter) in
variables. With this function, a wide variety of process can be easily realized: for
example, sending the same data to multiple addresses (destinations) by switch-
ing them during 1:N communications; switching write destination addresses in
PLC’s I/O memory during data receive process.

Enhanced functions of the protocol macro function
In addition to the conventional features of the protocol macro function, the fol-
lowing enhanced functions are provided.
Notice that the following functions are available only when your PSB is the
C200HW-COM**-EV1.
• SUM2 (2’s complement of SUM) and CRC-16 are added as error check codes.
• Repeat counter N current value, sequence End finish flag, and sequence Abort

finish flag are added to auxiliary area.
• A check code can be located behind a terminator in messages.
• Swap between high byte and low byte can be specified for error check codes.

1-2-2 Features of the SYSMAC-PST Protocol Support Tool
Simultaneous display of tree (hierarchical) view and list (table) view

The SYSMAC-PST displays data in the form of a tree in the left pane, which
gives you easier understanding of hierarchical structure of data you are setting/
monitoring.

Object-oriented operation
Double-clicking target data, instead of choosing from menus, opens its corre-
sponding popup dialog, which enables you to create protocols quickly without
thorough understanding of operation menus.

Supplied standard system protocols
Data exchange protocols for OMRON’s components (temperature controllers,
panel meters, bar code readers, modems, and so on) are included as standard
system protocols.
Notice that those standard system protocols are included also in the PSB.

Possible to trace send/receive message
By executing the trace function from the SYSMAC-PST, the PSB can trace and
save chronological data of send/receive messages upto 670 bytes. Each data
can be displayed for reading and saved as trace file.

1-3 Checking the Contents of the Package
After purchase, first, check the contents of your SYSMAC-PST package.
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Model of the SYSMAC-PST

Product Name Model Setup Disk Version

Protocol Support
Tool

WS01-PSTF1-E 3.5” FD (1.44 MB) Ver. 1.0

Components of the SYSMAC-PST
Check that all the following components of the SYSMAC-PST are included in
your package.

WS01-PSTF1-E

Item Quantity

Setup disk (3.5”/2HD) 4

Operation manual (this book) 1

User registration card 1

1-4 Supported PLC Models and Personal Computers

1-4-1 Supported PLC Models

The SYSMAC-PST supports the following PLCs (programmable controllers).

Series Model of CPU Unit

SYSMAC α C200HX-CPU34-E/44-E/54-E/64-E/34-ZE/44-ZE/54-ZE/64-ZE/65-ZE/85-ZE
C200HG-CPU33-E/43-E/53-E/63-E/33-ZE/43-ZE/53-ZE/63-ZE
C200HE-CPU-32-E/42-E/32-ZE/42-ZE

1-4-2 Supported PSBs

Product Name Installation Model Enhanced
Functions (See

Note)

Specifications

C200HW-COM-04-E --- CPU bus interface +
RS-232C port x 1 With
the protocol macroC200HW-COM-04-EV1 f

RS-232C port x 1 With
the protocol macro
function

PSB
Installed
into the

C200HW-COM-05-E --- RS-232C port x 2With
the protocol macroPSB into the

CPU unit C200HW-COM-05-EV1 f
the protocol macro
functionCPU unit

C200HW-COM-06-E --- RS-232C port x 1 +
RS-422/485 port x 1
With the protocolC200HW-COM-06-EV1 f

RS-422/485 port x 1
With the protocol
macro function

Note The enhanced functions are as follows:

• SUM2 (2’s complement of SUM) and CRC-16 are added as error check codes.

• Repeat counter N current value, sequence End finish flag, and sequence Abort
finish flag are added to auxiliary area.

• A check code can be located behind a terminator in messages.

• Swap between high byte and low byte can be specified for error check codes.
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1-4-3 Supported Personal Computers
Item Minimum Requirements Recommended

Requirements
Personal computers IBM PC/AT or compatible personal computers

CPU 486DX 100 MHz Pentium 90 MHz or higher

Operating system Microsoft Windows 95

Memory 16 Mbytes 24 Mbytes or more

Hard disk drive 20 Mbytes or more of
available area

50 Mbytes or more of
available area

Monitor VGA or higher SVGA or higher

Floppy disk drive 1 or more drives (1.44-Mbyte drive)

Note 1. Does not run on Microsoft Windows 3.1.
2. Installing the PSB into the CPU unit

CPU unit

Protocol Support Board

1-5 System Configuration
1-5-1 Connecting the SYSMAC-PST and the PLC

Connect the peripheral port on the CPU unit to the built-in RS-232C port.

Note Can be connected to the PSB port if the port is set to the host link mode.

RS-232C port RS-232C port

Protocol Support
Board

Peripheral port
on the CPU unit

Protocol Support
Board

RS-232C port
on the CPU unit

Peripheral connecting cable
Model: CQM-CIF02 RS-232C cable (see note)

Note 2m model: XW2Z-200S

5m model: XW2Z-500S
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Note For IBM PC/AT or compatible computers, a conversion connector from D-SUB
25P (female) to 9P (female) is required for the personal computer side connec-
tor.

1-5-2 Connecting the PLC to External Devices
The following figure shows the system configuration of the PSB in the PLC and
external devices. The RS-232C port provides 1:1 connection and the
RS-422/485 port 1:N connection.

RS-422/485

Protocol Support Board

Types of PSBs (Only Models Having the Protocol Macro Function)

Communications
Communications Function

Model Communications
Port Protocol

Macro Host link No-proced
ural 1:1 link NT link

1:1, 1:N CPU bus

C200HW-COM04-
CPU bus interface --- --- --- --- --- f

C200HW-COM04-
EV1 RS-232C

(port A) f f f f f ---

C200HW-COM05-
RS-232C
(port A) f f f f f ---

C200HW-COM05-
EV1 RS-232C

(port B) f f f f f ---

C200HW-COM06-
EV1

RS-422/485 (port
A) f

f
(see note)

f
(see note)

f
(see note) f ---

C200HW-COM06-
EV1 RS-232C

(port B) f f f f f ---

Model C200HW-COM**-EV1: Enhanced function model.

Note Not available for RS-485.

1-6 Protocol Macro Structure
The protocol consists of a communications sequence (”sequence” in short),
which is an independent process for the general-purpose external device (for
example, reading a process variable from a temperature controller). One se-
quence consists composed of some steps, each of which is composed of a
Send, Recv, or Send&Recv command, send/receive message, branch or end
according to the result of the process.

For example, the sequence to read a process value from the temperature con-
troller sends to the controller a send message (a string containing the read com-
mand with a header, address, check code, and terminator), and then receives a
receive message (a string containing a response to the read command with a
header, address, check code, and terminator).
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Protocol Support Board

The sequence determines, according to the result of process, whether to send
the same send message again (called retry) or execute the next process (for ex-
ample, reading process value from the temperature controller linked to another
address), for example.

Transmission
control
parameter
Link word
Send/receive
monitoring
timer
Response
Type

Message lists (see note 2)
Send message list

Header Address Data Check Terminator

Receive message list

Header Address Data Check Terminator

Receive matrix (see note 2)
Case No. 15

Case No. 00

Receive message Next process

Note 1. The command is the Send, Receive, or Send&Recv command.
• The protocol can retry only on the Send&Recv command.
• The protocol can wait for starting to send a send message on the Send or

Send&Recv commands.
• The protocol can select the next process according to the content of the

received message, using a receive matrix.
2. There are 3 types of messages: send messages, receive (expected) mes-

sages, and receive matrixes that switch processes according to multiple re-
ceive (expected) messages. Those messages are managed by lists, sepa-
rated from sequences.
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1-7 Step Structure
Each step has the fixed processing framework as follows. Users create proto-
cols by setting parameters for each framework.

Setup parameters that commonly affects steps (in each sequence)
Parameter Description

Transmission control
parameter

Sets the control mode for control signals including
flow control.

Link word Sets area in which data is shared between the PLC
and the PSB.

Monitoring time Sets monitoring time for send and receive process.

Response type Sets timing of writing receive data into PLC’s I/O
memory.

Setup parameters for each step
Parameter Setup content

Command Send, Recv, or Send&Recv

Send message Sets message to be sent for the Send
command.

Receive message Sets message expected to be received for the
Recv command.

Message Send message and
receive message

Sets messages to be sent and expected to be
received for the Send&Recv command

Receive matrix

Selects the next process according to the
content of the received message when the
command is Recv, or Send&Recv and max.15
messages can be expected to be received.

Repeat counter
The number of times iterating the step (0-255).
Using this parameter N allows to change the
content of send and receive messages.

Retry count
(Used only for Send&Recv command)
Retries the command when a retry cause such
as an error occurs (0-9 times).

Send wait time
(Used only for Send or Send&Recv command)
Set the waiting time before starting to send
data.

With/Without Response Writing Specifies whether to write received data.

Next process Set the next step to which the step transits or
the sequence exit if it ends normally.

Error process Set the next step to which the step transits or
the sequence exit if it ends abnormally.
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1-8 Data Created by the Protocol Support Tool
The Protocol Support Tool creates/manages data by file unit, called “project”.
Project files consist of the following data:

1 project file Protocol list

Devices

Trace list

Protocol name

Protocol name

Protocol name

Up to 20 protocols (see note 1)
(Up to 1,000 sequences/project)

Protocol name (1 protocol)
(see note 1)

Sequence #000/sequence name

Sequence #001/sequence name

Sequence #999/sequence name

Up to 60 sequences (see note 2)
(The first sequence No. and the
last sequence No. are specified
for each protocol.)

Send message list
Message name

Message name

Receive message list Message name

Message name

Up to 300 messages

Receive matrix Matrix name

Matrix name

Up to 100 matrixes

(see note 2)
Sequence#jjj

Step 00

Step 01

Step 15

Up to 16 steps

Project files are stored with an extension .PSW.
The Protocol Support Tool incorporates standard system protocols. The project
file that includes these standard system protocols is protocol.bin (read only).

Note To transfer standard system protocols to the PSB or create a new protocol by
partially modifying one of the standard system protocols, first copy the required
standard system protocol to another project file and then use the project file. The
standard system protocols themselves cannot be edited or transferred.

The standard system protocols have been installed into the PSB at our factory.
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Files that can be read or written by SYSMAC-PST
Type of PSS

file
Content File

extension
Readable Writable

PST project
files (see
note)

SYSMAC-PST project files
consisting of the following:
Protocol data
Device (communications
conditions between PLC and
PC, communications port
(A/B) setting of the PSB)
Trace data

*.PSW YES YES

PSS system
setting file

File that contains
communications port (A/B)
setting data of the PSS
Protocol Support Board

*.pts YES NO

PSS protocol
file

File that contains only PSS
protocol data

*.pt1 YES NO

Trace data
file

File that contains only trace
data

*.ptr YES YES

Note PST project files cannot be read by the PSS (Protocol Support Tool of DOS ver-
sion).

1-9 Major Screens of the Protocol Support Tool
The Protocol Support Tool displays the tree view of the hierarchical data struc-
ture in the left pane. For the highlighted data in the left pane, the list view of its
contents is displayed in the right pane.

Contents of a project
A project consists of protocol list, trace list, and device manager.

Display of sequences in a protocol
A protocol consists of sequences.



1-9SectionMajor Screens of the Protocol Support Tool

11

Display of each step in a sequence
A sequence consists of steps and their setup parameters for each sequence
(transmission control parameter and so on).

Display of messages in a message list
Messages are managed separately from sequences. Messages can be referred
to by their names from each step in a sequence.

Display of cases in a receive matrix
Receive matrixes are managed separately from sequences. Matrixes can be re-
ferred to by their names from each step in a sequence.

Display of trace data
Displays the send and receive messages in chronological order up to the maxi-
mum of 670 bytes (characters).
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1-10 Overview of Flow of Project Creation

Project creation from scratch

System setup

Protocol name, first sequence No.,
last sequence No.

Protocol creation (addition to list)

Sequence creation

Specify the followings: link word,
transmission control parameter,
response notification mode, and
monitoring time (Tr, Tfr, Tfs).

Step creation

Specify the followings: repeat counter,
command, number of retries, send wait
time, send message (note), receive mes-
sage (note), whether to write response,
next process, and error process.

Message creation

Header, terminator, check code, length,
address, message edit (including data)

Protocol transfer (from personal computer to PSB)

Receive matrix creation

Protocol sequence No. range setting

Menu operation/icon operation

Choose New from the File menu

Double-click the Device icon. Specify target
PC model, PC ↔ PLC Communication Set-
tings.
Double-click the PSB icon. Specify setup
items for each of ports A and B.

Right-click New Protocol.

Right-click New Sequence.

Right-click New Step.

Select New Message from Step or
right-click New Message.

Right-click New Matrix and
right-click New Case.

Refer to

Section 5-1

Section 6-1/6-2

Section 7-2

Section 7-2-5

Section 7-3-1/7-3-2

Section 7-3-3/7-3-4

Section 8-1/8-2

Section 8-3

Note

• A send message in a step can be specified by choosing its message name in
the send message list.

• A receive message in a step can be specified by choosing its message name in
the receive message list or receive matrix name in the receive matrix list.

• Therefore, you can create a message part during step creation more easily by
choosing a message name of the desired send message, receive message, or
receive matrix that you have created in advance.

1-11 Incorporated Standard System Protocol
The Protocol Support Tool provides the following 12 types of incorporated stan-
dard system protocols.
Choose File and then Load Standard Protocol from the main menu to load them.



1-11SectionIncorporated Standard System Protocol

13

Note To transfer standard system protocols to the PSB or create a new protocol by
partially modifying one of the standard system protocols, first copy the required
standard system protocol to another project file and then use the project file. The
standard system protocols themselves cannot be edited or transferred.

The standard system protocols have been installed into the PSB at our factory.

Protocol Name Function

E5_K Digital Controller Read Protocol for controlling an E5_K Digital Controller
via the PSB. Procedures for reading the MV the
operating parameter setting.

E5_K Digital Controller Write Protocol for controlling an E5_K Digital Controller
via the PSB. Procedures for writing set points and
operating parameters.

E5ZE Temperature Controller
Read

Protocol for controlling an E5ZE Temperature
Controller via the PSB. Procedures for reading
measured temperature and operating parameter
setting.

E5ZE Temperature Controller
Write

Protocol for controlling an E5ZE Temperature
Controller via the PSB. Procedures for writing
control temperatures and operating parameters.

E5_J Temperature Controller Protocol for controlling a E5_J Temperature
Controller via the PSB. Procedures for writing set
points, reading output amounts, and reading/writing
operating parameters.

ES100_ Controller Protocol for controlling a ES100 Temperature
Controller via the PSB. Procedures for writing
adjustment parameters, reading operation
amounts, and writing/reading operating
parameters.

Digital Panel Meter Protocol for controlling a Digital Panel Meter via the
PSB. Procedures for writing comparison values
and reading display values are set.

V500/V520 Bar Code Reader Protocol for controlling a Bar Code Reader via the
PSB. Procedures for controlling the Bar Code
Reader in remote mode, reading the data that has
been read by the Bar Code Reader, and
reading/writing operating parameters.

3Z4L Laser Micrometer Protocol for controlling a Laser Micrometer via the
PSB. Procedures for controlling the Laser
Micrometer in remote mode, reading measured
data, and writing/reading operating parameters.

F200/F300/F350 Visual
Inspection Systems

Protocol for controlling a Visual Inspection System
via the PSB. Procedures for controlling the Visual
Inspection System in remote mode, reading
measured values, and writing/reading operating
parameters.

V600/V620 ID Controllers Protocol for controlling an ID Controller via the
PSB. Procedures for performing Read/Write
operations of the ID Controller and writing/reading
operating parameters.

Hayes modem AT commands Protocol for controlling a Hayes modem (AT
commands) via the PSB. Procedures for
initialization of the modem, dialing, data
transmission, switching to escape mode, and
disconnecting the line.

For more information on each protocol, refer to the Communications Board Op-
eration Manual (No. W304).

Example: Protocol for the Controller (E5_K read)
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Sequence No. Communications Sequence

000 Read process value

001 Read set point during SP ramp

002 Read MV

003 Read set point

004 Read alarm value

005 Read proportional band, integral time, and derivative time

1-12 Basic Procedure of the Protocol Macro Usage
Procedure 1 PSB Setup

DIP Switches Setup on the PSB (For the C200HW-COM06-EV1 model only)

SW1: Switch between two-wire and four-wire methods

SW2: On/Off of terminator resistance (On during using RS-422/485 board)

Procedure 2 PSB Mounting

1, 2, 3... 1. Open the memory cassette cover.

2. Remove the PSB cover.
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3. Insert the PSB sliding in the slit completely.

4. Close the memory cassette cover.

Procedure 3 Connection with External Devices
Connect through RS-232C or RS-422/485.

RS232C

RS-422/48

Protocol Support Board

Note For connector pin arrangements and connection methods, refer to the SYSMAC
Communications Board Operation Manual (W304) and other relevant manuals
for general-purpose external devices.
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Procedure 4 System Setup3.

1, 2, 3... 1. For how to connect cables between the PLC and the SYSMAC-PST, refer to
“2.2 Connecting the SYSMAC-PST to PLC”.

2. System setup of the CPU unit and the PSB.
System setup to connect between the PLC and the SYSMAC-PST.

Perform the following setups (a) and (b). The communications conditions
specified in (a) and (b) must be coherent.

Target PLC model setting from the personal computer (SYSMAC-PST) and
communications setup between the personal computer and the PLC
a) Using the SYSMAC-CPT or SYSMAC Support Software or Programing

Console, specify a target PLC model from the device manager and per-
form communications setup between the personal computer and the
PLC.

b) PLC system setup on the CPU unit
Using a peripheral tool for PLC’s CPU unit, perform PLC system setup
according to a connected port.

• When connected to the peripheral port:
Communications setup of the peripheral port:
DM6650 - 6654 in PLC system setup

• When connected to the CPU unit built-in RS-232C port:
Communications setup of the RS-232C port:
DM6645 - 6649 in PLC system setup

System setup of the PSB

Use one of the following methods to perform system setup of the PSB port
A/B.

c) Using a SYSMAC-CPT, SYSMAC Support Software, or Programing
Console, perform the following PLC system setup.
PSB system setup
Port A: DM6555 - 6559 in PLC system setup
Port B: DM6550 - 6554 in PLC system setup

Example: PLC system area DM6555

Example: When setting communications
conditions to the default (standard)

15 0

6 0 0 0

Communications conditions
of Port A
0 indicates: Status bit:1 bit,
data length: 7 bits, parity:
even, stop bit: 2 bits, baud
rate: 9600 bps

Communications mode for
port A
6: Protocol macro

DM6555

d) Using the SYSMAC-PST, perform setup of communications port A/B
from the device manager and transfer the setting to the PLC.
For more information, refer to “Transferring Data to the PSB”.

3. Setup of external devices

Perform required processes including setting up DIP switches on external
devices.
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Procedure 5 Protocol Design → Refer to the Section 3 and the Section 4

1, 2, 3... 1. Creates the status transition chart of communications sequence.

2. Disassembles the protocol into the sequences and the steps and set them
up.

3. Creates the send and the receive messages.

Procedure 6 Project (Protocol Data) Creation and Transfer by SYSMAC-PST
For the brief flow, refer to 1.6.

1, 2, 3... 1. Creates a new project.
Refer to 5-1-1 Create a New Project of 5-1 Project Creation in Section 5.

2. Creates a new communications sequence.
Refer to 7-3-2 Set Sequence List Attribute of 7-3 Edit a Protocol in Section 7.

3. Creates each step.
Refer to 7-3-4 Edit a Step of 7-3 Edit a Protocol in Section 7.

4. Creates each message (Note).
Refer to Section 8 Editing Send & Receive Messages and Receive Ma-
trices.

5. Transfers the created projects to the PSB.

Refer to 9-2 Transfer Protocol Data in Section 9.

Note Each step can be created after each message creation (by specifying
the message name).

Procedure 7 The Ladder Program Creation

1, 2, 3... 1. Allocates function code for the PMCR instruction.

1 Sets to “ON” the DIP switch SW4 of CPU unit (Enable the application
commands setup).

1 Allocate function code for the PMCR instruction by a peripheral tool for
the CPU unit.

Note If your PLC is the C200H∗-CPU∗∗-ZE, FUN No. 260 is assigned to
the PMCR instruction by default.

2. Describes the PMCR instruction.

Example:

PMCR

#1100
DM0000

DM0010

FAL(06)001

25503

Input condition

28908
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When the input condition is set to “ON” and the protocol macro execution
flag is set to “OFF”, the communications sequence number 100 registered
on PSB is called to send and receive data via port A of the PSB.

How many words including
DM0000 are effective?
Specified number at DM0000 of
send data are read beginning
from DM0001.

Number of effective words

Send data

DM0000

DM0001

How many words including
DM0010 are effective?
Receive data is stored in
successive words beginning
from DM0011 and the number of
effective words is stored in
DM0010.

Number of effective words

Send data

DM0010

DM0011

3. Execute the PMCR instruction.

Procedure 8 Confirmation of Operations → Refer to Section 10 Trace/Monitor.
1, 2, 3... 1. Traces the transmission lines

Trace the data in the send and the receive messages and the control codes
flowing on the transmission line (RS-232C or RS-422/485).

2. Monitors the I/O memory
Monitor the send and the receive data and the status of flags.
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1-13 Specifications

1-13-1 Protocol Macro Specifications

Item Description

Number of Protocol 20 Max. Can be created and registered by the Protocol Support Tool.

Number of Sequence 1000 Max.

Per
protocol

Sequence
count

60 Max.
protocol

Message
count

300 Max.

Receive
matrix count

100 Max.

Number of steps per
sequence

16 Max.

Sequence execution
condition

Specified by the PMCR instruction on the PLC’s CPU unit (by giving a sequence No.).

Sequence
content
(common
parameter

Transmission
control
parameters

One of X-on/X-off flow, RTS/CTS flow, delimiter control, or contention control, and
modem control can be specified.

(common
parameter
to all steps)

Response
method

(Mode for writing received data to the I/O memory area specified by the third operand of
the PMCR instruction.)
Either the scan mode or interrupt mode can be specified.

Monitoring
time for
sending/
receiving

Receive wait, receive finish, or send finish can be monitored.
Setup range: 0.01-0.99 s, 0.1-9.9 s, 1-99 s, or 1-99 minutes

Link word Data are exchanged between the PLC’s CPU unit and the PSB when I/O is refreshed. Two
area for sending data, and two area for receiving data.

Step
content

Command Send, Recv, or Send&RecvStep
content Repeat

counter
1-255 times

Retry count 0-9 (Can be specified only for Send&Recv command)
Send wait
time

0.01-0.99 s, 0.1-9.9 s, 1-99 s, or 1-99 minutes
(Can be specified only for Send or Send&Recv command)

With/Without
response
writing
(operand
addressing)

Specifies whether to store the receive message after data receiving is completed (when
storing received data to the area specified by the third operand of the PMCR
instruction.)

Next
process

Specifies the next process as follows when the step ends normally: End (end the
sequence), Next (go to the next step number), Goto (go to a specified step number), or
Abort (abort the step to end the sequence).

Error
process

Specifies the next process as follows when the step ends abnormally: End (end the
sequence), Next (go to the next step number), Goto (go to a specified step number), or
Abort (abort the step to end the sequence).

Send
message

Data sent to the
specified address when
the command is Send
or Send&Recv.

Consists of a header (Note 1), address (Note 2), length, data
(Note 2), error check code (Note 3), and terminator (Note 1).

Receive
message

Data received from the
specified address when
the command is Recv
or Send&Recv.
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Item Description
Step
content

Receive
matrix

When the command is
Recv or Send&Recv,
the receive matrix sets
up the message
expected to be
received (up to 15
sets) to switch next
process by comparing
the data.

Specify a receive message and next process for each of case Nos.
00 - 15.
At least one of 16 cases must be specified to Other for its receive
message type (other than the specified receive message).

Note 1)
Data
attribute of
header and
terminator

Constant ASCII data, HEX data, or control code.

Step
content

Note 2)
Address
attributes

Constant ASCII data, HEX data, or control code (For address, the control code cannot be
used.)content Address

attributes
and data
attributes in

Variable No conversion, HEX to ASCII conversion, or ASCII to HEX conversion (Direction
of read / write can be specified.)

attributes in
send or
receive
message

Specifica
tion
mode

(X,Y)
X: Effective address (source or destination address)
Y: Data size (1-255) (Data size is equal to the number of bites on
transmission path.)

X Word
specification

Word read (I/O
memory →
send data)

Specified by the
second operand
of the PMCR
instruction

Specified start
address + n
(The linear
expression
aN+b, whichSpecified by

the link word.

expression
aN+b, which
includes the
repeat counter

Specified
directly.

repeat counter
N, can be
specified for n.)

Word write
(receive data
→ I/O memory)

Specified by the
third operand of
the PMCR
instruction.

specified for n.)

Specified by
the link word.
Specified
directly.

Wild Card ∗ Receive any data/address (only
for receive message)

Repeat
Counter

N
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Item Description

Step
content

Note 2)
Address
attributes
and data
attributes in
send or

Variable Y Linear
expression or
constant
including the
repeat counter

aN+b a: 0-255
b: 1-255
N: Repeat counter value

attributes in
send or
receive

Wild card ∗ Receive any length of data.
receive
message Word

specification
Word
read(I/O
memory →
send data)

Specified by
the second
operand of the
PMCR
instruction

Specified start
address +
n(The linear
expression aN +
b, which
includes theSpecified by

the link word.

b, which
includes the
repeat counter
N, can be

Specified
directly.

N, can be
specified for n.)

Note 3)
Error check
code

Supports calculation of LRC, CRC-CCITT, CRC-16, SUM, and SUM2.

The
maximum
length of
the send or
the receive
message

256 bytes (Except 200 bytes of one-step receiving message at a control of RS/CS flow,
X-on/X-off flow, or delimiter)

Trace function Possible to trace chronological data of send/receive messages up to 670 bytes (characters).

Possible to trace changes in the control signals such as step No., RS, or CS.

1-13-2 Specifications of the Protocol Support Tool

Item Description

Basic function Creation of protocols, edition of standard system protocols, transfer of protocols to the
PSB, tracing/file saving

File creation unit Project unitFile creation unit
Components of project Protocol list Up to 20 protocols (components

of protocol: sequence,
send/receive message, receive
matrix)

Devices Target PLC, network setup,
comms port setup

Trace list

Other functions - Tracing of transmission lines
- Monitoring of PLC’s I/O memory
- Print of protocols
- Standard system protocol procedure

Supported OS Microsoft Windows 95

Supported network Host link (SYSWAY)

Connection with PLCs Peripheral port on the CPU unit or built-in RS-232C or RS-232C port on the PSB (only in
the host link mode)

Personal computers IBM PC/AT or compatible computer

CPU 486DX 100 MHz or higher

Memory 16 Mbytes or more

Hard disk 20 Mbytes or more of available area

Monitor VGA or higher

Floppy disk drive 1 or more 1.44-Mbyte drives
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SECTION 2
Environment/Installation/Uninstallation/

Starting/Ending

This section outlines the functions of SYSMAC-PST and describes the operating environment, installation procedure, and the
setting of the usage environment.

2-1 Environment Requirements 24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-2 Connecting to a PLC 24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-3 Installation 26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-4 Uninstallation 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-5 Start Up 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-6 Shut Down 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-7 Setting the User Interface 30. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2-7-1 Setting the Display Area 30. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-7-2 Toolbars 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2-8 Common User Interface 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-8-1 Outline of Common User Interface 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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2-1 Environment Requirements
SYSMAC-PST requires the following minimum computer configuration require-
ments for effective running.

• 100 MHz 80486dx or better CPU.

• At least 16 Mbytes of RAM.

• hard disk storage with at least 20 Mbytes of free space.

• VGA or better display system.

• Microsoft Windows 95.

• Mouse.

SYSMAC-PST operates with the following PLC’s which support PSBs.

• C200HX (CPU85, CPU65, CPU64, CPU54, CPU44, CPU34) -E/-ZE.

• C200HE (CPU42, CPU32) -E/-ZE.

• C200HG (CPU63, CPU53, CPU43, CPU33) -E/-ZE.

SYSMAC-PST supports the following PSB’s.

• C200HW-COM04-E/-EV1.

• C200HW-COM05-E/-EV1.

• C200HW-COM06-E/-EV1.

2-2 Connecting to a PLC
When transferring protocol data created by SYSMAC-PST, use the following
cables to connect the computer and PLC.

Communications
procedure

Cable used Connector on the
computer

Connector on the
PC

Peripheral bus CQM1-CIF02 RS-232C Peripheral port

Note A personal computer can be connected to the PSB port if the port is set to the
host link mode.

RS-232C port

When creating a specific RS-232C cable, join the connectors as follows.
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Connectors and Cables
Component name Model Manufacturer

D-sub connector (9-pin,
PLC side, male)

Model XM2A-0901 (connector) OMROND-sub connector (9-pin,
PLC side, male) Model XM2S-0911 (connector hood)

OMRON

D-sub connector (9-pin,
Computer side, female)

Model XM2D-0901 (connector) OMROND-sub connector (9-pin,
Computer side, female) Model XM2S-0911 (connector hood)

OMRON

Recommended Cable UL2464 AWG28 × 5P IFS RVV SB
(UL item)

Fujikura Wire

AWG28P × 5P IFVV-SB (non-UL item)

UL2464-SB 5P × AWG28 (UL item) Hitachi Wire

CO-MA-VV-SB 5P × AWG28
(non-UL item)

Hitachi Wire

Wire path length Up to 15 m

Connection Signals Computer
Pin number Symbol Circuit name

1 FG Protective Ground

2 RD Receive Data

3 SD Send Data

7 RTS Request To Send

8 CTS Clear To Send

5 SG Signal Ground

Wiring Cables The following diagram shows the wiring of cables connecting a PLC and computer:

PLC
Connector hood FG

---
SD
RD
RS
CS
SG

1
2
3
4
5
9

Computer
Connector hood FG

FG
RD
SD
RS
CS
SG

1
2
3
7
8
5

D-SUB 9P plug (Male) D-SUB 9P plug (Female)

Shield
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2-3 Installation
Use the following procedure to install SYSMAC-PST and SYSMAC-CDM (see
note) Version 1.3 on to a computer running Microsoft Windows 95.

Note SYSMAC-CDM is a communications-associated application software used in
the SYSMAC-PST. Users do not need to be concerned about this software ex-
cept when installing the software and when error messages are displayed.

If SYSMAC-CPT and SYSMAC-PST applications are installed on the same PC
be sure that SYSMAC-CDM will be installed in the same directory for both ap-
plications.

1, 2, 3... 1. Turn on the computer and activate Windows 95.

2. Select the Start push-button from the taskbar and choose Settings....

3. Select the Windows Control Panel.

4. Select the Add/Remove Programs setting
5. The Add/Remove Programs Properties dialog is displayed.

Select the Install... push-button to install SYSMAC-PST.
6. Insert disk 1 of SYSMAC-PST into the computer’s floppy drive. Select the

Next> push-button. Ensure that the Command Line for Installation
Program: field reads “a:\setup.exe”, where ‘a:\’ is the location of the floppy
drive (letter case is not important), and select the Finish push-button. If
required, select the Browse... push-button to find the setup.exe file.

7. The setup program takes a few moments to initialise, as indicated by the
displayed progress indicator. Once the progress indicator reaches ‘100%
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complete’, installation begins. The Welcome dialog is displayed. Read the
information on the Welcome dialog and Select the Next> push-button.

8. The Choose Destination Location dialog is displayed. Select the Browse...
push-button to locate a destination directory for SYSMAC-PST. If a
destination directory does not currently exist, it is created by the installation
process following confirmation by the user. Select the Next> push-button to
continue.

Note If any Windows-version support tool other than the SYSMAC-PST
has already been installed, such as the SYSMAC-CPT, be sure to
install the SYSMAC-PST in the same directory.
For example, if the SYSMAC-CPT is installed in “C:\Program
Files\Sysmac”, designate the following drive and path name at the
time of installation as in “C:\Program Files\Sysmac\...”

9. If a version of SYSMAC-PST already exists in the selected destination
directory, the SYSMAC-PST Already Installed dialog is displayed. Select
the Next> push-button to overwrite the current version of SYSMAC-PST or
the <Back push-button to choose a different destination location.

10. The installation process completes by copying files from the floppy disk to
the computer. When prompted, insert the required disk in the floppy drive
and select the OK push-button. If necessary, select the Browse...
push-button to find the required disk.

The file progress indicator illustrates how far installation of the current file has
progressed.
The disk progress indicator illustrates how far installation of the current disk has
progressed.
The hard disk progress indicator illustrates how much disk space is left at the
destination location.
11. Read the information dialogs that are displayed prior to the closure of the

installation program. Select the Finish push-button.

Caution Premature Cancellation of the installation of SYSMAC-PST is not advised as
files may have already been copied on to the computer.
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2-4 Uninstallation
Use the following procedure to remove SYSMAC-PST and SYSMAC-CDM
Version 1.3 from the computer.

1, 2, 3... 1. Select the Start push-button from the taskbar and choose Settings....

2. Select the Windows Control Panel.

3. Select the Add/Remove Programs setting.

4. The Add/Remove Programs Properties dialog is displayed.

Select the ‘SYSMAC-PST’ entry from the Uninstall and select the
Add/Remove... push-button.

5. SYSMAC-PST and SYSMAC-CDM is removed from the computer. Select
the OK push-button on confirmation.
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2-5 Start Up
Use the following procedure to start SYSMAC-PST.

1, 2, 3... 1. Select the Start push-button from the taskbar and choose Programs....
2. Select the Omron folder.

3. Select the SYSMAC-PST program. SYSMAC-PST is activated.

2-6 Shut Down
Use one of the following methods to shut down SYSMAC-PST.
Select the control menu in the title bar and choose the Close option.

Click the right mouse button in the title bar and choose the Close option.
Select File from the menu bar and select the Exit menu option.

Select the Close button in the title bar.
Press Alt+F4.

A confirmation dialog is displayed if any information currently open in
SYSMAC-PST has not been saved.

Select the Yes push-button to Save the changes. Select the No push-button to
discard the changes. SYSMAC-PST closes. Select the Cancel push-button to
abort the operation and return to SYSMAC-PST.
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2-7 Setting the User Interface
The SYSMAC-PST user interface can be configured to suit the individual needs
of the user in a number of ways:
• Setting the display area.
• Moving, removing and re-displaying toolbars within the display area.
• Removing and re-displaying the status bar.

2-7-1 Setting the Display Area
The display area of SYSMAC-PST can be moved and resized in a number of
ways.
The display area can be moved by selecting the title bar with the left mouse
button and dragging the window to a new destination, or by selecting Move from
the project window control menu.
Use the following procedure to resize the display area.

1, 2, 3... 1. Move the mouse pointer or input device over a window boundary. The
mouse pointer changes shape.

2. Once the mouse pointer has changed, click and hold the left mouse button
and drag the boundary to its new position.

Note By selecting the corners of the project window boundary, the project window can
be resized ensuring that the aspect ratio of the window is preserved.

A project window can also be resized by selecting Size from the project window control
menu.

The display area can be maximized to fill the full display or minimized to the taskbar.

To minimize the display area, select the Minimize button from the title bar.

To maximize the display area, select the Maximize button from the title bar.

To restore the display area to its usual size from its maximized state, select the Restore
button from the title bar (the Restore button replaces the Maximize button if the display
area is already maximized).

The above functions can also be accessed by selecting the control menu.
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2-7-2 Toolbars
The dockable toolbars used by SYSMAC-PST can be moved to maximize use of
the display area. The following toolbars are used by SYSMAC-PST.
• The Project toolbar.
• The Protocol toolbar.
• The Trace toolbar.
• The PLC toolbar.
A dockable toolbar can be moved about the display area by selecting the toolbar
surround (not a toolbar button) with the left mouse button, and dragging it to its
new position in the display area. The toolbar inherits its own title bar if moved
from its original position. A double-click in the title bar returns the toolbar to its
original position.
To remove a particular toolbar from the display, select View from the menu bar,
followed appropriately by the Project Toolbar, Protocol Toolbar, Trace Toolbar or
PLC Toolbar option. Repeat this procedure to redisplay the toolbar.
If the toolbar has been moved and has its own title bar, it can be removed by
selecting the Close button and subsequently redisplayed by using View from the
menu bar.

2-8 Common User Interface
For clarity, access to functions is not discussed in following sections, but
described here.

2-8-1 Outline of Common User Interface
The following is the basic screen configuration provided by SYSMAC-PST.

Project name

Title bar
Menu bar

Tool bar

Project name

Project window

Status bar

The dialog or pull-down menu appears
by double-clicking the left mouse button
with the mouse pointer located to the
corresponding item.

Hierarchy screen
• The hierarchy appears with the

project as the highest level.
• The selected item is highlighted

and the contents of the data ap-
pear in the right screen portion
(contents screen).

Contents screen

• The contents of the data of the item selected and
highlighted in the left screen portion (hierarchy
screen) appears.

• By double-clicking the left mouse button with the
mousepointer locatedon the icon on the left edge
of the screen, the contents of the data appears
with the hierarchy from the highest level to the
lowest level scrolled.

Project window
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1, 2, 3... 1. The main screen in the project window is divided into two panes (i.e., the left
and right panes).
• The data hierarchy appears in the left pane in a tree format. The left pane is

called hierarchy screen.
• The contents of designated data (i.e., highlighted data) in the left pane ap-

pear in a table format in the right screen portion. The right pane is called
contents screen.

2. The menu and tool bars are used for basic Windows functions, such as file
and edit functions, and protocol and trace operating functions.

3. The following are the basic operations required to create, edit, and down-
load protocols.
• The screen is scrolled from the highest level to the lowest level where the

data in detail can be checked if the left mouse button is double-clicked with
the mouse pointer located on the icon in the left or right pane (i.e., the hier-
archy or contents screen). By pressing the ESC Key, the screen is scrolled
from the lowest level to the highest level.

• To create a new object, such as a protocol, sequence, step, or message,
click the right mouse button with the mouse pointer located on the Edit
menu or press the Shift and F10 Keys so that the Edit menu will pop up,
and select Create New Object. Then a new object appears in the right
pane (contents screen).

• Data is input into the list in the right pane (contents screen). To input the
data, trouble-click the left mouse button with the mouse pointer located on
the input-field cell so that the set dialog will appear. Then input the set val-
ue into the set dialog.

• The menu is used for setting the communications port of the PSB, upload-
ing protocols, tracing data, or downloading trace data after clicking the
right mouse button with the mouse pointer located on the menu or press-
ing the Shift and F10 Keys so that the menu will pop up.

Note The pop-up menu appearing with the right mouse button clicked is a useful fea-
ture of SYSMAC-PST. The kind of pop-up menu appearing depends on what is
pointed while the right mouse button is clicked. The user should understand that
the main functions of SYSMAC-PST are available with the pop-up menus of
SYSMAC-PST. Such functions include functions used for creating new proto-
cols, sequences, messages, matrices, and matrix cases, setting the commu-
nications port of the PSB, uploading protocols, and tracing data.
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Project Window
Data appears in the following hierarchy.

: Project

: Protocol List

: Protocol

: Communication
Sequence

: Send Message
List

: Receive Message
List

: Receive
Matrix List

: Trace List

: Devices

: PLC

: PSB

--

--

--

+

+

Project

Protocol List

Protocol Name

Sequence
Name

Sequence
Name

Send Message
List

Receive Message
List

Receive Matrix List

Protocol Name

Protocol Name

Trace List

PLC

PSB

Devices

-- The data indicated to the right
displays those in lower levels.

+ The data indicated to the right
does not display those in low-
er levels.

Sequences under the above
protocol name

Lists under the above
protocol name

Displays
only
one.

Displays
more
than
one.

Displays
only
one.

--

Matrix

The item appears according to the selected data (i.e., the highlighted data) in the
left pane (hierarchy screen).

Left Pane
(Hierarchy Screen)

Right Pane
(Contents Screen)
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Selected data
in left pane
(hierarchy

screen)

Item in right pane (contents screen)

Project ∗ Name --- --- --- --- --- --- --- --- --- ---

Protocol
List

∗ Protocol
Name

Seq Start Seq
End

Type --- --- --- --- --- ---

Protocol
Name

∗ #
(Se-
quence
Number)

Commu-
nication
Sequence

Link
Word

Control Re-
sponse

Timer
Tr

Timer
Tfr

Timer
Tfs

--- ---

Sequence
Name

∗ Step Repeat Com-
mand

Retry Send
Wait

Send
Mes-
sage

Receive
Mes-
sage

Re-
sponse

Next Error

Send
Message
List

∗ Message
Name

Header
<h>

Termi-
nator
<t>

Check
Code
<c>

Length
<l>

Ad-
dress
<a>

Data --- --- ---

Receive
Message
List

∗ Message
Name

Header
<h>

Termi-
nator
<t>

Check
Code
<c>

Length
<l>

Ad-
dress
<a>

Data --- --- ---

Matrix List ∗ Matrix
Table

Case
Steps

--- --- --- --- --- --- --- ---

Matrix ∗ Case
Number

Receive
Message

Next
Process

--- --- --- --- --- --- ---

Trace List ∗ Descrip-
tion

Uploaded Size --- --- --- --- --- --- ---

Devices ∗ Device Current
Configu-
ration

--- --- --- --- --- --- --- ---

PLC ∗ PLC
Compo-
nent

Descrip-
tion

--- --- --- --- --- --- --- ---

PSB ∗ PSB
Compo-
nent

Descrip-
tion

--- --- --- --- --- --- --- ---

The highlighting cursor is available in both the left screen portion (hierarchy
screen) and the right screen portion (contents screen) of the project window.
The focused portion (i.e., the portion actually selected in operation) is sur-
rounded by ---. If a line in the right screen portion (contents screen) is selected,
the focused portion is in the right screen portion (contents screen).
To switch over the focus between the left and right screen portions (hierarchy
and contents screens), press the Tab Key or select Focus Select from the View
menu or click either of the screens.

4. The mouse, Up, Down, Left, or Right Key, or Function Key can be used to
select the elements in projects.

The following operations are available without the mouse.
• The following are possible in either of the screens by pressing the Up or

Down Key while the focus is in the screen.
The scrolling of the tree in the left screen portion (hierarchy screen).
The scrolling of the rows of the tables in the right screen portion (contents
screen).

• The next higher level is reached by pressing the ESC Key or the Back-
space Key.

• The right screen portion (contents screen) is scrolled for a single-screen
portion whenever the Page-up or Page-down Key is pressed.



2-8SectionCommon User Interface

35

• The next active window of SYSMAC-PST is reached by pressing the Ctrl
and F6 Keys or selecting Next Window from the Control menu.

• The size ratio of the left screen portion (hierarchy screen) to the right
screen portion (contents screen) is changeable by moving the border line.

• The width of each item in the right screen portion (contents screen) is
changeable by moving the border line.

• The hierarchy in the left screen portion (hierarchy screen) is selectable by
clicking the + or -- portion. After the -- portion is clicked, the + portion
appears at the final hierarchy level, in which case only the display of the left
screen portion (hierarchy screen) changes but the display of contents
screen does not change.

Click this. Displays the
lower level
data.

5. The hierarchy is scrolled downwards by double-clicking the left mouse but-
ton with the mouse pointer located on either of the icons or pressing the
Down Key while the focus in the screen. The selected and highlighted data
in the left screen portion (hierarchy screen) is scrolled.

By pressing the ESC Key or selecting Parent in the View menu, the hierar-
chy screen is scrolled in the higher level direction.

6. Click the right mouse button with the mouse pointer located on the pop-up
Edit menu to select Create New Data.

A new step is created after clicking the right mouse
button or pressing the Shift and F10 Keys to select
the corresponding item in the pop-up Edit menu. In
this example, Create Step is selected.

7. Input data of each item by double-clicking the left mouse button with the
mouse pointer located on the item of the table in the right screen portion
(contents screen).

This dialog appears
by double-clicking the
left mouse button.
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Control Menu

Control Menu

Project Window
Control Menu

Close

Maximize

Minimize

Menu and Short-cut Key
Main
menu

Sub menu Description Short-cut
key

Icon on tool bar

File New Creates a new project. Ctrl+N fFile

Open Opens the existing project selected. Ctrl+O f

Open System
Protocols

Opens the system protocol. --- f

Close Closes the project worked on. --- ---
Save Overwrites and saves the project file worked on. Ctrl+S f

Save As Saves the project file worked on as a new file. --- ---
Download Protocols
to PSB

Downloads the protocols selected to the PSB. --- f

Protocol Compare Compares the data of two protocols. --- f

Upload Protocols
From PSB

Uploads the protocols from the PSB. --- f

Display PSB
Protocols

Displays the list of protocols stored in the PSB. --- f

Display Object Code
Size

Displays the quantity of object code data. --- f

Print Prints the protocols or trace selected. Ctrl+P f

Print Preview Displays the image of print output. --- ---
Print Setup Sets the printer model, paper size, and printing

direction.
--- ---

Recent File Displays a maximum of four files recently used. --- ---
Exit Exits SYSMAC-PST. --- ---

Edit Undo Undoes the previous operation. Ctrl+Z ---Edit

Cut Cuts and transfers the range designated to the
clipboard.

Ctrl+X f

Copy Copies and transfers the range designated to
the clipboard.

Ctrl+C f

Paste Pastes the contents of the clipboard to the
position designated.

Ctrl+V f

Delete Deletes the range designated. Del f

Accept Accepts the results of input. --- ---
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Main
menu

Sub menu Description Short-cut
key

Icon on tool bar

Edit Cancel Cancels the results of input. --- ---Edit

Field Enables the selected field in the contents screen
ready for input, the effect of which is equivalent
to that of the double-click operation of the
mouse.

--- ---

Select All Selects the data of all rows. Ctrl+A ---
Inverse Selection Selects data other than the data focused. Ctrl+I ---
Move Scrolls the steps or matrix case upwards or

downwards to the top or bottom.
--- f

View Project Toolbar Shows or not shows the project tool bar. --- ---View

Protocol Toolbar Shows or not shows the protocol tool bar. --- ---
Trace Toolbar Shows or not shows the trace tool bar. --- ---
PLC Toolbar Shows or not shows the PC tool bar. --- ---
Parent Scrolls the displayed hierarchy portion in the

project window to the one upper.
Esc ---

Swap Focus Switch over the focus between the hierarchy
and contents screens.

Tab ---

Window New Window Creates an identical new window. --- ---Window

Cascade Shows windows in cascade status. --- ---
Tile Shows windows laid vertically. --- ---
Arrange Icons Arrange icons to align with one another. --- ---

Help Help Topics Shows Search Topic in SYSMAC-PST’s Help. --- fHelp

About PST Shows the version of SYSMAC-PST. --- f
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Pop-up Menu
If either of the following objects is selected, the pop-up menu according to the
hierarchy appears by clicking the right mouse button or pressing the Shift and
F10 Keys.

• Pop-up Edit Menu

Selected object Pop-up Edit menu

Project Properties
Protocol List Create ProtocolProtocol List

Cut
Copy
Paste
Delete

Protocol Create Communication SequenceProtocol

Create Matrix
Create Receive Message
Create Send Message
Cut
Copy
Paste
Delete

Communication Sequence Create StepCommunication Sequence

Cut
Copy
Paste
Delete

Step Edit Send Message
Edit Receive Message
Cut
Copy
Paste
Delete

Send Message List Create Send MessageSend Message List

Cut
Copy
Paste
Delete

Receive Message List Create Receive MessageReceive Message List

Cut
Copy
Paste
Delete

Matrix List Create MatrixMatrix List

Cut
Copy
Paste
Delete

Matrix Create Matrix CaseMatrix

Cut
Copy
Paste
Delete
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Selected object Pop-up Edit menu

Matrix Case Cut
Copy
Paste
Delete

Trace Delete

• Pop-up Operation menu (in On-line Operation)

Selected object Pop-up Edit menu

PSB Upload Protocols From PSBPSB
Display PSB Protocols

Trace Memory A/B Start Trace Continuous TraceTrace Memory A/B Start Trace

One-Shot Trace
Stop Trace
Upload Trace From PSB

Comms port A/B Edit SettingsComms port A/B

Download Settings To PLC
Upload Settings From PLC

Tool-bar Icons

• Project Tool Bar

These icons are for the operation of
project-related functions.

• Trace Tool Bar

These icons are for the operation of trace-re-
lated functions.

• Protocol Tool Bar

These icons are for the operation
of protocol-related functions.

• PLC Tool Bar

The PLC modes, such as off-line, program,
and monitor modes, and corresponding PLC
models are displayed.
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List of Tool-bar Icons
Tool bar Icon Corresponding

menu
Tool bar Icon Corresponding

menu
Project toolbar New Protocol toolbar Compare

Open Download
Protocols

Open System
Protocol

Object Code Size

Save Download Port
Settings

Cut Upload Port
Settings

Copy Upload Protocols

Paste PSB Protocol List

Print Delete

About Up

Help Down

Trace toolbar Start of Trace Top

Fast Rewind Bottom

Rewind PLC toolbar PLC Mode

Forward PLC Model

Fast Forward ---

End of Trace

Start one-shot
trace

Start Continuous
trace

---

Stop trace ---

Upload trace

The status bar displays the explanation of the menu or icon of the position where
the cursor is located.

Note Select the toolbar icon by referring to the corresponding explanation of the icon
appearing on the status bar.

The right portion of the status bar displays either one of the following keys that
are locked.
CAP: Uppercase keys are locked.
NUM: Number keys are locked.
SCRL: Scroll keys are locked.

Status Bar
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3-1 Protocol Macro Outline
The Protocol Support Tool allows users to freely create and edit protocols, which
are procedures for sending data to and receiving data from general-purpose de-
vices connected to the PSB through RS-232C or RS-422/485. The Protocol
Macro is a function to implement the sending and the receiving messages by the
execution of starting instruction for the protocol macro (PMCR instruction) of the
user program on the CPU unit.

#1001

Protocol Support Board

Protocol Support
Board service

3-1-1 Sequence/Step Structure
One sequence consists of up to 16 steps. One step includes one command
(Send, Receive, or Send&Receive) and one or two messages (Send, Receive,
or Send&Receive). Step transition is specified by the “next process” within the
step.

1, 2, 3... 1. Sequence-specific data (common to all steps)

Setup Item Description

Transmission control
parameter

X-on/X-off flow control, RTS/CTS flow control, modem
control, delimiter control, or contention control

Link word Shared memory area between the PLC and the PSB.

Monitoring time Time for monitoring send and receive processing.

Response Type Timing for writing received data.
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2. Step-specific data

Setup Item Description Command typeSetup Item Description

Send Receive Send&
Receive

Command Send, Receive, or
Send&Receive

Repeat counter The number of times iterating
the step (0-255)

O O O

Send message The contents set here is sent
as a message.

O O

Receive message The message that was actually
received is compared with the
data set here.

--- O O

Receive matrix Selects the next process
according to message
expected to be received (up to
15 types).

--- O O

Retry count The number of times for
retrying the command when
some retry factor such as an
error arises.

--- --- O

Send wait time Wait time for starting data
sending for a Send command.

O --- O

With/Without
Response Writing
(operand
addressing)

Specifies whether to write
received data .

--- O O

Next process Specifies the next step to which
control goes when the system
ends normally.

O O O

Error process Specifies the next step to which
control goes when the system
ends abnormally.

O O O

3. Message structure and content

Messages to be sent and received are generally structured as follows:

1) Messages containing header and terminator

The check code and the terminator can be replaced each other.

Note Possible only when the Communications Board C200HW-COM**-EV1 is used.

Header Address Data Terminator Check code
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2) Messages containing header and data length

Setup Item Meaning Data attributesSetup Item Meaning

Constant Variable
Header Beginning of

message
O ---

Address Message
destination

O O

Length Message length --- ---

Data Message body O O

Check code Error check code --- ---

Terminator End of message O ---

• Input the constant in the header and terminator.
• Either the constant or variable can be input in the address and data. By includ-

ing variables in the address and data, the address or data can be retrieved
from the designated area of the I/O memory and the transmitted or received
data can be written in the designated area of the I/O memory.
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3-1-2 Communications Sequences and the PMCR Instruction

The PMCR instruction will specify a communication port number and sequence
number. In addition, the user can specify the source I/O memory address and
the destination I/O memory address of the message.

PMCR Instruction
Specification

Control Data

Ladder Program

D0002

D0003

Note 1. The protocol macro execution flag is set to “ON” at the start of the PMCR
instruction, and set to “OFF” when the sequence ends and the received data
is safely stored in the specified relay area. Therefore, to execute the next
PMCR instruction, the ladder program first checks that the flag is set to
“OFF”.

2. The FAL instruction is used to check whether PMCR instruction parameters,
etc. are correctly set.
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3-2 Sequence Attributes (common to all steps)

3-2-1 Setting
Setup Item Description

Transmission control
parameter

X-on/X-off flow control, RTS/CTS flow control, modem
control, delimiter control, or contention control

Link word Shared memory area between the PLC and the PSB.

Response Type Timing for writing received data.

Monitoring time Time for monitoring send and receive processing.

3-2-2 SYSMAC-PST Setup Screen

Sequence name Send finish monitoring time, Tfs

Receive finish monitoring time, Tfr
Receive wait monitoring time, Tr

Response type
Transmission control mode

Link word addressing

For the details of setup method, refer to 7-3-2 Set Sequence List Attribute of 7-3
Edit a Protocol in the Section 7.

3-2-3 Transmission Control Parameter
Control parameters set transmission control modes controlling the flow, RTS,
CTS, DTR, DSR, etc. The following 5 types of transmission control are sup-
ported. You shall set the same transmission control modes as for the external
device to communicate with. Notice that the modem control parameter can be
specified together with other parameters.

Transmission
control parameter

Function Usage

Xon/Xoff flow
control

Executes flow control by software
using Xon (11 Hex) and Xoff (13
Hex) codes.

Set when the external device
supports the Xon/Xoff flow control.

RTS/CTS flow
control

Executes flow control by hardware
using the RTS and CTS signals.

Set when the external device
supports the RTS/CTS flow control.

Modem control Holds DTR “ON” during execution of
a PMCR instruction, and RTS “ON”
during sending of data.

Set when the external device
checks the DSR status.Must be
used if you want to use the internal
RS422 port.Must be used also if an
external RS422/RS485 converter is
connected to RS-232C port.

Delimiter control For sending or receiving a large
quantity of data, this procedure
separates data into several frames
with delimiters.

Set when the external device
supports delimiter control.

Contention control Transmission control mode for
getting the send right in
point-to-point contention
communication, such as the SECS
protocol.

Set when the external device
supports contention control.

Note Unless modem control is set, the DTR on the port of the PSB cannot be turned
ON. When both modem control and RTS/CTS control are set, the DTR complies
with modem control, and the RTS and CTS comply with RTS/CTS flow control.
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Transmission control parameter Settings on the SYSMAC-PST

RTS/CTS flow control None: No RTS/CTS flow control
Send: RTS/CTS flow control only during
sending
Receive: RTS/CTS flow control only
during receiving
Send&Receive: RTS/CTS flow control
during both sending and receiving

Xon/Xoff flow control None: No Xon/Xoff flow control
Send: Xon/Xoff flow control only during
sending
Receive: Xon/Xoff flow control only
during receiving
Send&Receive: Xon/Xoff flow control
during both sending and receiving

Modem control Yes/No

Contention control No
Yes: Send request code; Control code:
either ASCII or HEX

Delimiter control No
Yes: Send request code; Control code:
either ASCII or HEX
Receive request code; Control code:
either ASCII or HEX

3-2-4 Link Word Addressing

1, 2, 3... 1. Addressing of Send or Receive Data users can specify where to store send/
receive data using the following 3 modes case by case.
However, the direct addressing and the operand addressing are not set
here, because they are set within communication message. Only the link
word addressing is set by sequence as described below in the column en-
closed by bold lines:
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Addressing Function Identification Code in
Messages

Usage

Operand
addressing
(Set within a
send or
receive
message)

Addresses an I/O memory within a send or
receive message using the second operand
(send data store beginning word number)
and the third operand (receive data store
beginning word number) of the PMCR
instruction included in the ladder program.
The system sends or receives data using
the specified I/O memory.
This item determines the timing at which
receive data is written into the specified I/O
memory area according to the response
notification mode in a sequence (in addition
to that, this item lets you specify whether to
write responses for each step).

• Scan
The system writes receive data to PLC at
every PLC scan.

• Interrupt
The board interrupts the PLC at receptionof
data for write to the specified I/O memory.

(Fixed Nos. and receive case Nos. are
available as interrupt program Nos.)

Word read: R(z)

Word specified by the
second operand of the
PMCR instruction + z
word

Word write: W(z)

Word specified by the
third operand of the
PMCR instruction + z
word

By the PMCR instruction
included in the ladder
program, users can
dynamically set a relay
area to be commonly used
in the sequence.
The interrupt function
implements a high
response processing.

Direct
addressing
(Set within a
send or
receive
message)

Because these words are refreshed at
every PLC scan, writing operation to the I/O
memory does not synchronize with data
receiving, inducing some time lag.

CIOjjj
LRjj
HRjj
ARjj
DMjjjj
EMjjjj
j: Word No.

This mode is used to
assign a fixed relay area
used separately by the
step.
Changing addresses
needs modification and
retransmission of the
step.

Link word
addressing
(Set by
sequence)

Specifies an area on which data are shared
between the PLC and the PSB. Two sets of
link word, link word 1 and 2, can be set as
such areas.
Link word 1:

IN (for storing receive data)
OUT (for storing send data)

Link word 2:
IN (for storing receive data)
OUT (for storing send data)

Set these areas using the reserved words:
I1, I2, O1, or O2. Because these words are
refreshed at every PLC scan, writing
operation to the I/O memory does not
synchronize with data receiving, inducing
some time lag.Directly addresses an I/O
memory within a send or receive message.

I1 (IN of link word 1)
O1 (OUT of link word 1)
I2 (IN of link word 2)
O2 (OUT of link word 2)

This mode is used to
assign a fixed relay area
commonly used by all
steps in a sequence.
Changing link words
needs modification and
retransmission of the
sequence.

Note For the store area of send or receive data, the following IOM areas can be speci-
fied:

CIO: 000 ∼ 511

LR: 00 ∼ 63

HR: 00 ∼ 99

AR: 00 ∼ 27

DM: 0000 ∼ 6655

EM: 0000 ∼ 6143
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1) Operand Addressing

Protocol Support Board

2) Direct Addressing

Protocol Support Board

3) Link word Addressing

Protocol Support Board
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Link channel specification

IN

OUT

Starting
address
size

Starting
address
size

Link 1

IN

OUT

Starting
address
size

Starting
address
size

Link 2

Link 1

Link 2

Area type

Area type

Area type

Area type

CPU Protocol Support Board

Refresh



3-2SectionSequence Attributes (common to all steps)

51

Example: Read and write part of data assigned in the above in a message.

(W (I1+3), 4)

20
channels

OUT

IN

Link 1

CPU

Link 1
OUT

IN

Refresh

Refresh

CIO100

CIO119

DM0100

30
channels

Protocol Support Board Specification in a message

Send message

(R (O1+5), 2)

Receive message

5
channels

3
channels

CIO 105 is read and built in the data in a
send message.

Data in receive message is written in
DM0103 to DM0104.

CIO105 is read and built in the data in a send message. Receive
message(W (I1+3), 4)Data in receive message is written in
DM0103 to DM104.

3-2-5 Response Type

The response type specifies when to write the receive data to the I/O memory
specified by the third operand of the PMCR instruction and how to notify this
write processing to the CPU unit. One of the following 3 modes can be used as
this mode.

1, 2, 3... 1. Scan Mode
This mode writes the receive data to the I/O memory at a scan of the CPU
unit.

Protocol Support Board

2. Interrupt Mode: Fixed #
This mode writes the received data to the I/O memory at the same time of the
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data receiving. In addition, this mode specifies the appropriate interrupt pro-
gram number to have the CPU unit execute this program.

Protocol Support Board

3. Interrupt Mode: Receive Case #
This mode writes the receive data to the I/O memory at the same time of the
data receiving. In addition, this mode calculates the interrupt program No.
using the following method to have the CPU unit execute this interrupt pro-
gram.

Protocol Support Board

Interrupt program No. = XX (HEX)
When using a receive matrix:
Case No. of the receive matrix
Otherwise: 0

Step No. of the sequence
that was executed

Example: When the step No. = 2 and the receive matrix case number
= 11 (HEX),Interrupt program No. = 2B (HEX) = 43 (Decimal)

Setting up using Protocol Support Tool.
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3-2-6 Monitoring Time
Users specify the time for monitoring the send or receive processing. The follow-
ing types of monitor time can be specified. However, Ts (send wait time) is
omitted here because the value is set step by step.
Set the monitoring time by sequence as only described below in the columns
enclosed by bold lines:

Monitoring time Description Command typeMonitoring time Description

Send Receive Send &
Receive

Receive wait
monitoring time:
Tr

Monitors the time from when the receive
command of the step in the sequence is
recognized (receive command execution) until
the first byte (header) is received.
When receiving no data in the specified Tr
(Note 1), the system executes the error process
set in the step.

--- O O

Receive finish
monitoring time:
Tfr

Monitors the time from reception of the first byte
to reception of the last byte of the data in the
step in the sequence. When the receiving is not
finished in the specified Tfr (or the terminator
does not come) (Note 2), the system executes
the error process set in the step.

--- O O

Send finish
monitoring time:
Tfs

Monitors the time from transmission of the first
byte to transmission of the last data . Unless
the transmission ends within this specified
watchdog time (Note 1), the system iterates the
step up to the times specified in the step. If
even after the repeating transmission does not
come to an end, the system executes the
appropriate error process.

O --- O

Send wait time: Ts Sets the time from when the send command of
the step is recognized until the first byte is sent.
For example, when sending the data over an
extension line through the modem, unless
waiting for a while to send the telephone
number after dialing 0, the dialing may not be
successful.

O --- O

O : Available, —: Not available

Note 1. When a retry count of Send&Receive is set for the step, the system repeats
the step up to the times of the retry count. If all retries fail or a time-out oc-
curs, the system executes the appropriate error process.
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2. Be sure to set both the Receive wait monitor time Tr and Receive finish mon-
itor time Tfr. If either one of them is not set, the other side is invalidated.

3-3 Step Attributes

3-3-1 SYSMAC-PST Setup Screen

Repeat counter

Command
Retry count

Send wait time
Send message

Receive message

With/Without
response writing

Next process

Error process

For the details of setup method, refer to 7-3-4 Edit a Step of 7-3 Edit a Protocol in
the Section 7.
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3-3-2 Setting

Parameter Description Remark CommandParameter Description Remark

Send Recei
ve

Send
&

Receiv
e

Repeat counter Sets the number of times of
iterating the step (1-255). The
system increases the value of the
repeat counter N at every step.

Incorporating a linear expression
including the repeat counter N into
the send or receive message
allows users to freely change the
destination of the message or the
I/O memory to which the message
is stored.

O O O

Command Sets one of the following 3
types of command:

Send: Sends data
Receive: Receives data
Send&Receive: Sends and
receives data

When sending and receiving the
data by consecutive turns, using
the Send&Receive command
allows users to set the steps
efficiently.
Because the retry count for an
error can be set, the error process
is described simply.

Retry count Valid only for Send&Receive
command. The system executes
the current step up to the
specified times (0-9) when some
retry factor such as an error
occurs. If the retry factor still
remains, the control goes to the
error process.

During retrying, the send wait time
is ignored. Therefore, the send
wait time has to be provided by an
error process during retrying.
Likewise, a retry process has to
be provided by an error process
for Send or Receive command.

--- --- O

Send wait time Sets the wait time (Ts) as waiting
time for data sending to start.

Set a send wait time when the
communication partner can not
receive data immediately.

O --- O

Send message Sets the send message when the
command is Send or
Send&Receive.

See Section 3-4. O --- O

Recv message Sets the expected receive
message when the command is
Receive or Send&Receive.

See Section 3-4. --- O O

With/Without
Response Writing
(operand
addressing)

Sets whether received data is to
be written. Valid only when the
receive data are stored using the
operand addressing mode.

Setting this parameter to
“available” always needs to specify
the response method

--- O O

Next process Sets the next transit step when the
step ends normally.

End: Executes the step and
ends the sequence.

Next: Executes the next step.
Goto∗∗: Executes the step
specified by ∗∗.
Abort: Aborts the step and end the
sequence.

O O O

Error process Sets the next transit step when the
step ends abnormally.

Same as above. O O O

O : Available, ---: Not available

3-3-3 Repeat Counter

1, 2, 3... 1. Initial value specification

One of the following parameters can be set as the initial value in the correspond-
ing step of the repeat counter variable N.

Reset: After the repeat counter variable N is reset to 0 when the step is started, the step
is repeatedly executed by a specified number of times.
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Hold: When the step is started, the current value of the repeat counter variable is held
as it is, and the step is repeatedly executed by a specified number of times.

2. Number of iterations set
The number of iteration times to repeatedly execute the step can be specified by
one of the followings:
• Setting constant 1 to 255.
• Using a channel read R ( )

The content (binary) of the low-order byte at the channel of the second operand
+1 of a PMCR instruction is specified as the number of iterations.

The content (binary) of the low-order byte in DM0000 is specified as the number
of iterations.

Note How to specify channel read

R ( )

Start channel + constant

How to specify a
channel

Symbol to be
specified

ExampleHow to specify a
channel

Symbol to be
specified When constant=0 When constant=2

Operand
specification

None Cannot be set. R(2)

Link channel
specification

O1,I1, O2, I2 R(O1) R(O1 + 2)

Direct specification CIOjjj, LRjj,
HRjj, ARjj,
DMjjjj,
EMjjjj :
Channel#

R(DM0000) R(DM0000 + 2)

The content of the low-order byte at the start channel + constant channel is read
as binary data to indirectly specify the number of bytes.

• During step execution by the number of counts in the repeat counter, control is
not shifted to the transition destination specified for the next processing or er-
ror processing. After the step is executed by the number of set iterations, con-
trol is shifted to the specified destination for the next processing or error proc-
essing.

• Use the repeat counter variable N for specifying a send/receive message ad-
dress or data enables the following:

Example: When the same send message is sent to a multiple of N-connected external unit
Use the repeat counter variable N at the send message address.

Protocol Support Board

Example) R (1)

Example) R (DM0000)
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Example: If you want to specify different addresses for different steps to store receive mas-
sages, include the repeat counter variable N in the data in the receive message.

Protocol Support Board

& (W(N+1),2 Two-byte receive data is converted from ASCII to HEX and stored at the address
of the third operand specified address + (repeat counter variable N + 1) CH of a
PMCR instruction.

Note Refer to Message item data attributes

3-3-4 Commands
Set either Send, Receive, or Send & Receive.

Send: Sends a send message set in a step.

Receive: Handles a receive message in a step or receive message in a receive matrix as
an expected message, and receives data. (Note)

Send & Receive: After sending a send message set in a step, handles the receive message set in
a step or receive message in a receive matrix as an expected message, and re-
ceives data (Note)

Note Compare an actually received message and set receive (expected) message,
and if they are matched, go to the next processing. If they are not matched, con-
trol is shifted to the error processing for the receive message, and for the receive
matrix, to the next processing specified with “Other” (other than the set receive
message group.)
Generally, when a command is sent and a response is received, set Send&Re-
ceive.
Send&Receive allows retry to be specified. At retry, no transmission wait can be
applied. If you want to apply a transmission wait at retry, divide the retry in the
Send step and Receive step.

3-3-5 Retry count
When the retry count of the Send&Receive command is set, if a retry factor
among the above error factors occurs,(Refer to the table of error factors on the
following page) the system executes the Send&Receive command repeatedly. If
this error factor still remains after the specified number of retry repetitions, the
system goes to the error process.
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When retrying, the system sends data regardless of the send wait time Ts.

Send&Receive

Note To execute the retry process as an error process, it is necessary to set the steps
as follows. As you will see, the description of the error process is more compli-
cated than using Send&Receive commands with specifying the retry count.

Example: Retrying the same process 3 times.

Note When both the repeat counter N and the retry count is set, until the system exe-
cutes the steps for the times of the retry count, the counter N is not updated.
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When the retry factor disappears or the system has executed the steps for the
times of the retry count, the counter N is updated.

Send&Receive

3-3-6 Send Wait Time
For the Send or Send&Receive command, set the wait time taken from the cor-
responding step to come to data transmission.

3-3-7 Send Message/Receive Message

3-3-8 With/Without Response Writing
Set whether or not received data is written.
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This setting is valid when the data in a send message is specified with a variable
and the starting channel address is operand-specified.

3-3-9 Next Process/Error Process

When a step is normally terminated or abnormally terminated, set which step
control will be shifted to.

When a reception matrix is specified as a receive message, the above setting is
invalid, and the next processing specified with the receive matrix is valid.

Goto**: After execution of the step, shift to the specified step ∗∗ (0 to 15).

Next: After execution of the step, shift to the next (+1) step.

End: After execution of the step, terminate the entire sequence including the step.

Abort: If an error factor occurs in execution of the step, interrupt execution of the step
and terminate the entire sequence including the step.

Setting using the Protocol Support Tool

When one of the following error factors occurs, the step ends abnormally, and
then the system goes to the appropriate error process.
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Errors Command type When retry is
specified;

Errors

Send Recei
ve

Send
&

Receiv
e

When retry is
specified;

The Message that was received is not the same as the expected
receive message.

O O step is retried

Monitoring time expired The data (,or header) are not
received within “receive wait
monitoring time.”

O O

Data receiving is not finished
within “receive finish monitoring
time.”

O O

Data sending is not finished within
“send finish monitoring time.”

O O

A transmission error occurs during data receiving (The communication
error flag 28304 or 28312 is set to “on”).

O O

An error is detected in error check code. O O
Received data exceeds the specified area at attempting to write them in
the I/O memory (PMCR instruction execution error flag (11 or 12 of
268CH) of FAL9C is set to “on” and the protocol macro error code is
“3”).

O O step is not
retried

3-4 Communication Message Attributes

3-4-1 Communication Mechanism

As shown below, one of the features of data sending and receiving using the pro-
tocol macro function is that designations of reading/writing from or to the I/O
memory on the CPU unit are included in the communication message itself.

Specifically, when the communication message includes the variable responsi-
ble either for “Direct Addressing” which directly addresses I/O memory or for
“Operand Addressing” which addresses I/O memory using the second or third
operand of the PMCR instruction, user can send or receive data in I/O memory.
Refer to 3.2.4 Link Word Addressing for the details on addressing.

Sending

Protocol Support Board
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Receiving

Protocol Support Board

$(N, 1) Use a repeat counter (1 byte) as an address.

In addition, the inclusion of repeat counter N as a variable allows users to
change the address of I/O memory at every sending or receiving, and to change
the address of send message.

Example: When sending the same message to more than one external device connected
in one-to-n configuration, you can use the repeat counter variable N as the ad-
dress of the send message.

Protocol Support Board

Example: If you want to specify different addresses for different steps to store receive mas-
sages, include the repeat counter variable N in the data in the receive message.

Protocol Support Board

&(W(N+1),2) Two-byte receive data is converted from ASCII to HEX and stored at the address
of the third operand specified address + (repeat counter variable N + 1) CH of a
PMCR instruction.

Note Refer to Message item data attributes
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3-5 Communication Message Structure
The Communication message contains 6 items: header, address, length, data,
error check code, and terminator.

Header Address Length Data Check code Terminator

Parameter Description Data attributes

Header Sets the data that indicate the beginning of the communication message
frame. At reception, data from the header is received as the message.

Constant only

Address Sets the unit number or other information to be used as the message’s
destination.

• The system identifies whether the receiving data is addressed to itself.

• When “Word writes” or “Wild card” is set as a data attribute, the system re-
ceives all themessages as addressed to itselfwithout identifyingwhether it
is addressed to itself (broadcast addressing.

• The message sending address can automatically be updated by using the
repeat counter.

Constant (Reserved
characters are not available.)
Variable

Length • Indicates the length (number of bytes) of amessage. Basedon thecalcula-
tion method set at transmission (length size/data format), calculates and
message length and append the value before sending,

• At the message reception, this data is not checked.

Automatic variable

Data • For sending messages
Set the data to be sent.

• For receiving messages
Set the data expected to be received. When the data of the actually re-
ceived message frame is different from the specified data, the system exe-
cutes the error process.

Constant
Variable

Error check
code

• At send processing, the check code of the send message frame is auto-
matically calculated according to the setup, and appended to the message
frame to be sent.

• At receive processing, errorchecking is executed that compares thecheck
code that was received with the check code locally calculated from the re-
ceived data.

• When both check codes are not the same, the control goes to the error pro-
cess.

Automatic variable
(LRC,SUM, LRC, CRC-16,
SUM2, CRC-CCITT, or
No-Check)

Terminator Marks the end of a message frame.

• When sending a message, the system finishes a frame of the message
sending after it sent the terminator. If the terminator is not set, the system
finishes the sending when it sent the data set at the end of the send mes-
sage.

• At receiving message, the system finishes the receiving when it received
the terminator. If the terminator is not set, the system finishes the receiving
when it received the data set at the end of the receive message.

• If the number of bites of data set at the end of the receive message is “Wild
card”, the system finishes the receiving when the buffer becomes full (256
bytes). However, if a flow control (X-on/X-off, RTS/CTS) is set, the system
sends out the X-off code when the buffer is filledup to75% (200bytes) of its
size and finishes the receiving.

Constant only

Note The above six items can be eliminated in the following cases:
At sending: The header, the address, the length, the error check code, and the
terminator can be eliminated.
At receiving: If the terminator exists, the header, the address, the length, and the
error check code can be eliminated. If the data length is fixed, the terminator can
be eliminated as well.
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3-5-1 SYSMAC-PST Setup Screen
Message name (Note)

Header Terminator

Check code Length Address Data

For the details of setup method, refer to the Section 8 Editing Send & Receive
Messages and Receive Matrices.

Note After the creation of communication message, users can create steps by speci-
fying the message name.

3-5-2 Header
Indicates the beginning of a message. Only a constant can be specified.
Selects the message type (ASCII, HEX, control code), and enters data.

Example: Type: ASCII, data: @ (screen display: “@”)

3-5-3 Address
Specify the address when a message is subjected to 1:N communication. A
constant or variable can be specified. A constant and a variable can be com-
bined as a string. Using the repeat counter variable N for the variable can
change the address for each sending and receiving.
Select the address type (constant, variable), and enter data.

Example: Type: Variable, conversion: None, data: (R(1),2) (screen display: (R(1),2))

3-5-4 Length
At sending, automatically calculates the length of the entire message (excluding
this item itself), and adds the item. Unit: No. of bytes.
At reception, this length data is not checked.
Specify the length size (one byte, two bytes), data type (ASCII, BIN) according to
the communication specification of the unit at the communication partner.

Example: 1 byte, BIN, initial value: 0 (screen display: (0) (1-byte BIN))

Note The length calculation range is set in the “Range” of the [Edit Message] dialog.

3-5-5 Data
At sending, specify data to be sent. At reception, specify expected data.
A constant or variable can be specified. A constant and a variable can be com-
bined as a string.
Specifying a variable allows the I/O memory channel data to be used as part of
data (At sending: read, at reception: write). Further, using the repeat counter
variable N for the variable allow data to be changed for each sending and receiv-
ing.
Select the data type (constant, variable), and enter data.

Example: Type: Constant (ASCII), data: RX0
Type: Variable (HEX), data: &(N,R (1))
Type: Constant (ASCII), data: 00

(Screen display: “RX0” + &(N,R(1)) + “00”)
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3-5-6 Error check code
Specify the error check code when data is sent.
LRC, CCITT, CRC-16, SUM (1-byte/2-byte), and SUM2 (1-byte/2-byte) can be
specified. As the data type, BIN or ASCII can be selected. The data size, default,
and swap between high byte and low byte can be specified.

Example: Type: LRC, data type: ASCII, data size; 2 bytes, initial value: 0 (screen display):
LRC (H parity) (0) (2-byte ASC)

Note 1. The error check code range is set in the “Range” of the [Edit Message] dia-
log.

2. SUM2, CRC-16, and swap between high byte and low byte are possible only
when the Communications Board is C200HW-COM**-EV1.

3-5-7 Terminator
With reception of this code, data reception is completed. (When data is received
without this code, data reception will be completed when the data that corre-
sponds to the length of the message set in the reception message inside the step
is received.)
With sending of this code, data sending is completed. (When data is sent without
this code, data sending is completed at the time when the last data is sent.)
Only a constant can be specified.
Select the terminator type (ASCII, HEX, control code) according to the commu-
nication specification of the unit of the communication partner, and enter data.

Example: Type: HEX, data: 2A0D (screen display [2A0D])

3-5-8 Message item data attributes
Users can set the following constants or variables as message items.

Constant (can be set for header, address, data, or terminator)
Constant Specifying method Examples

ASCII data Specify between double
quotes as in “12345”.

“12345”

HEX data Specify between square
brackets as in [5A2B].

[5A2B]

Control code Specify by selecting the
special code such as CR,
LF, or STX from the list.

[OD] for CR

Variable (can be set for address or data)
Variables read and write into the I/O memory of PLC, and utilize repeat counter
variables.

Specify in the form of (X, Y).
X: The effective address

Specifies where to read or write in the I/O memory, or the liner expres-
sion including N, or the wild card. One of the followings can be used for
specify these items.

a) Both the read/write options and the starting channel + (the linear expres-
sion including N)

b) Linear expression including N.
c) Wildcard (∗)

Note Wildcard can be specified only in the receive message.

1. Format
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Y: Data size (0-255)
Specifies the number of bytes to read or to write, when the data are not
converted. (Specifies 1 when reading the value of N.)
Specifies the number of bytes on the transmission, when the data are
converted. The number of bytes on I/O memory are as follows.

Option Data size on the I/O memoryOption

$ (HEX→ASCII) & (ASCII→HEX)
R (Read from the PC→Send) Y/2 bytes Y x 2 bytes

W (Receive→Write to the PC) Y x 2 bytes Y/2 bytes

One of the following can be used for specify items.

1, 2, 3... 1. Linear expression including N.
2. Wildcard (∗)

Note Wildcard can be specified only in the receive message.

3. Both the read option and starting channel + (the linear expression including
N)

Note Reads bits 0 to 11 of the word as 3-digit BCD.

There are three types of variables as shown below. For each variable, users can
set the attribute which specifies the direction (forward or reverse direction) to
read or to write the data to be converted.

Forward direction : Bit: High-order → low-order, channel: high-order → low-order
Reverse direction : Bit: High-order → low-order, channel: low-order → high-order

Variable Read/write direction Function
Unconverted variable Forward Reverse Read WriteUnconverted variable

(X, Y) ~ (X, Y) Y bytes of data from the address specified by X
are processed without conversion.

Variable converted to
ASCII

$(X, Y) ~$ (X, Y) Y/2 bytes of HEX data
from the address
specified by X are
converted to Y bytes of
ASCII data.

Y bytes of HEX data is
converted into ASCII
data equivalent to Y∗2
bytes before storage
with the address
specified by X as the
beginning.

Variable converted to
HEX

& (X, Y) ~& (X, Y) Y∗2 bytes of ASCII
data from the address
specified by X are
converted to Y bytes of
HEX data.

Y bytes of ASCII data is
converted into HEX
data equivalent to Y/2
bytes
before storage with the
address specified by X
as the beginning.
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Variable Format

~$(R(DM0000), 2 )

X Y

Data size on the transmission path:

Effective address:
The beginning word + (The linear expression including N)

Read/ Write option
R: Read from the PLC
W: Write to the PLC

Conversion attribute
Blank: Unconverted
$: ASCll conversion
&: HEX conversion

Conversion direction
Blank: Forward direction
~: Reverse direction

or the wild card (*)

The linear expression including N or the wild card (*) or indirect specifi-
cation by the Read option (RC): Reads from PLC.
(Reads bits 0 to 11 of word as 3-digit BCD.)

Note How to specify a channel

How to specify a
channel

Symbol to be
specified

ExampleHow to specify a
channel

Symbol to be
specified When linear

expression
including N=0

When linear
expression

including N=1
Operand
specification

None Cannot be set. R(1)

Link channel
specification

O1, I1, O2, I2 R(O1) R(O1+1)

Direct specification CIOjjj, LRjj,
HRjj, ARjj,
DMjjjj,
EMjjj
j : Channel #

R(DM0000) R(DM0000+1)

Note For converted variables:

When the frame format of instructions (commands) that the partner machine can
translate is configured by ASCII code, the numeral HEX data in the I/O memory
have to be converted to HEX data by $( , ) before they are sent, and the numeral
ASCII data have to be converted to HEX data by &( , ) before they are received.
• When converting data (HEX data) in the I/O memory into ASCII codes before

sending
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Example: Convert a 6-digit numeric value (3 bytes in the I/O memory) for the DM0000 into
the ASCII code in the Reverse direction

5 6

1 2

7 8DM0000

15 0
~$( , ) 35 36

”5” ”6”

37 38 31 32

”1” ”2””7” ”8”On the
transmission path

How to specify: ~$ (R (DM0000) 6)
Number of bytes in the transmission path
(after ASCII conversion)

Read from DM0000

HEX ASCII conversion

Reverse direction

• When converting the numeric data (ASCII data ) from the mating unit into the
HEX data and receiving and writing it

Example: Converting a 5-digit numeric data (5 bytes in ASCII data) into the Hex data, and
write it from the I/O memory DM0000 in the reverse direction.

1 2

5 0

3 4

0 0

DM0000

15 0
~&( , )31 32

”1” ”2”

33 34 35

”5””3” ”4” On the
transmission path

How to specify: ~& (W (DM0000), 5)
Number of bytes in the transmission path

Read from DM0000

ASCII HEX conversion

Reverse direction

Users can set the following contents on the X and Y of variable (X,Y).
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Contents of X and Y
How to set X and Y Specification Example Items availableHow to set X and Y Specification Example

Send Receive
Address Data Receive Data

How
to
set
X

Reading
/writing
the I/O
memory

Word
reading

Operand
address-
ing

R (z)

Beginning CH +
(Linear ex-
pression in-
cluding N)

Read option

Read from the
beginning CH +
(yN + x)CH

(R (1),1)
The system reads
one byte from the
second operand of
the PMCR
instruction + 1
location to send it
with no conversion

O O O O

Link
word
address-
ing

R (z)

Beginning CH +
(Linear ex-
pression in-
cluding N)

Read option

$(R(O1+5),2)
The system reads 2
bytes from the 5th
word in the link
word’s output area
1to send it with
conversion to ASCII
form.

O O O O

Direct
address-
ing

Read option

Read from the
beginning CH +
(yN + x)CH

$(R(DM0000),3)
The system reads 3
bytes from DM0000
to send it with
conversion to ASCII
form.

O O O O
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How to set X and Y Specification Example Items availableHow to set X and Y Specification Example

Send Receive
Address Data Receive Data

How
to
set
X

Reading
/writing
the I/O
memory

Word
writing

Operand
address-
ing

W (z)

Beginning
CH + (Lin-
ear expres-
sion includ-
ing N)

Write option
Read from the
beginning CH
+ (yN + x) CH

(W(1),1)
The system writes
one byte of receive
data to the (third
operand of the
PMCR instruction +
1)th word with no
conversion.

--- O --- O

Link
word
address-
ing

W (z)

Beginning
CH + (Lin-
ear expres-
sion includ-
ing N)

Write option

&(W(I1+5),2)
The system writes 2
bytes of receive
data to the input
area 1 of the link
word’s 5th word with
hexadecimal
conversion.

--- O --- O

Direct
address-
ing

Write option
Read from the
beginning CH
+ (yN + x) CH

&(W(LR0060),3)
The system writes 3
bytes of receive
data to LR0060 with
conversion to HEX
form.

--- O --- O

Wild card Can be set only in
the address part or
data part of the re-
ceive message.
• Setting the wild

card in the address
part
The system re-
ceives all the mes-
sages without
checking the ad-
dress data.

• Setting the wild
card in the data part
The system re-
ceives all data with-
out checking the re-
ceived data.

With (∗, 2) specified
in the address part,
2 bytes can be
received from any
address.
With (∗, 5) specified
in the address part,
5 bytes can be
received from any
address.

--- O --- O

N (repeat counter) N (N, 1) repeat
counter value

O O O O

How
to
set
Y

Linear expression including N
(repeat counter)

yN+x

Constant.
Sets the
number of
bytes
(1-255).

Repeat counter
value
Coefficient
(0-255).

$(R(1),2)
The system
repeatedly reads 2
bytes starting at
word No. (second
operand of the
PMCR instruction +
1) to send it
converted to ASCII
form.

O O O O
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How to set X and Y Specification Example Items availableHow to set X and Y Specification Example

Send Receive
Address Data Receive Data

How
to set
Y

Wild card Can be set only in
the data part of the
receive message.
Setting the wild card
in the data part The
system receives all
the messages
without checking the
received data.

&(W(1),∗)
The system
receives data from
the third operand of
the PMCR
instruction + 1 to
store it with
conversion to HEX
form regardless of
the length.

--- O --- O

I/O
Chan
nel
read

Chan
-nel
read

Operand
specificatio
n

R (z)

Beginning
channel +
(linear
expression
including
N)

Read option

Beginning
channel + (linear
expression
including N)

Read option

The content of the
low-order byte of
the starting CH +
(yN + x) CH is read

as a binary value
and handled as a
byte.

(∗,R(1)): Set in
receive data.
Any receive data is
received by the
number of bytes of
the contents CH +
1CH specified using
the third operand.

O O O O

Link
channel

R (z)
Beginning
channel +
(linear
expression
including
N)

Read option

Beginning
channel + (linear
expression
including N)

Read option

(R(1) , R(O1): Set in
send data. Data is
sent by the number
of bytes of the
contents of the
starting CH at the
link channel output
area | from CH +
1CH specified with
the second operand
of a PMCR
instruction.

O O O O

Direct Read option

The content of the
low-order byte of
the starting CH +
(yN + x) CH is read

as a binary value
and handled as a
byte.

(R (DM0000), R
(DM0100)): Set in
send data. Data is
sent by the number
of bytes of the
contents from
DM0000CH to
DM0100.

O O O O
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Examples of the variable
CPU to Unit PSB Reading

“x”

“x”

PSB to CPU Unit Writing

Note 1. 0 is stored in an empty bit in a word whose write data is less than 16 when
writing into the CPU unit.
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When the receive data has variable length, use the wild card (∗).

Convert other than numerical data in the following way:
• The negative sign (--) is recognized as a minus value and the highest digit is

stored as FHex.

• The decimal point is ignored when the data is stored.

• Symbols and characters other than 0 to F are stored as 0Hex.

Receive data string
(Example)

Variable (ASCII to HEX
conversion)

After conversion

HEX: 2D 31 32 33 34 35
ASCII: -- 1 2 3 4 5

& (W(DM000,6) DM0000
DM0001

23 45
00 01

HEX: 31 32 33 2E 34 35
ASCII: 1 2 3 . 4 5

DM0000
DM0001

23 45
00 01

HEX: 31 2F 33 34 35 36
ASCII: 1 / 3 4 G 6

DM0000
DM0001

34 06
00 10

Note Error Check Code

For protocol macros, the following 8 types of check code can be set:

Calculation
method

Data type Reverse
direction

(see note 2)

Initial value

LRC BIN 1 byte Unavailable 0-255LRC

ASCII 2 byte
(see note 1)

Available

0-255

Sum
(1 byte)

BIN 1 byte Unavailable 0-255Sum
(1 byte) ASCII 2 byte Available

0-255

Sum
(2 bytes)

BIN 2 byte Available 0-65535
(2 bytes)

ASCII 4 byte Available

Sum2
(1 byte)

BIN 1 byte Unavailable 0-255Sum2
(1 byte) ASCII 2 byte Available

0-255

Sum2
(2 bytes)

BIN 2 byte Available 0-65535Sum2
(2 bytes) ASCII 4 byte Available

0-65535

CRC-CCITT BIN 2 byte Available ---CRC-CCITT

ASCII 4 byte Available

---

CRC-16 BIN 2 byte Available 0-65535CRC-16

ASCII 4 byte Available

0-65535
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Note 1. Swap between high byte and low byte of the error check code is possible
only when the Communications Board is C200HW-COM**-EV1.

2. The host link (SYSWAY) uses an error check code: LRC ASCII 2-byte (se-
quential direction).

The followings are the examples of the calculation:
Example) Following message items are used to calculate the check code when
the initial value is 0.

00 52 44 38 39

Calculation items

1, 2, 3... 1. LRC (Longitudinal Redundancy Check)
This mode calculates the exclusive OR (XOR) of the characters of a set of data
to create a check code.

LRC 2byte ASCII 00 52 44 38 39 31 37 0D

LRC 2byte ASCII 00 52 44 38 39 37 31 0D

LRC 1byte ASCII 00 52 44 38 39 17 0D

: Check Code

Initial value

XOR

XOR

XOR

XOR

1 byte
Calculation result

(1)

(2)

(3)

(4)

00 Hex

52 Hex

44 Hex

38 Hex

39 Hex
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2. SUM

This mode adds arithmetically the characters of a set of data to create a check
code. Users can specify either of the directions for storing the SUM, as with vari-
ables.

SUM (1 byte) ASCII 2byte 00 52 44 38 39 30 37 0D

SUM (2 byte) ASCII 4byte 00 52 44 38 39 30 31 30 37 0D

SUM (1 byte) BIN 1byte 00 52 44 38 39 07 0D

: Check Code

SUM (2 byte) BIN 2byte 00 52 44 38 01 07 0D
~SUM (1 byte) ASCII 2byte 00 52 44 38 39 37 31 0D
~SUM (2 byte) ASCII 4byte 00 52 44 38 39 31 30 37 30 0D
~SUM (2 byte) BIN 2byte 00 52 44 38 39 07 01 0D

Note SUM2 is the 2’s complement of SUM.

3. CRC (Cyclic Redundancy Check Code)

This mode regards the whole data as a bit string (message polynomial), divides
this string by the fixed constant (generative polynomial), and defines the remain-
der as the check code.

CRC detects errors better than the vertical parity or horizontal parity, and is used
widely in LANs, etc (For example, the SYSMAC LINK uses CRC-CCITT).

Various kinds of CRC can be used. The calculation mode defined according to
the CCITT recommendation is called CRC-CCITT, where X16+X12+X5+1 is
used as the generative polynomial. (Incidentally, CRC-16 (X16+X12+X2+1) is
also often used as a generating polynomial.)

CRT-CCITT 4byte ASCII 02 52 44 38 39 33 36 46 42 0D

: Check Code

CRT-CCITT 2byte BIN 02 52 44 38 39 36 FB 0D

CRT-16 4byte ASCII 02 52 44 38 39 42 46 46 41 0D

CRT-16 2byte BIN 02 52 44 38 39 BF FA 0D

Note Reverse direction is available. Default value can be set for the CRC-16

The generating function in the calculation mode of the CRC that is mounted on
the C200HW-COM04/05/06-EV1 is uniquely determined as CRC-CCITT or
CRC-16. Data for each character of CRC-CCITT is treated differently from that
for CRC-16 as shown below.
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If a message with “n” characters, which is subject to check code calculation, is
expressed as shown in the following table, the MSB (Most Significant
Bit) and LSB (Least Significant Bit) in every character for CRC-16 will be re-
versed as shown in the following tables.

C0 C1 --- Cn--1

D0(7) to D0(0) D1(7) to D1(0) --- Dn--1(7) to Dn--1(0)

Note D: 0 or 1

CRC-CCITT

C0 C1 --- Cn--1

D0(7) D0(6) to D0(0) D1(7) D1(6) to D1(0) --- Dn--1(7) Dn--1(6) to
Dn--1(0)

CRC-16

C0 C1 --- Cn--1

D0(0) D0(1) to D0(7) D1(0) D1(1) to D1(7) --- Dn--1(0) Dn--1(1) to
Dn--1(7)

Therefore, algorithm for each one becomes as shown below.
• CRC-CCITT algorithm

The last value is determined
as the check code.

• CRC-16 algorithm

The last value is determined
as the check code.

X16 X12 X2

MSB LSB

Data input

3-5-9 Supplemental Notes on Message Setup
1, 2, 3... 1. Specifying more than one constant or variable

To specify more than one constant or variable, use + as follows:

Example: Sending a command (”RX0” + word number + “00” (code number)) to determine
the PV (Process variable) of the temperature controller

”RX0” + $(N,1) + “00”
↓

A message “RX0N00” (N is the value of the repeat counter, 0-255) is sent.
N = 0: “RX0000”
N = 1: “RX0100”
N = 2: “RX0200”

2. Word writing for receive messages
For receive messages, the system needs to compare the “address part” of
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the message frame that was received, confirm whether this part has the self
unit number or not, receive the data part if so, and store this “data part” to the
appropriate area on the PLC by “word writing.”

• Specify the data needed for comparison such as an address using a constant,
variable with constant X, variable (word reading), wild card, etc.

• Specify the data necessary to be stored to the area on the PLC using a “vari-
able (word writing).”

Example: Comparing the address part (2 bytes long) and receiving the data part succeed-
ing the address part to store in the I/O memory on the PLC

Address specification
: $(R(1),2) When the received message is for the receiver (the received

address is the same as the address (2 bytes long) set in the
second operand of the PMCR instruction + 1, and then con-
verted to ASCII form), the data part succeeding this address
part is received.

Note Note: The message to be compared (expectation message) is word read (R
option).

: (∗,2) Whichever unit address the destination of the receive message
has, the data part succeeding the address part is received.

Note Note: For the address part, the wild card (∗) can be used only on X.

Data addressing
: &(W(1), ∗) The data that were received are written to the third operand of

the PMCR + 1 with conversion to HEX form regardless of the
length.

Note Note: To store the data that were received into the area on the PLC, use word
writing (W option) to specify.

Example: Comparing some part of the receive data and storing the other part of the data to
the PLC area.
The system checks the command string “TX∗∗” in the data that were received, and then
stores the succeeding data to the area in the PLC.

Data specification:
“TX”+(∗,2)+&(W(1), ∗) When receiving the command TX, the system does not

compare the next 2 bytes of data, and stores the subsequent
data with converting to HEX form regardless of the length.

• If the wild card (∗) is set at the data size part of “variable (word write)”, the sys-
tem finishes the message receiving when the buffer becomes full (256 bytes)
with the message.

• If the wild cards are set at the data sizes of consecutively specified “variables
(words write)” (separated by “+”), the first “variable (word write)” only is effec-
tive.
For example, (W(1), ∗)+(W(10), ∗) is equal to (W(1), ∗).

• If “+”s separated by a constant or a check code are specified between “vari-
ables (words write)” the data sizes of which the wild cards are set,
the constant or the check code is deemed a delimiter.

For example, if “12345ABC5678” is received while (W(1), ∗)+”ABC”+(W(10), ∗)
is set, “12345” corresponds to (W(1), ∗) and “5678” corresponds to (W(10), ∗).

3. Setting the header, check code, and terminator
• For the header or terminator, various special codes such as @, CR, LF, STX, or

ETX are used according to the mating communication unit. Always set on the
message the same header or terminator as the mating communication unit.
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• Most of the mating communication unit can send or receive only ASCII codes.
In this case, convert the HEX code into ASCII before sending and convert re-
ceived data from ASCII to HEX conversion before storage. Consider the data
format and reading/writing direction which allows sending/receiving of the
mating unit, and convert it into a data format which can be handled with the
data conversion-available variable before sending and receiving.

3-6 Creating Receive Matrices
Receive matrices are set when more than one receive messages are expected
to be received or when users want to change next process for each receive mes-
sage.
Up to 15 types of message can be set in a receive matrix (case no.00 ∼15). In a
receive matrix, next processes such as End, Next, Goto∗∗, or Abort set for each
one of the up to 15 types maximum of receive message.
”Other” must also be set to enable processing when some message other than
the receive messages specified in the matrix is received.

Note The unit by which the system compares the expected value with the actually re-
ceived value in the receive matrix is not of data, but of messages.

<t><c>Data<a><h> <t><c>Data<a><h>

<t><c>Data<a><h>

<t><c>Data<a><h>

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Receive
Received message

<h>: Header
<a>: : Address
<c>: Error check code
<t>: Terminator

Other (must be set.)

Note: Maximum of 16 cases are possible including “Other.”

Receive matrix

Next processingReceive (expected) message

For example, using a receive matrix allows users to efficiently create the follow-
ing communication sequence.

Example: Via the host link (SYSWAY), change over the processing according to the re-
sponse (Program/Monitor/RUN mode) for the status read command.
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Protocol Support Board

Host link MS command Response PLC

* Issue an MS command.
Transmission message:

* Receive a response.
Receive matrix: Case No.00

Case No.01

Case No.02

“@”+“00”+“MS”+LRC+[2A0D]

“@”+“00”+“MS”+“00”+“00”+(*,*)+LRC+[2A0D]

“@”+“00”+“MS”+“00”+“02”+(*,*)+LRC+[2A0D]

“@”+“00”+“MS”+“00”+“03”+(*,*)+LRC+[2A0D]

Header
Address Host

link command

Program mode code
End code

Receive
(expected)

message
Next processing
Go to 01

Monitor mode

RUN mode

Go to 02

Go to 03

Case No.03 Others

By using the receive matrix, identify the difference in the status in the response
data (section in the above), and change over the processing according to the
mode of the PLC.

An example of using the receive matrix
Change over the processing according to the ACK, NAK reception.
In the following example, the entire message structure is omitted and only data is
indicated with “”.
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Send message
Send

&
Receive

Send data Error

Receive
the
expected
message Abort

Next
Step No. 01

Step No. 00

Send escape
code

Send
&

Receive

Retry
three
times
Retry
count

Receive a
result code

Other
than 0,
or Error

Send
&

Receive

If 0

Abort

Abort

NextStep No. 02

Send disconnect
command

Retry
three
times

Retry
count

Receive a
result code

End

N

Y

Step structure

Step No. Repeat
counter

Command Retry Second
wait

Second
message

Receive
message

Response
notification

Next
process

Error
process

00 R/001 Send&Receive ”ENQ” ”ACK” Next Goto o00_ _ _

01 R/001 Send&Receive

02 R/001 Send&Receive

_

_

Message Receive
matrix

”EOT” End Abort_

_

__

_1 s Goto o00

Receive matrix

Case No. Receive
message

Next
process

00 ”ACK” Goto02

01

~

”NAK” Goto01

Abort15 Other

Set next processes (End, Next, Goto**, or Abort)
for each one of the up to 15 types of receive
message.

For “Other case, set the next process to be
executed when the message that was received is
not equal to any of the expectation messages.

Note Set same header and same terminator for all the receive messages set by the
receive matrix. If headers or terminators are different by case number, the sys-
tem shall make a comparison for the received message based on the header
and the terminator (or the data length, if the terminator is unavailable) of a re-
ceived message set as case number 00. For example, therefore, if the header of
case number 00 is “@” and the header of case number 01 is [02](STX), the sys-
tem identifies that the comparison results in the unmatched even if the header of
actually received message is [02], because it is different from the header “@” of
case number 00.
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3-7 Example of standard system protocols

3-7-1 Example: “Current-value read” sequence of the regular (type E5K
read system) protocol

Level Item Contents of setting
Sequence Link word ---Sequence

Transmission control parameter Modem control
Response Type Scan
Receive wait monitoring time Tr 3s
Receive finish monitoring time Tfr 3s
Send finish monitoring time Tfs 3s

Step Step No. 00Step

Repeat counter RSET/001
Command Send&Recv
Retry counter 3
Send wait time ---
Send message SD(00)_1
Receive message RV(00)_1
With/Without response writing Yes
Next process End
Error process Abort

Send message
SD(00)_1

Header <h> ”@”Send message
SD(00)_1 Terminator <t> [2A0D]

Error check code <c> LRC (H parity) (0) (2-byte ASCII)
Length <I> ---
Address <a> $(R(1)),2)
Message editing <h>+<a>+”1”+”00”+”0000”+<c>+<t>

Data
Reception
message

Header <h> ”@”Reception
message
RV(00)_1

Terminator <t> [2A0D]
RV(00)_1

Error check code <c> LRC(H parity)(0) (2-byte ASCII)
Length<I> ---
Address<a> &(R(1)),2)
Message editing <h>+<a>+”00”+”00”+&(W(1),4)+<c>+<t>

Data
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3-7-2 Modem Initialization (MD24FB10V) sequence of Modem Hayes AT
command Protocol

Level Item Contents of setting
Sequence Link word ---Sequence

Transmission control
parameter

RS/CS flow (receiver), modem control

Response type Scan
Receive wait monitoring time
Tr

10s

Receive finish monitoring
time Tfr

---

Send finish monitoring time
Tfs

---

Step Step No. 00 01 02Step

Repeat counter RSET/001 RSET/001 RSET/001
Command Send &Recv Send &Recv Send &Recv
Retry counter 0 0 0
Send wait time --- 1s 1s
Send message MD24FB10V MD24FB10V MD24FB10V
Receive message <Initial-R1> <Initial-R2> <Initial-R3>
With/Without response
writing

None None None

Next process Matrix Matrix Matrix
Error process Goto 1 Goto 2 Abort

Send
message

Header <h> ---Send
message
MD24FB10V

Terminator <t> CR
MD24FB10V
_1 Error check code <c> ---_1

Length <I> ---
Address <a> ---
Message editing ”ATE0V0X4OV2ON3%C0*C0OX1&M0”+”S26=10”+<t>

Data
Receive
matrix

Case No. 00
matrix
<Initial-R1>
<Initial-R2>

Receive message RxD.0
<Initial-R2>
<Initial-R3> Next process End

Receive
message

Header <h> ---Receive
message
RXD.0

Terminator <t> CR
RXD.0

Error check code <c> ---
Length <I> ---
Address <a> ---
Message editing ”0” + <t>

Data
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3-8 Example of Communication Sequence
Shown below is an example of sequence to read process values from a 8CH
type temperature controller (E5ZE):

3-8-1 Sequence Setup Content

Sequence No. 101

Link word Transmission
control mode

Response type Monitor time, Tr Monitor time, Tfr Monitor time Tfs

--- Modem control Scan mode 3s 3s 3s

3-8-2 Step Setup Content
Create a process flow as follows:

Step No. 00

Receive the
response

Send the read command
for process value

Current value of Repeat
Counter

N=8

End Abort

Send & Recv

Normal

Y

N

The system sends the read command for a process value and waits the re-
sponse from the temperature controller. It converts the process value data to
HEX codes and store them in I/O memory. It uses the repeat counter to switch
the PLC area, sends the read command for the next process value until eight
words process values are read and stored in the PLC areas.

According to a set retry count (three times), the same step is repeatedly execut-
ed up to three times automatically at any of the following error occurrences:

• The send finish monitoring time Tfr, the receive wait monitoring time Tfr, or the
receive finish monitoring time Tfr is expired.

• A receiving communication error occurred (port A: CIO28304 or port B: 28312
is “ON”).

• Wrong receive message.

• An error in the error check code.

Step No. 00

Normal

Abnormal
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Repeat
counter

Command Retry
count

Send wait
time

Send
message

Receive
message

With/Without
response
writing

Next
process

Error
process

RSET/008 Send&
Recv

3 --- Described
below

Described
below

With End Abort

3-8-3 Send and Receive Messages Creation
The system can read the PV (process variable) of the specified word on the tem-
perature controller (E5ZE) by sending the “RX0N00” (N is the word number of
the controller) command. Only one word of data can be read in one time of data
sending or receiving. When reading 8 words of data, it is necessary to execute
the Send&Recv command 8 times repeatedly.

Send message

Example: A frame of read command for the process variable

@ Unit R X FCSO Word O O *

Header Address Data Check code Terminator

Receive message

Example: A frame of the response to the read command for the process variable

@ Unit R X FCSEnd code Process variable *

Header Address Data Check code Terminator

• Specifying the unit number as 2 characters (1 byte) beginning from the second
operand of the PMCR instruction + 1



3-8SectionExample of Communication Sequence

85

• Specifying the word number of the measured temperature as 1 digit of the re-
peat counter N

As a result, create the send message as follows.

$

3-8-4 Receive Message Creation
• Writing the data of the measured temperature to the third operand of the

PMCR instruction + (2N + 1) without fixing the length.
Note: N means the value of the repeat counter.

*

Create the receive message as follows.

$ *

3-8-5 Contents of sequence
Measuring temperature reading in sequence No. 10 of the temperature control
(Model E52 reading series) protocol
• Sequence unit setting

Item Contents

Link word No setting

Transmission control parameter Modem control available

Response type Scan posting method

Receive wait monitoring time (Tr) 3s

Receive finish monitoring time (Tfr) 3s

Send finish monitoring time (Tfs) 3s
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• Step unit setting

Step 00 (only)

Item Contents
Repeat counter Repeat type: ResetRepeat counter

Counter: 8 (constant)
Command Send & Receive

No. of retries 3

Send wait time None

Send message Message name: SD (RX)1

Receive message Message name: RV (RX)x1

With/Without Response Writing Yes

Next process End

Error process Abort

• Presence of send/receive message

Send message name <SD(RX)1>

”@”+$(R(1),2)+”RX0”+$(N,1)+”00”+LRC(H parity)(0)(2 Byte ASCII)+[2A0D]

Header Address Data Check code Terminator

Receive message name <RV(RX)1>

”@”+$(R(1),2)+”RX0”+&(W(2N+1),*)+”00”+LRC(H parity)(0)(2 Byte ASCII)+[2A0D]

Header Address Data Check code Terminator

3-9 Executing Created Communications Sequence
This section describes how to execute the communication sequence described
so far. It is necessary to transfer the protocol that was created to the PSB in ad-
vance. However, the previously mentioned communication sequence is regis-
tered in sequence number 101 of the incorporated standard system protocol, so
the following describes the procedure for executing sequence number 101.

Note It is assumed that the standard protocol is under the initial status. When the se-
quence is changed by the Protocol Support Tool or other modes, return to the
original sequence before execution.

3-9-1 Device Connection
It is assumed as an example that a PLC (Model C200HX), Communications
Board (Model C200HW-COM06), and temperature control device (Model
E5ZE) are connected as follows.
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8 bits of measured temperature are assumed to be stored to DM101-116.

3-9-2 Initial Setup
1, 2, 3... 1. Set the dip switch on the PSB.

2. Set the PLC system setup of C200HX as follows:
Use DM6555 #6000:

Note Communications mode as the protocol macro function to set the
communications requirements as follows:

Note1: #6000

The mode used by port A

The communication requirement of port A
0: Standard setup

Standard setup contents

Start bit 1 bit

Data length 7 bits

Parity Even parity

Stop bit 2 bits

Baud rate 9600bps

Note For more information of the PLC system setup area related to the protocol macro
function.

3. Set the temperature control device (E5ZE)
Set the unit number to “0” and baud rate to “9600 bps”.

Switch Unit:
Used for setting
the Unit number.
Set to “0”.

Switch Function:
Used for setting
the switch function.

Switch Function

ON

OFF

Hardware mode
Not used (Must be OFF)

Connection of E5ZD-SDL Setting Indicator
Operation mode when the power is ON
Temperature unit (_C or _F)

Memory bank designation method
1: ON, 2* OFF (Set to 9600 bps)
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Note After changing the dip switch’s setting, turn OFF and ON the power supply once.

3-9-3 Creating Ladder Programs
The protocol is executed by the PMCR instruction of the PLC.

• PMCR instruction specification

• Function: Calls the send/receive sequence No. registered in the PSB, and
executing the send/receive sequence of the corresponding sending/re-
ception sequence and sends/receives data to/from the general-purpose
external unit through port A or B of the PSB.

• Meaning of operand:

C: Control data

15 12 11 8 7 0

Send/receive sequence
No. 000 to 999(BCD)

Port specification
1: Port A
2: Port B

PMCR

C

S

D

S: Send data starting channel number

Set the starting channel at the CH area where data required for setting is stored.

Note When no send data is found, be sure to set #0000. Setting the other constant or
channel generates an error (ER flag 25505 is ON), and the PMCR instruction is
not executed.

Send data of how many words are valid at S and the following is stored in S.

Actually send data is stored in S+1 and the following.

No. of send data
words

Send data

.

.

.

S

S + 1

How many channels are valid (including S)

D: Receive data storage starting address number

Set the starting address at the CH area where receive data is stored.

Note When no receive data is found, be sure to set a dummy channel. Setting a
constant (#0000 to FFFF) generates an error (ER flag 25503 is ON), and the
PMCR instruction is not executed.

Data is not written in the dummy channel. It can be used for the others.

Receive data is not stored in D and the following.
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The number of effective addresses is stored in D1--, D+ 1 and the following,.

No. of effective words

Receive data

.

.

.

D

D + 1

How many words are valid (including D)

• Flag

Value ON OFF

ER(25503) • When *DM (Indirect) is specified, the DM content is
neither 6656 or higher nor BCD,

• For D, the DM content is neither 6144 nor higher or
BCD,

• When the instruction is executed or already in exe-
cution

• When neither 1 nor 2 is specified for the port

Other than the cases in the left

• Data contents

Model C200HX/HG/HE

Operand C S D

Relay area 1 000-255 000-2555 000-252

Relay area 2 256-511 256-511 256-511

Hold relay HR00-99 HR00-99 HR00-99

Auxiliary relay AR00-27 AR00-27 AR00-27

Link relay LR00-63 LR00-63 LR00-63

Timer/counter T/C000-511 T/C000-511 T/C000-511

Temporary relay --- --- ---

Data memory D0000-6655 D0000-6655 D0000-6143

Indirect data
memory

*D0000-6655 *D0000-6655 *D0000-6655

Constant See the above. #0000-FFFF ---

Contents of send/receive data word assignment to read the process value in se-
quence No.101of the standard system protocol “E5ZE Temperature Controller
Read” (from the Communications Board Operation Manual)

Read the process value and store the result in the specified address.

• Send data word assignment (Second operand of PMCR instruction)

No. of send data words

(Indeterminate) Unit No.

+0

+1

Send data
starting address

Offset Contents(Data format) Data

+0 No. of send data
channels( BCD 4-digit)

0002 (fixed)

+1 Unit No. (HEX 2-digit) 00 to 0F
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• Receive data word assignment (Third operand of PMCR instruction)

No. of send data words

Measuring temperature (lower 4-digit)

Measuring temperature (higher 1-digit)

Measuring temperature (lower 4-digit)

Measuring temperature (higher 1-digit)

+0

+1

+2

+3

+4

Measuring temperature (lower 4-digit)

Measuring temperature (higher 1-digit)
+15

+16

~ .
.

~

Channel 0

Channel 1

Channel 7

Receive data
storage address

Offset Contents(Data format) Data

+0 No. of receive data words (BCD
4-digit)

0017

+1 CH0 Measuring temperature
(lower 4-digit) (BCD 4-digit)

Differs depending on the
temperature measuring type.
Refer to the Model E5ZE Manual+2 CH0 Measuring temperature

(higher 1-digit) (BCD 1-digit)

temperature measuring type.
Refer to the Model E5ZE Manual

F denotes - (minus).

to to to

+15 CH7 Measuring temperature
(lower 4-digit) (BCD 4-digit)

Differs depending on the
temperature measuring type.
Refer to the Model E5ZE

+16 CH7 Measuring temperature
(higher 1-digit) (BCD 1-digit)

Refer to the Model E5ZE
Manual.
F denotes -.

[Send Data setting]
[Receive Data Storage Location]

DM0100
DM0101
DM0102 Data of temperature input chan-

nel 0 (measured temperature)

Data of temperature input chan-
nel 7 (measured temperature)

“17” means that 17 words of
DM0100 to DM116 are used as
the receiving area.

”2” means that two words of DM0000 to
DM0001 are used as the transmission area.

For this sequence, set the unit numbers here.
The protocol communicates with E5ZE with unit
number 00 because the lower 2 digits are “00”.

DM0115
DM0116

#0017
lower 4-digit

lower 4-digit

higher 1-digit

higher 1-digit

Set here the address for storing the data to
be transmitted to the PSB.

Set here the address for storing the data to
be returned from the PSB.
this example sets DM0100 so that the data
that were measured are stored on and after
DM0100.

Set 101 on the lower 3 digits of this word
because the sequence number of the
measured value reading is 101.

Note The following shows the cautions in using the PMCR instruction.

• Transmitting no data to the PSB

Settings of the PMCR
Instruction
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• Storing no data to the relay area on the PLC

• Related Special Auxiliary Relay
The PSB status (execution status of sequence/step) is allocated on the follow-
ing special auxiliary relay of the PLC. Use them in the ladder programs.

• Special Auxiliary Relay (PSB Allocation Area)

Word Bit(s) Function Read: R/
Write: W

FlagWord Bit(s) Function Read: R/
Write: W System User

268CH PSB error
area of detailed

00 Watchdog timer error for the PSB R f ---268CH PSB error
area of detailed
information for the

01 Port recognition error (hardware error) R
f ---

information for the
system
continuation error

02 Protocol data error (protocol data checksum error
due to memory corruption)

R
continuation error
FAL9C occurrence 03 to 10 Reserved for future expansion RFAL9C occurrence

11 Port B protocol macro error (error relating to PMCR
instruction execution)

R

12 Port A protocol macro error (error relating to PMCR
instruction execution)

R

13 to 15 15: “System setting error occurrence” 14: Above
error for port A 13: Above error for port B

R

283CH 00 to 03 Port A error codes 0: No error
1: Parity error 2: Framing error
3: Overrun error 4: FCS error
5: Time-out error 6: Checksum error
7: Command error

R

04 ON for communication error at Port A R
07 Port A Sequence Abort Termination Flag (see note 1) R
08 to 11 Port B error codes 0: No error

1: Parity error 2: Framing error
3: Overrun error 4: FCS error
5: Time-out error 6: Checksum error
7: Command error

R

12 ON for communication error at Port B R
15 Port B Sequence Abort Termination Flag (see note 1) R

284CH 00 to 07 Port A Current Repeat Count (01-FF) (see note 1) R
285CH 00 to 07 Port B Current Repeat Count (01-FF) (see note 1) R
286CH 00 Port A Trace In-progress Flag (see note 2) R286CH

01 Port B Trace In-progress Flag (see note 2) R
08 to 11 Port A Protocol macro error codes

: No error 1: No protocol macro function
2: Sequence number error
3: Receive data write same area exceeded
4: Protocol data error

R

12 to 15 Port B Protocol macro error code
: No error 1: No protocol macro function
2: Sequence number error
3: Receive data write same area exceeded
4: Protocol data error

R
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Word Bit(s) Function Read: R/
Write: W

FlagWord Bit(s) Function Read: R/
Write: W System User

287CH 00 to 03 Port A execution completion receive case No. (0 to
F)

R f ---

04 to 07 Port A execution completion step No. (0 to F) R
15 Port A Execution Completion Storage Flag

0: No 287CH storage
1: 287CH storage present

R

288CH 00 to 03 Port B execution completion matrix case No. (0 to F) R288CH

04 to 07 Port B execution completion step No. (0 to F) R
15 Port B Execution Completion Storage Flag

0: No 288CH storage
1: 288CH storage present

R

289CH 00 Port A Restart Flag W --- f289CH

01 Port B Restart Flag W

--- f

02 Port A Continuous Trace Start/Stop Flag (see note 2) W --- f

03 Port B Continuous Trace Start/Stop Flag (see note 2) W

--- f

04 Port A Shot Trace Start/Stop Flag (see note 2) W
05 Port B Shot Trace Start/Stop Flag (see note 2) W
08 Port A Instruction Execution Flag R f ---

09 Port A Step Error Processing Execution Flag R
f ---

10 Port A Sequence End Termination Flag R
11 Port A Forced Abort Flag W --- f

12 Port B Execution Instruction Flag R f ---

13 Port B Step Error Processing Execution Flag R
f ---

14 Port B Sequence End Termination Flag (see note 1) R
15 Port B Forced Abort Flag W --- f

Note 1. It is valid only when the Communications Board is the model C200HW-
COM**-EV1.

2. The exclusive flags used only in the Protocol Support Tool.

Note The instruction execution error caused by the PMCR instruction operand setting
failure is reflected on the ER flag (25503).

• Flag/Switch Description

Flag/Switch
Name

Content Word Flag TypeFlag/Switch
Name

Content

Port A Port B System User

Instruction
Execution Flag

Becomes 1 (turned ON) when
the PMCR instruction is
executed. Remains unchanged
to be 0 (OFF) when the
execution failed. Becomes 0
(OFF) when the sequence is
terminated (by the End or Abort
termination).

1: PMCR instruction
executing
0: No PMCR instruction
executing

28908 28912 f ---

Step Error
Processing
Execution Flag

Becomes 1 (turned ON) when
the step ends by error.
Becomes 0 (OFF) when the
step ends in normal.

1: Step error termination
0: No step error
termination

28909 28913 --- f
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Flag/Switch
Name

Flag TypeWordContentFlag/Switch
Name UserSystemPort BPort A

Content

Sequence End
Termination Flag

Becomes 1 (ON) when the
sequence is terminated by the
End of the next process or the
error process. However, it is
invalid when the instruction
executing flag is 1 but it is valid
when that flag is 0. Note: The
normal termination of sequence
execution is identified with this
flag by setting the End (Abort
for the termination with error) for
the sequence End termination.

1: Sequence End
termination (changes from
OFF to ON when the
instruction execution flag
changes from ON to OFF)
0: Not the sequence End
termination

28910 28914 f ---

Sequence Abort
Termination Flag

Becomes 1 (ON) when the
sequence is terminated by the
Abort of the next process or the
error process. However, it is
invalid when the instruction
executing flag is 1 but it is valid
when that flag is 0.

1: Sequence Abort
termination (changes from
OFF to ON when the
instruction execution flag
changes from ON to OFF)
0: Not the sequence Abort
termination

28307 28315 f ---

Forced Abort
Flag

Use to Abort the step execution
to be forced to stop in the
executing sequence by the user
program.

Changes from 0 to 1 at
the forced Abort execution

28911 28915 --- f

Restart Flag Use to initialize the
communication buffer and the
special auxiliary relay 283CH to
285CH by the user program or
the Programming Devices.
If the Restart Flag is changed
from 0 to 1 during the sequence
execution, the restart process
will be executed after the
sequence execution or abortion.

Changes from 0 to 1 when
the communication port is
initialized (automatically
becomes 0 after the
initialization completion).

28900 28901 --- f

Execution
Completion Step
No.

The execution-completed step
No. is stored. The bit 15 is
turned ON when the No. is
stored.

0 to FHex 287CH
04 to 07

288CH
04 to
07

f ---

Execution
Completion
Receive Case
No.

The receive case No. selected
in accordance with the receive
message is stored when the
receive matrix is set. The bit 15
is turned ON when the No. is
stored.

0 to FHex 287CH
00 to 03

288CH
00 to
03

f ---

Execution
Completion
(step No. or the
receive case
No.) Storage
Flag

Becomes 1 (ON) when the
execution completion step No.
or the execution completion
receive case No. is stored. The
read is performed as this flag is
the input condition.

1: Stored
0: Not stored

28715 28815 f ---

Current Repeat
Count

The step repeat count N value
is reflected

01 to FFHex 284CH
00 to 07

285CH
00 to
07

f ---

Note See the section 4-5 for the error related flags.

3-9-4 Operation
The following describes the system’s operation when executing the ladder pro-
gram shown in 3-9-3 Creating Ladder Programs.

1, 2, 3... 1. When starting to execute a PMCR instruction, the system transmits the in-
formation set in the operand of the PMCR instruction such as the starting
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sequence number and communication data store area, and sets the port A
instruction execution flag (28908) ON.

2. The PSB reads the communication sequence with the appropriate se-
quence number set in the PMCR instruction.

3. The system sends “RX0 Word No. 00” (the command measuring the tem-
perature of the temperature control device’s specified word) to the unit num-
ber (00) of the temperature control device (E5ZE) stored in DM0001.

4. The system receives “RX00” (the response from the temperature control de-
vice, 00 means the end code.) from the device (E5ZE) with unit number 00 to
store the succeeding measured temperature into DM0101 and DM0102
through the PLC scan.

5. The system increases the value of the repeat counter by 1 8 times repeated-
ly. Every time the repeat counter is increased, the following contents are
changed.

• The word number of the temperature control device specified by $(N,1) in
the send message changes between 0 and 7.

• The DM area storing the measured temperature specified by &(W(2N+1,*)
in the receive message changes as follows:

→DM0101→DM0103→DM0105→DM0107→DM0109→DM0111
→DM0113→DM0115

6. When the system ends the execution of the sequence, the port A instruction
execution flag (28908) is set OFF.

3-9-5 Confirming the Operation

When the process variable is not stored successfully, confirm the following
points.

• System error FAL01 or FAL9C.

• Confirm that the PLC’s system setup is set correctly.

• Confirm the setups of the PMCR instruction’s parameter and data.

• Flag 28909 (port A step error processing flag) is ON.

• Confirm that the PLC’s system setup is correct. (Especially confirm wheth-
er port A and port B are not specified conversely)

• Confirm that the line distribution (See Communication Board User’s
Manual to connect the line is correct).

• Confirm the communication rate, flame, and unit number of the 5ZE.

• No error, but data are not stored.

• Confirm that the RUN LED of E5ZE is lit. (For details, refer to the E5ZE
Operation Manual.)

• Other errors
When some error occurs during the operation of the PSB, the system shows
this error using the LEDs on the PLC’s CPU unit or the error code on the pro-
grammable console, as well as stores the type or the location of the error into
the relay area related to the PSB. When an error occurs, see the following to
troubleshoot properly.



95

SECTION 4
Using the Protocol Macro Function

4-1 Applicable Range of the Protocol Macro Function 96. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-2 Protocol Creation Process 97. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-3 Transmission Control Mode Setup 100. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-4 Ladder Programming Method 102. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

4-4-1 Ladder Programming Method 102. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-5 Calculation Method of Monitoring Time 108. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-6 Operation Confirmation 110. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-7 Errors at the Protocol Execution 113. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-8 Performance (Communication Response Time) 114. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



4-1SectionApplicable Range of the Protocol Macro Function

96

4-1 Applicable Range of the Protocol Macro Function
Using the Protocol Support Tool allows users to create several communications
sequence (or protocol) compatible with communications control modes dis-
cussed in this chapter.
However, they are not compatible with communications control modes such as
the full duplex, the synchronous communication, frame synchronous mode
(HDLC: High level Data Link Communication), etc.

Transmission mode Half duplex and single direction

Synchronizing mode Start-step synchronization mode

Transmission control mode Contention mode (Point to point
connection)
Polling selecting mode (Point to
multi-point connection)
Modem control mode

Flow control mode Software flow: Xon/Xoff flow control
Hardware flow: RS/CS flow control
Delimiter control

Transmission error control mode LRC, CRC-CCITT, CRC-16*, SUM,
SUM2 (see note)

Message format Header+Address+Length+Data+Chec
k Code+Terminator, or
Header+Address+Length+Data+Termina
tor+Check Code (see note)

Note It is valid only when the Communications Board is the model C200HW-
COM**-EV1.

• The message length must be 256 bytes or less. For a message whose length is 257
bytes or more, the data exceeding 256 bytes cannot be sent nor received.

• Data operating process functions are the calculations of the Error Check Code and the
frame length to be sent and the numeral data conversion between ASCII code and HEX
data only. The other operation or conversion is handled by the ladder program, if neces-
sary.

• The signal line cannot be controlled optionally by any mode other than the modem con-
trol and the RS/CS flow control.

• Such process is infeasible that determines the number of receiving bytes by the use of
the beginning data of a received frame.

• The data in the buffer is cleared before the sequence execution and after the receive
command execution. Therefore, such process cannot be used that reads one byte by
one from the content of receive buffer.

• Maximum number of branched process according to received data (sent command
etc.) is 15. If more branches are necessary, the ladder has to manage it.
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4-2 Protocol Creation Process
• Create the status transition chart of communications sequence.

Before users create a protocol by using the Protocol Support Tool, it is recommended to
firstly draw such a status transition charts to illustrate the communications sequences
with thecommunicatingmachineas shownbelowforexample. Then,users canconvert
them to “sequences” and “steps” editable by the Protocol Support Tool.

PLC

Send A

Send C

⋅ Retry, if not B.
⋅ End, if B.

⋅ Retry after one
minute, if not D.

⋅ End, if E

External device PLC

Send the read
command for
process value.

Send the write
command for a
set value.

⋅ Retry, if not
response
format.

⋅ End, if
response
format.

⋅ Retry, if not
response
format.

⋅ End, if
response

format.

Temperature
controller

Example:

• Disassembling the protocol into “sequences” and “steps” to be editable by the Protocol
Support Tool.

• Disassemble into sequences
Take out a block from the above process as a “sequence” which shall be
started (or switched) by the ladder program.
For example, either “Read the process value of temperature controller” or
“Write the set value of temperature controller” becomes “sequence”.

• Disassemble into steps
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• Disassemble sequences into squares (steps) as shown below:

Send

Send A

Normal
end

Error

Next
process

Error
process

Send&Recv

Send A

Receive
B

Error

Next
process

Error
process

Y Y

Recv

Receive
B

Error

Next
process

Error
process

Y

Send&Recv (Receive matrix)

Send A

Receive matrix

Receive B Receive C Receive D Receive others Error

Next process Next process Next process Next process Error Process

Recv (Receive matrix)

Receive matrix

Receive B Receive C Receive D Receive Other Error

Next process Next process Next process Next process Error Process
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Example 1:

Send message

Send
&

Recv

Send data
Error

Receive
the
expected
message Abort

Next
Step No. 01

Step No. 00

Send escape
code

Send
&

Recv

Retry
three
times

Retry
count

Receive a
result code

Other
than 0,
or Error

Send
&

Recv

If 0

Abort

Abort

NextStep No. 02

Send disconnect
command

Retry
three
times

Retry
count

Receive a
result code

End
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Example 2:
Step No.00

Send dial
command

Send dial
command

Retry three times
Retry count

Retry three times
Retry count

Send&
Recv

Send&
Recv

(Receive
matrix)

Result code

(Receive
matrix)

Result code

Receive 7,9 Receive 1,234 Receive 4,6,8, or others Error

END Abort Abort

END Abort Abort

Goto 01

Step No. 01

Receive 1,234 Receive 4,6,7,8,9,or others Error

When configuring the steps, the enough consideration is necessary not only for
the normal course (the process is completed in normal) but for the error course
(the process is terminated by error). The error courses are often set to be
aborted (intermittent process stop) all together. However, if the abort is set as
the simple “others than normal course”, the process stops there.
Add the description to switch from the error course to the normal course by set-
ting Next and Goto as far as possible if the error cause is predicted and the pro-
cess can be continued by the other steps even if the errors occur.
Besides, if the error causes are identified, the debug becomes easy even when
the recovery is impossible by describing the steps. For example, for the device
such as modems which returns the specific result codes, the result codes can be
set in the receive matrix in order to confirm the sent result codes and to ease the
error cause identification.

4-3 Transmission Control Mode Setup
The Protocol Macro function supports such transmission control modes as the
flow control (Xon/Xoff flow control by software and RTS/CTS flow control by
hardware), the delimiter control, the contention control, and the modem control.
Pleas note that the system cannot freely control the signal line by the other
mode.
Examples of their general use are as follows:

• The external device is compatible with the RTS/CTS flow control.
Select the RTS/CTS flow control.

• The external device is compatible with the Xon/Xoff flow control.
Select the Xon/Xoff flow control.
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• The connection in one-to-n configuration is used for the external device.
Select the modem control.

• The external device is a modem.
Select the modem control.

• The external device is a modem compatible with the RTS/CTS flow control
(or the Xon/Xoff flow control).
Select both the modem control and the RTS/CTS flow control (or the Xon/
Xoff flow control).

• The external device compatible with the RTS/CTS flow control (or the Xon/
Xoff flow control) is connected in 1:N configuration.

Note

The RS/CS flow control sets the CTS signal from receiving terminal to “OFF” to
stop the data sending temporally when the receiving speed exceeds the proces-
sing in a no-procedural communication. When the receiving process finished, it
sets the CTS signal to “ON” again to resume the sending.
This control is a kind of hardware flow controls. The signal line of RS-232C cable
is used.

The Xon/Xoff flow control sends the Xoff (13H) signal from receiving terminal
to stop data sending temporally when the receiving speed exceeds the proces-
sing in a no-procedural communication. When the receiving process becomes
available, it sends the Xon (11H) signal to start the data sending again. This is a
kind of software flow controls. (However, the Xon and the Xoff signals are control
codes, therefore they might be included in the sending data when they are
binary. On the contrary, the Xon and the Xoff signals might be mixed in the data.
Thus, this control is not used for a binary data communication).
The modem control is a specific function to the Protocol Macro function.
It sets ER(DTR) signal to “ON” from the start of Protocol Macro execution
through the end.
It sets RS(RTS) signal to “ON” during the data sending.
The contention control is a data transmission mode which establishes a data
link from the data sending terminal before the communication. Since mutually
communicating terminals are in the equal relations, either terminal can establish
the link to send data anytime.
The delimiter control sends a delimiter, which has been set by the send code,
at the end of the send data if no terminator is defined for the send message. At
the next step, it does not send until it receives a delimiter, which has been set by
the receive code, from the communicating terminal.

If a terminal received a delimiter set by the receive code, it sends a delimiter set
by the send code and continues the data receiving.
When the received data exceeds 200 bytes in the RS/CS flow control, the
Xon/Xoff flow control, or the delimiter control mode.

The received data is 200 bytes maximum a step in the RS/CS flow control, the
Xon/Xoff flow control, or the delimiter control. If data more than 200 bytes are
expected to receive, it is necessary to design the sequence to receive them by
plural steps.
Example: When receiving 300 bytes

Step No. Command Send
message

Receive
message

Next process

00 Send&Recv A command 200 bytes Next

01 Recv --- 100 bytes End

Note on the selection of the contention control mode
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When the contention control mode is set, the send request code is automatically
sent at the beginning of the sequence, the successive process has to be set in
the sequence.

When the communicating partner does not have a priority. (Execute the
communication process after the receipt of partner’s receive permission
code)

Step No. Command Send message Receive
message

Next process Error process

00 Recv --- Receive
permission code

Next Goto00

01 Send&Recv Data Data End Abort

When the communicating partner has a priority.

(Send the receive permission code if the received data is not the partner’s re-
ceive permission code)

Step No. Command Send message Receive
message

Next process Error process

00 Recv --- Receive
permission code

Next Goto02

01 Send&Recv Data Data End Abort

02 Send&Recv Receive
permission code

Data Next Abort

03 Send Data --- End Abort

4-4 Ladder Programming Method

4-4-1 Ladder Programming Method
• The instruction execution flag shall be the Normally closed input condition in order to

avoid the PMCR instruction execution during the PMCR instruction execution.

• Perform the sequence execution result read process and the sequence error termina-
tion process under the condition that the instruction execution flag is cleared.

Example:

PMCR

DIFD (14) A

Instruction execution flag

Input condition 28908

28908

A

Sequence error termination process

Sequence execution result reading process
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Example: The execution of the protocol name Temperature Controller (Model
E5jK Read System) sequence No. 000 (read process value)

Protocol Support Board

Send data

Receive data

Maximum 32 units

The temperature controller unit No. is specified,
the send data of the process value read com-
mand is sent, and the process value in the re-
sponse is received in the specified word.

RS--422A/485

Temperature controller
Model E5jK
Unit No. 00

Temperature controller
Model E5jK
Unit No. 01

Temperature controller
Model E5jK
Unit No. 31

• The Send/Receive Word Allocation Contents of the Sequence No. 000
(read process value)

Read Process Value (Sequence No. 000)
Read the process value and stores the results in the specified words.
Send data word allocation (2nd operand of PMCR)

Number of send data words

(Undefined) Unit No.

+0

+1

First word of
send data

Offset Contents(data format) Data

+0 Number of send data
words (4 digits BCD)

0002 (fixed)

+1 Unit No. (2 digits BCD) 00 to 31

Receive data word allocation (3rd operand of PMCR)

Number of send data words
+0

+1

Receive data
storage words Process value

Offset Contents(data format) Data

+0 Number of send data
words (4 digits BCD)

0002

+1 Process value (4 digits
BCD)
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• PMCR Instruction Operand Setting Contents
In case the unit No. 03 E5jK process value is read, received and stored in the DM201:

C: Control data

1: Port A

S: The first word number of the send data
S: DM0100

15 0

D: The first word number of the receive data storage

D: DM0200

PMCR

#1000

DM0100

DM0200

C

S

D

C

15 12 11 8 7 4 3 0
0001

00 03
00S: DM0100

S+1: DM0101
Number of send data words = 2
Unit No. = 03

15 0
D: DM0100

D+1: DM0201

Process value

Number of send data words = 2
Process value is stored (BCD 4-digit)

000: Sequence No.

03

0 0 0 2

• Example of the Ladder Program Creation
The following example shows that the protocol name Temperature Controller (Model
E5jK Read System) sequence No. 000 (current value) is executed by the PMCR
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instruction and the read process value is transferred to the other word at the normal
completion of the sequence:

1Instruction
execution flag
28908 0

1

00100
0

Sequence normal
termination: Step error
process execution flag 28909

The process value in
DM0201 is transferred to
DM0300.

Sequence error
termination: Step error
process execution flag 28909 1

FAL instruction is executed.

PMCR

#1000

DM0100

DM0200

2890800000
Input condition Instruction flag

DIFD (14) 00100

28908
Instruction flag

Input condition

MOV (21)

DM0201

DM0300

28908 28909
Step error process execution flag

FAL (06) 00

28909
Step error process execution flag

When the input condition 00000 is ON and the instruc-
tion execution flag 28908 is OFF, the sequence No.
000 is executed and the process value is stored in
DM0201.

The instruction execution flag 28908 is cleared from
ON to OFF, 00100 changes from OFF to ON (re-
mains unchanged to be ON during 1 cycle).

MOV (21) If the instruction execution flag is OFF and
the step error process execution flag 28909 is OFF
when 00100 is ON the current received process val-
ue in DM0201 is transferred to DM0300.

If the step error process execution flag 28909 is ON
when 00100 is ON (sequence termination), the FAL
instruction (Failure Alarm instruction) is executed as
the sequence error termination.

1 cycle

Sequence
execution

Sequence
termination

Sequence
restart

1

0

1

0

For the reference:
Sequence Error Termination Process
If the End is set for the normal sequence termination and the Abort is set for the
error termination as follows, either the normal sequence termination or the error
termination can be identified by the sequence End termination flag and the se-
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quence Abort termination flag.
Example 2

Sequence

Step No. 00

Error

Sequence error
termination

Abort

End

Abort

Error

Sequence error
termination

Step No. 01

Step No. 00

Step No. 01

End End

Abort

Error

Sequence error
termination

Step No. 02

Sequence normal
termination

Sequence normal
termination

Sequence
Example 1 Example 2

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

Sequence normal termination Sequence normal termination

Instruction
execution flag
28908

Sequence
execution

Sequence
termination

Sequence
restart

Sequence End
termination flag
28910

Error process at
the step No. 00

Step error process
execution flag
28909

Sequence error termination

Instruction
execution flag
28908

Sequence Abort
termination flag

Step error process
execution flag
28909

Sequence
execution

Sequence
termination

Sequence
restart

Sequence
execution

Sequence
termination

Sequence
restart

Sequence
execution

Sequence
termination

Sequence
restart

Error process at
the step No. 00

Instruction
execution flag
28908

Sequence End
termination flag
28910

Step error process
execution flag
28909

Sequence error termination

Instruction
execution flag
28908

Sequence Abort
termination flag

Step error process
execution flag
28909

Note The step error process flag is not a flag for all the sequence, but a flag to see
whether the error process is executed at a step in the sequence. Therefore, as
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the above example 2, if the consecutive step terminates in normal after the error
process execution during the sequence (step No. 00), the flag remains un-
changed to be 1 (ON). Thus it shall be reminded that this flag is not always useful
as the error termination flag for all the system.

Note Use the forced abort flag by keeping the following points in mind:
The instruction execution flag changes from ON to OFF when the user program
changes the forced abort flag from OFF to ON. Therefore, the abort process is
not executed if the forced abort flag in turned OFF when the instruction execu-
tion flag becomes OFF. Set the forced abort flag to OFF after the minimum [CPU
unit cycle time + 15 ms] of the ON held. When the instruction execution flag B-bit
is the PMCR instruction execution condition, the PMCR instruction is executed
during the forced abort process and causes the FAL9C error. Therefore, execute
the PMCR instruction after the period of minimum [CPU unit cycle time + 15 ms]
after the forced abort flag is changed from OFF to ON when using the forced
abort flag.

Example: The forced abort flag is turned ON and the 30 ms period is elapsed, then the
forced abort flag is turned OFF and simultaneously the PMCR instruction inter-
lock is released.

PMCR

00000
flag

Forced abort
Input condition

28908
execution flag

Instruction

28911

TIMH

000

#0003

The condition
to allow the abort T000

A

A

T000

Forced abort flag

A

28911

The condition to
allow the abort

A

T000

Forced Abort Flag
28911

Instruction
Execution Flag
28908

30 ms 1 cycle
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4-5 Calculation Method of Monitoring Time
The calculation method of monitoring time for the operand addressing (without
response writing) is shown here. Referring to this calculation method, calculate
the monitor times for the operand addressing (with response writing), link word
addressing, and direct addressing. When actually setting the monitor times as
sequence data, be sure to provide sufficient allowance.

PMCR #1234
D0000
D1000

D0000

D1000

CPU unit External device

Send data
conversion

process

PMCR
instruction
process

External
device

process

Received
data writ-
ing

Received
data

conversion
process

2 3

7 6 5 4

1

Protocol Support
Board

Number Function Time Required Description

1 The PMCR instruction’s process
time

About 40-70µ second A time from the start of PMCR
instruction to the end of the
send data transfer

2 The send data conversion
process time

Depends on number of
conversion bytes

A time from the end of the send
data conversion based on the
specified conversion method to
the start of the send data to the
external device.

3 The send data transmission
time

Number of data characters x
one character bit/ transmission
rate

A time required to the send data
transmission to the external
device. When designing, use
double the calculated time
because an idle time exists
between the send characters.

4 The external device process
time

Depends on the external
devices’ process

A time required by the external
device to process according to
the command from the PLC until
the start of the send response
data.

6 The received data transmission
time

Number of data characters x
one character bit/ transmission
rate

A time required to transmit the
received data from the external
device. When designing, use
two to five times the calculated
time because an idle time exists
between the receive characters.
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Number DescriptionTime RequiredFunction

6 The received data conversion
process time

Depends on number of
conversion bytes

A time required for the
conversion of the received data
from the external device based
on the specified conversion
method

7 Received data writing time A time of one cycle time minute
maximum

A time required to finish the
received data transfer to the I/O
memory.

Note Although the data conversion process times of 2 and 6 vary according to the PLC
operation status, the maximum values can roughly be estimated by the following
calculation formula:
2 The send data conversion process time = 10000µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15 µ second, ASCII conversion:
40µ second, HEX conversion: 55µ second)
6 The receive data conversion process time = 100µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15µ second, ASCII conversion: 30µ
second, HEX conversion: 15µ second)

• Example of the Send Wait Time Calculation

The send wait time (Ts) is a waiting time from the execution of the send com-
mand to the sending of the beginning one-byte (the start character). Therefore, it
is equal to a total of 1 +2 in the above table and it can be set in the range where
the following equation is satisfied:

The send wait time >1+2

Ts is waiting time before starting sending. Therefore users have to consider the
time period before communication line and related devices become available
when continuous data are sent by plural steps. For example, when users send a
telephone number from an intercom via modem, they firstly send number 0 (to
connect with public line), then put the send wait to be set for a short period (1
second) before sending the telephone number.

• Example of Calculation of the Send Finish Monitoring Time, (Tfs)

The send finish monitoring time, Tfs >
Number of data characters one-character bit x 2/ transmission rate

Example: @ + 5 + HEX data of 5 words + CRC-CCITT (BIN) 2 bytes + CR = 15 characters
(120 bits)

1 + 1 + 10 + 2 + 1 = 15

One character equals 12 bits under the following condition:

Start bit: 1 bit; Data: 8 bits; Parity: Yes; Stop Bit: 2 bits

Therefore, 15 x 2 = 180 bits

180/9600 = 0.01875 seconds

In practice, however, it must be set to a value double the calculated time be-
cause an idle time exists between characters sent from the PSB as shown
below:

0.01875 x 2 = 0.0375 seconds

Because the unit of the monitoring time is in the range of from 0.01 seconds (10
ms) to 99 minutes, users can set the Tfs 0.02 seconds after which the system
executes the error process or the retry process.



4-6SectionOperation Confirmation

110

• Example to Set Up the Receive Wait Monitoring Time (Tr)

The receive wait monitoring time (Tr) sets the monitoring time from the system’s
recognition of the received command in the applicable step and to the receiving
of the beginning one-byte (the start character). In the above table, it refers to a
total of 4+5 for the beginning character and it can be set in the range where the
following equation is satisfied:

The receive wait monitor time, Tr > 4+5 for the beginning character

When this time is up, the system executes the error process or the retry process.

• The Receive Finish Monitoring Time (Tfr)

The receive finish monitoring time (Tfr), monitors the receiving time from the re-
ceipt of the beginning one-byte (the start character) to the receipt of the last one-
byte data (the end character). In the above table, it refers to 5. As in the case of
the send finish monitor time, an idle time exists between receive characters and
depending on devices to be connected, the time varies. Therefore, it is recom-
mended that the time be set to two to five times of the calculated time. It can be
set in the following range:

The receive finish monitor time, Tfr > 5 x (2 to 5)

When this time is expired, the system executes the error process or the retry pro-
cess.

4-6 Operation Confirmation
To confirm the operation of created ladder program, there are “The Trace Func-
tion of the Transmission Line” and “The Area Monitoring Function of the PLC
Channel” in the Protocol Support Tool.

• Tracing the Transmission Line
Users trace the transmission data and the control signals flowing on the transmission
line (RS232C or RS422/485). By this function, users can confirm the data and signals
flowing on the transmission line, even if they do not have the protocol analyzer.

PC

Send message
@ 0 2 R
40 30 32 52

@ 0 0
40 30 30

0 0 0 0 0 0 0

Receive message

Step No.
RTS

CTS

Personal Computer

External general-purpose device

Tracing the send/receive message or control
message that runs through the transmission line.

• The I/O memory Monitor of the PC
This is a function to monitor or to change the I/O memory areas on the PC. By this func-
tion, users can confirm the contents of sent and stored data in the PLC’s relay area, the
contents of received data, and the status on various flags. It also enables a trial run
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where users can change the values of communication data and execute again the lad-
der program.

PLC

Personal Computer

External general-purpose device

Displays I/O memory
area of the PLC

CIO LR HR AR DM
210Address ---

0003
0004
0000

0000
0010
0020

0000 0002
0000
000003B6

B3B4

When an error occurs in the ladder program execution, users can search the er-
ror cause by checking the various flags as follows:

• System Error FAL9C (The ALM/ERR lamp on the CPU unit blinks on and off)
When the system error FAL9C occurs, the ALM/ERR lamp on the CPU unit blinks on
and off. In this case, see the following table and take a necessary action:

Word Bit(s) Function name Actions Read/
Write

268CH 00 Watchdog timer error for the PSB
(hardware error, software error
(runaway))

The PSB becomes unable to
operate. Change the
communication

---

01 Port recognition error (hardware
error)

board and supply the power again. R

02 Protocol data error (protocol data
checksum error due to memory
corruption)

ON for 25503 (ER) as well. Transfer
the protocol again. After the
recovery, the reset abnormality
enables the continuous operation.

R

11 Port B protocol macro error (error
relating PMCR)

PMCR instruction is not executable.
Detailed error

R

12 Port A protocol macro error (error
relating PMCR)

codes are indicated in the flag as
follows:

Port A: 28612-15
Port B: 28608-11

R

13 System setting error for port B Review the system setup and
restart the relating port.

R
14 System setting error for port A

Review the system setup and
restart the relating port. R

15 System setting error See the actions for bit 13 and 14 R

• Other Errors

If an error other than system FAL9C occurs, users can search the error cause by
checking each flag in the table below. Search the error cause and take neces-
sary actions.

Note The step number, the receive matrix case number, and the repeat count which
have just finished before the error occurrence are indicated by the following
flags:

Step number Port A: 28704-07, Port B: 28804-07 0-F

Receive matrix number Port A: 28700-03, Port B: 28800-03 0-F

Repeat counter Port A: 28400-07, Port B: 28500-07 01-FF
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Words Bit(s) Function name Read/
Write

283CH 00-03 Port A error codes
0: No error 1: Parity error 2: Framing error
3: Overrun error 4: FCS error 5: Timeout error
6: Checksum error 7: Command error

R

04 ON for communication error R
07 Port A Sequence Abort Termination Flag (see note 1) R
08-11 Port B error codes

0: No error 1: Parity error 2: Framing error
3: Overrun error 4: FCS error 5: Time-out error
6: Checksum error 7: Command error

R

12 ON for communication error R
15 Port B Sequence Abort Termination Flag R

284CH 00-07 Port A Current Repeat Count (01 to FF) (see note 1) R

285CH 00-07 Port B Current Repeat Count (01 to FF) (see note 1) R

286CH 00 Port A Trace In-progress Flag (see note 2) R286CH

01 Port B Trace In-progress Flag (see note 2) R
08-11 Port A Protocol macro error code

0: No error 1: No protocol macro function
2: Sequence number error
3: Receive data write area exceeded 4: Protocol data error

R

12-15 Port B Protocol macro error code
0: No error 1: No protocol macro function
2: Sequence number error
3: Receive data write area exceeded 4: Protocol data error

R

287CH 00-03 Port A execution completion matrix case No. (0 to F) R287CH

04-07 Port A execution completion step No. (0 to F) R
15 Port A 288CH storage enable

0: Disable; 1: Enable
R

288CH 00-03 Port B execution completion matrix case No. (0 to F) R288CH

04-07 Port B execution completion step No. (0 to F) R
15 Port B 287CH storage enable

0: Disable; 1: Enable
R

289CH 00 Port A Restart Flag W289CH

01 Port B Restart Flag W
02 Port A Continuous Trace Start/Stop Flag (see note 2) W
03 Port B Continuous Trace Start/Stop Flag (see note 2) W
04 Port A Short Trace Start/Stop Flag (see note 2) W
05 Port B Short Trace Start/Stop Flag (see note 2) W
08 Port A Instruction Execution Flag R
09 Port A Step Error Processing Execution Flag R
10 Port A Sequence End Termination Flag (see note 1) R
11 Port A Forced Abort Flag W
12 Port B Execution Instruction Flag R
13 Port B Step Error Processing Execution Flag R
14 Port B Sequence Termination End Flag (see note 1) R
15 Port B Forced Abort Flag W

Note 1. It is valid only when the Communications Board is the model C200HW-
COM∗∗-EV1.

2. The exclusive flags used in the Protocol Support Tool only. They can not be
used in the ladder program, etc.
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4-7 Errors at the Protocol Execution

When an error listed below occurs, take an appropriate action, referring to the
following table:

Problem Findings Cause Action

PSB does not
operate.

The “RDY” LED lights OFF. PSB is abnormal Replace the PSB and
reconnect the power.

System error
FAL9C
occurred.

26800 is ON PSB is abnormal. Replace the PSB and
reconnect the power.FAL9C

occurred. 26801 is ON and the “RDY” LED
lights OFF.

This error occurs when the RS232C
port is not recognized when the
power is turned ON by such as an
abnormal hardware.

Replace the PSB and
reconnect the power.

26802 is ON PSB protocol data are abnormal. Rewrite the protocol
data by using the
Protocol Support Tool.

System
errors FAL9C
and FAL9B
occurred

26815 is ON and the “RDY” LED
blinks.

• The PSB system setting (DM6550
to DM6559) has incorrect setting
values.
If 26813 is ON, the port B has a
problem.
If 26814 is ON, the port A has a
problem.

• The PSB does not support the pro-
tocol macro function.

• Check the PSB sys-
tem setting
contents of the prob-
lem port and restart
the system.

• Use the PSB which
supports the protocol
macro function.

System error
FAL9C
occurred
when the
PMCR
instruction is
executed.

26811 is ON (Port B) or 26812 is ON
(Port A).

The protocol macro error (PMCR
instruction relating error) occurred.
The details are registered as error
codes.

Take necessary
actions in accordance
with the error codes.

Instruction
execution
flag is not set
to ON. 28908
is Port A.
28912 is Port
B.

Error codes
28608 to 11 (Port A)
28612 to 15 (Port B)

Error code: 1 • The PSB system (DM6550 to
DM6559) is not set to the proto-
col macro mode.

• The PSB does not support the
protocol macro function.

• Check the PSB sys-
tem setting contents
of the problem port.

• Use the PSB which
supports the protocol
macro function.

Error code: 2 The sequence number is not
present.

Reset the first operand
of the PMCR
instruction. Otherwise,
transfer the sequence
No. to the PSB.

Error code: 3 The received data overflowed when
writing it in the I/O memory.

Specify the other area.
Otherwise, reduce the
receive data size.

Error code: 4 The PSB data error. Rewrite the protocol
data by using the
Protocol Support Tool.

The data
send/receive
is not well
executed
despite the
PMCR
instruction
execution.
The

28909 is ON (Port A) or 28913 is ON
(Port B).

The step is executing the error
process during the sequence
caused by an error such that the
receive message does not match
with the expected receive message.

Search the error cause
and add the
appropriate process.
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Problem ActionCauseFindingsexecution.
The
instruction
execution
flag is ON.
28908 is Port
A. 28912 is
Port B

28304 is ON (Port A) or 28312 is ON
(Port B).

The communication error occurred
during the message receive.

Confirm the
communication route
to the connected
devices.

The
communicati
on with the
connected
devices is
impossible.

28304 is ON (Port A) or 28312 is ON
(Port B).

This error occurs by the abnormal
communication route to the
connected devices or by the
communication condition setting
failure. The details are registered
as error codes.
28300 to 03 (Port A)
28608 to 11 (Port B)

• Restart the prob-
lem port or initial-
ize each relay by
executing the RXD
and PMCR instruc-
tions.

• Confirm the com-
munication route.

• Check the com-
munication condi-
tion setting.

The PMCR
instructions
are not
executed.

ER flag (25503) is ON. This error occurs by the instruction
operand setting failure.

Check the instruction
operand.

4-8 Performance (Communication Response Time)
The response performance of communication with the external devices using
PMCR instruction, which varies according to the definition of the Protocol Macro,
is divided in the following four modes:
• Use the event (operand addressing) areas

• Use the interrupt mode for the response method

• Use the link word area

• Use the direct addressing

The above four modes are different in the data transmission mode between the
CPU unit and the PSB. There are three kinds of data transfer modes from the
CPU unit to the PSB, while there are four kinds of those modes from the PSB to
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the CPU unit. The communication response time varies according to the com-
bination of those modes.

Use the event area

Use the event area

Use the interrupt mode

Use the link word area

Use the link word area

Use the direct addressing

Use the direct addressing

C
P

U
unit

P
rotocolS

upportB
oard

• Communication Response Time Using the Event (operand addressing) Area
Illustrated below is the data flow when the communication area addressed by the se-
cond and the third operand of the PMCR instruction is used:

PMCR #1234
D0000
D1000

D0000

D1000

CPU unit
Protocol Support

board External device

Send data
conversion

process

PMCR
instruction
process

External
device

process

Received
data

conversion
process

2 3

7 6 5 4

1

Received
data writing

The communication response time is total from 1 to 7 in the above figure.
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Number Function Time Required Description

1 PMCR instruction
process time

About 40 to 70µ second The time from the start of PMCR
instruction to the end of the data
transfer

2 Send data conversion
process time

Depends on the number
of conversion bytes

The time required for the send
data conversion based on the
specified conversion mode which
finishes at the start of data
sending to the external device.

3 Send data transmission
time

Number of data
characters x
one-character bit/
transmission rate

The time required for the send
data transmission to the external
device.
(Use double the calculated time
because an idle time exists
between send characters.)

4 External device process
time

Depends on the
external device process

The time required for the external
device process according to the
PLC’s command which finishes by
the start of the response data
sending.

5 Received data
transmission time

Number of data
characters x
one-character bit/
transmission rate

The time required for the received
data transmission from the
external device.
(Use two to five times the
calculated time because an idle
time exists between the receive
characters.)

6 Received data
conversion process
time

Depends on the number
of conversion bytes

The time required for the received
data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data transfer

7 Received data writing
process time

One-cycle time
maximum

The time required to finish
received data transfer to IOM.

Note Although the data conversion process times of 2 and 6 vary according to the PLC
operation status, the maximum values can roughly be estimated by the following
calculation formula:
2 The send data conversion process time = 10000µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time → No conversion: 15µ second, ASCII conversion:
40µ second, HEX conversion:
55µ second)

6 The receive data conversion process time = 100µ second + one-byte conver-
sion time x number of conversion bytes (one-byte conversion time→No conver-
sion: 15µ second, ASCII conversion: 30µ second, HEX conversion:
15µ second)
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• Communication Response Performance Using the Interrupt Notification Mode
Illustrated below is the data flow when the event area (operand addressing) is used and
the response method is the interrupt mode:

PMCR #1345
D0000
D1000

PMCR
instruction
process

Board
interrupt
process

Send data
conversion

process

Received
data conversion

process

External
device

process

D0000

D1000

CPU unit Protocol Support Board External devices

2 3

7 6 5 4

1

The communication response time is total time from 1 to 7 in the above figure.
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Number Function Time Required Description

1 PMCR instruction
process time

About 40 to 70 micron
second

The time from the start of PMCR
instruction to the end of the data
transfer.

2 Send data conversion
process time

Depends on the number
of conversion bytes

The time required for the
DP-RAM’s send data conversion
based on the specified conversion
mode which finishes at the start of
data sending to the external
device.

3 Send data transmission
time

Number of data
characters x
one-character bit/
transmission rate

The time required for the send
data transmission to the external
device.
(Use double the calculated time
because an idle time exists
between send characters.)

4 External device process
time

Depends on the
external device process

The time required for the external
device process according to the
PLC’s command which finishes by
the start of the response data
sending.

5 Received data
transmission time

Number of data
characters x
one-character bit/
transmission rate

The time required for the received
data transmission from the
external device.
(Use two to five times the
calculated time because an idle
time exists between the receive
characters.)

6 Received data
conversion process
time

Depends on the number
of conversion bytes

The time required for the received
data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data transfer.

7 PSB interrupt process
time

About 50 micron second The time started by the response
interrupt notification and ended by
the end of the received data
transfer to IOM.

Note Although the data conversion process times of 2 and 6 vary according to the PLC
operation status, the maximum values can roughly be estimated by the following
calculation formula:
2 The send data conversion process time = 10000µ second + one-byte conver-
sion time x number of conversion bytes
(One-byte conversion time→No conversion: 15µ second, ASCII conversion:
40µ second, HEX conversion:
55µ second)
6 The received data conversion process time = 100µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15µ second, ASCII conversion: 30µ
second, HEX conversion: 15µ second)



4-8SectionPerformance (Communication Response Time)

119

• Communication Response Performance Using the Link Word Area
Illustrated below is the data flow when the link word area is used for the communication
data storing area:

PMCR #1456
#0000
000

OUT
area

IN area

Send data
conversion

process

Received
data conversion

process

External
device

process

CPU unit
Protocol Support

Board
External devices

PMCR
instruction
process

Request
data

3 4

8 7 6 5

2

1

Send data
notification

Received
data writing

The communication response time is total from 1 to 8 in the above figure.
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Number Function Time Required Description

1 PMCR instruction
executing notification
process time

About 40 µ second The time from the start of PMCR
instruction to the end of the
instruction notification to the PSB.

2 Send data notification
process time

One-cycle time
maximum

The time required for the data
transfer based on the PSB
request.

3 Send data conversion
process time

Depends on the number
of conversion bytes

The time required for the data
conversion based on the specified
conversion mode which finishes at
the start of data sending to the
external device.

4 Send data transmission
time

Number of data
characters x
one-character bit/
transmission rate

The time required for the data
transmission to the external
device.
(Use double the calculated time
because an idle time exists
between send characters.)

5 External device process
time

Depends on the
external device process

The time required for the external
device process according to the
PLC’s command which finishes by
the start of the response data
sending.

6 Received data
transmission time

Number of data
characters x
one-character bit/
transmission rate

The time required for the receive
data transmission from the
external device.
(Use two to five times the
calculated time because an idle
time exists between the receive
characters.)

7 Received data
conversion process
time

Depends on the number
of conversion bytes

The time required for the receive
data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data.

8 Received data writing
process time

One-cycle time
maximum

The time required for the received
data transfer to IOM.

Note Although the data conversion process times of 2 and 6 vary according to the PLC
operation status, the maximum values can roughly be estimated by the following
calculation formula:
2 The send data conversion process time = 10000µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15µ second, ASCII conversion: 40µ
second, HEX conversion:
55µ second)
6 The receive data conversion process time = 100µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15µ second, ASCII conversion: 30µ
second, HEX conversion:
15µ second)
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• Communication Response Time Using the Direct Addressing
Illustrated below is the data flow when the direct addressing is used:

PMCR #1456
#0000
000

IOM

IOM

Send data
conversion

process

Received
data conversion

process

External
device

process

CPU unit
Protocol Support

Board
External devices

PMCR
instruction
process

Request
data

RepeatÁ and Å by the
number of variables of
the direct addressing

RepeatÆ and Ç by the
number of variables of
the direct addressing

3 4

8 7 6 5

2

1

Send data
notification

Received
data writing

The communication response time is total from 1 to 8 in the above figure. The
functions 2 and 3 are repeated by the number of variables of the direct addres-
sing of the send message while 7 and 8 are repeated by those of the receive
message.
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Number Function Time Required Description

1 PMCR instruction
executing notification
process time

About 40 µ second The time from the start of
PMCR instruction to the
end of the instruction
notification to the PSB.

2 Send data notification
process time

One-cycle time maximum The time required for the
send data transfer based
on the PSB request.

3 Send data conversion
process time

Depends on the number of
conversion bytes

The time required for the
sent data conversion based
on the specified conversion
mode which finishes at the
start of data sending to the
external device.

4 Send data transmission
time

Number of data characters
x one-character bit/
transmission rate

The time required for the
data transmission to the
external device.
(Use double the calculated
time because an idle time
exists between send
characters.)

5 External device process
time

Depends on the external
device process

The time required for the
external device process
according to the PLC’s
command which finishes by
the start of the response
data sending.

6 Received data
transmission time

Number of data characters
x one-character bit/
transmission rate

The time required for the
received data transmission
from the external device.
(Use two to five times the
calculated time because an
idle time exists between the
receive characters.)

7 Received data conversion
process time

Depends on the number of
conversion bytes

The time required for the
received data conversion
from the external device
based on the specified
conversion mode which
finishes at the end of data.

8 Received data writing
process time

One-cycle time maximum The time required for the
DP-RAM’s received data
transfer to IOM.

Note Although the data conversion process times of 2 and 6 vary according to the PLC
operation status, the maximum values can roughly be estimated by the following
calculation formula:
2 The send data conversion process time = 10000µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15µ second, ASCII conversion: 40µ
second, HEX conversion:
55µ second)
6 The receive data conversion process time = 100µ second + one-byte conver-
sion time x number of conversion bytes
(one-byte conversion time→No conversion: 15µ second, ASCII conversion: 30µ
second, HEX conversion: 15µ second)
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• The Overhead at I:N Connection
When the repeat count is specified by a step, the time from the end of the previous step
execution to the next start of the same step execution is about 20µ seconds. This time
period is from the end of the communication with the previous machine to the start of the
process with thenext machine in thesystem of1:N connection.When the link wordarea
or the direct addressing area is used, the send data is transferred from the CPU unit at
every step, therefore an additional time is required before the actual start of the data
sending as follows:

• When the link word area is used: The total time of Á + Å in the
above figure (the link word)

• When the direct addressing is used:The total time of Á + Å in the
above figure
(the direct addressing)

These times are not required if the event (operand addressing) area is used, be-
cause the beginning of sequence only in the send data is transferred from the
PLC’s CPU unit.
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SECTION 5
Project Creation and Display

This section describes how to edit and manage projects.

5-1 Project Creation 126. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-1 Create a New Project 126. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-2 Open an Existing Project 127. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-3 Save a Project 127. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-4 Save a Project As 128. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-5 Close a Project 129. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

5-2 Project Display 129. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-3 Project Windows 130. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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5-1 Project Creation
A project contains all protocol and system setting data. Each project consists of
a protocol list and devices: a protocol list defines all the protocols within a project
consisting of sequences, steps, messages and matrices; devices define the
system settings.
A SYSMAC-PST project has the same concept as projects in other products,
such as SYSMAC-CPT and SYSWIN, in that the project contains both ladder
and PLC to Computer communications information. The project hierarchy also
follows standard Windows 95 concepts, such as Explorer.
SYSMAC-PST provides the user with the following capabilities associated with
projects.
• Creating a new project.
• Opening an existing project.
• Renaming an existing project.
• Copying a project.
• Saving a project.
For more information about protocol lists, protocols, sequences and steps, refer
to Section 7 Protocol Creation and Editing. For more information about mes-
sages, refer to Section 8 Editing Send & Receive Messages and Receive Ma-
trices. For more information about traces, refer to Section 11 Trace/Monitor. For
more information about system settings, refer to Section 6 Hardware Configura-
tion.
Observe the following precautions when using a floppy disk:
• Copy project files contained in a floppy disk onto the hard disk.
• Do not save project files directly on a floppy disk. Save them on the hard disk

once and then, using Windows Explorer, etc., copy the files from the hard disk
to a floppy disk.

• Do not remove the floppy disk from the drive while using a project file on a
floppy disk.

• If the message “Disk full while accessing xxx” appears while saving a project
file, the file saving will have failed due to insufficient disk space. In such a case,
be sure to resave the project file onto the hard disk.

5-1-1 Create a New Project
Use the following procedure to create a new project.

1, 2, 3... 1. Select New from the File menu or click on the New button from the Toolbar.
Alternatively, a new project can be created by pressing Ctrl+N.

Each new project is given a default name displayed in the title bar which may be
changed prior to saving the project.
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A description for the project can be applied by selecting the project in the left
pane with the right mouse button and clicking Properties. The Project Properties
dialog is displayed.

Enter a meaningful description for the project and click on the OK push-button.
Click on the Cancel push-button to abort.

5-1-2 Open an Existing Project
Use the following procedure to open an existing project.

1, 2, 3... 1. Select Open from the File menu or click on the Open button from the
Toolbar. Alternatively, an existing project can be opened by pressing
Ctrl+O.

2. The Open dialog is displayed.

Select a project from the Open dialog list. Project files (*.psw) are displayed
by default. Other types of files can be selected from the Files of type:
drop-down list. The current folder can be changed by selecting another
folder from the Look in: drop-down list.

3. Click the Open push-button or double-click on the selected project to open
the project with the specified filename, file type and location. Click the
Cancel push-button to close the Open dialog without opening a project.

5-1-3 Save a Project
Use the following procedure to save a project.



5-1SectionProject Creation

128

1, 2, 3... 1. Select Save from the File menu or click on the Save button from the Toolbar.
Alternatively, an existing project can be saved by pressing Ctrl+S.

2. The project is saved using the current project name. For a new project which
has not been saved before, the Save operation activates the Save As
operation, described in Section 5-1-4 Save a Project As.

5-1-4 Save a Project As
The Save As operation permits the saving of an existing project under a different
project name. It is also used to provide a new project with a project name for the
first time.

Use the following procedure to save a project under a different project name.

1, 2, 3... 1. Select Save As from the File menu.

2. The Save As dialog is displayed.

To ensure only a project is saved, the Save as type: field is set to “PST
Project Files (*.psw)”. The current folder can be changed by selecting
another folder from the Save in: Drop-down list.

Type a project name in the File name: field. A project can be overwritten by
selecting the project from the list. It is not possible to overwrite a read-only
project.

3. Click the Save push-button to save the project with the specified filename,
file type and location. Click the Cancel push-button to close the Save As
dialog without saving the project.

Confirmation is required if a project is to be overwritten.

Select the Yes push-button to overwrite the existing project. Select the No
push-button to abort this operation. A project that is read-only cannot be
overwritten.
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5-1-5 Close a Project
To close a currently open project select Close from the File menu or select the
Close button from the project window title bar. Closing a project requires
confirmation if the project has not been saved since its last amendment.

Select the Yes push-button to Save the project. If the project has been saved
before, a Save operation is activated as described in Section 5-1-3 Save a Proj-
ect. If the project has not been saved before, a Save As operation is activated as
described in Section 5-1-4 Save a Project As. Select the No push-button to lose
any changes to the project since its last Save operation. Click the Cancel push-
button to close the project without saving changes to the project.

5-2 Project Display
The project window is used to perform all actions associated with a project.

The project window consists of two panes: the left pane contains the project hier-
archical structure, the right pane contains information referring to the embold-
ened item in the left pane. It is possible to navigate from one pane to the other by
selecting Swap Focus from the View menu or by pressing Tab. The full hierarchi-
cal structure is as follows:
Project
Protocol list
Protocol
Sequence
Step

Send Message List
Send Message

Receive Message List
Receive Message

Matrix List
Matrix

Matrix Care
Trace List

Trace
Devices
PLC
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PLC Memory
PSB
Trace Memory A/B
Communications Port Settings A/B

PC<-->PLC Comms Settings

The hierarchical structure can be expanded by selecting the plus icon in the left
pane, or by selecting an item in the right pane. Navigation up a level is achieved
by selecting the minus icon in the left pane, selecting Parent from the View menu
or by pressing Esc.

To amend settings in the right pane, select the appropriate icon in the left, for
instance, the project icon.

The width of the fields is automatically adjusted to fit the text. The widths can be
further adjusted in the right pane. Use the following procedure to further adjust
the column widths.

1, 2, 3... 1. Move the mouse pointer or input device over the header fields of the right
pane. Between columns the mouse pointer changes shape.

2. Once the mouse pointer has changed, click and hold the left mouse button
and drag the column width to the new position.

The divider bar separating the left and right frame can also be moved in the same
manner. Use the following procedure to adjust the pane size.

1, 2, 3... 1. Move the mouse pointer or input device over the divider bar between panes.
The mouse pointer changes shape.

2. Once the mouse pointer has changed, click and hold the left mouse button
and drag the divider bar to the new position.

5-3 Project Windows
It is possible to include more than one project window within SYSMAC-PST. A
new window can contain a project currently open in another window, or a differ-
ent project.

To add a new project window for an already open project, select New Window
from the Window menu. The new project window is placed to the front, cascad-
ing from its predecessor project window. All windows are provided with a unique
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identifier and can be used independently to navigate through, and amend, the
project.

To add a new project window for a different project, use the Open method de-
scribed in Section 5-1-2 Open an Existing Project. The new project window is
placed in front cascading from its predecessor project window.

To activate a project window, select the appropriate title bar or press Ctrl+F6 to
jump to the next project window.

A project window can be moved within the SYSMAC-PST application by
selecting the project window button title bar with the left mouse and dragging the
project window to its new destination, or by selecting Move from the project
window control menu.

A project window can be resized. Use the following procedure to resize a project
window.

1, 2, 3... 1. Move the mouse pointer or input device over a project window boundary.
The mouse pointer changes shape.

2. Once the mouse pointer has changed, click and hold the left mouse button
and drag the boundary to its new position.

Note By selecting the corners of the project window boundary, the project window can
be resized ensuring that the aspect ratio of the window is preserved.

A project window can also be resized by selecting Size from the project window
control menu.

Multiple windows can be fully viewed within SYSMAC-PST. However, the more
project windows that are opened, the less information can be viewed within each
one.
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To arrange project windows so they can be fully viewed, select Tile from the Win-
dow menu.

Multiple windows can be returned to their cascaded state by selecting Cascade
from the Window menu.
Multiple windows can be maximized and minimized on an individual basis in the
same manner as the display area. Refer to Section 2 Environment/Installation/
Uninstallation/Starting/Ending for further information.
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SECTION 6
Hardware Configuration

This section describes the hardware settings that can be configured for SYSMAC-PST.

6-1 Devices Configuration 134. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-2 Computer-to-PLC Communications 134. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

6-2-1 Connection to PLC via Modem 136. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-2-2 Cable Connection between Modem and PLC 140. . . . . . . . . . . . . . . . . . . . . . . . . . . .

6-3 PLC Configuration 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-1 PLC Selection 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-2 Online Connection 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-3 Switching to Offline Connection 142. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-4 PLC Mode Selection 142. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-5 PSB Selection 142. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-6 PSB Communications 143. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-3-7 Transferring Port Settings to the PSB 144. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

6-4 Printer Setup 145. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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6-1 Devices Configuration
The Devices are configured as follows.

1, 2, 3... 1. The Devices consist of a PLC and PC ↔ PLC Comms.

2. The PLC consists of a PLC Memory and PSB.

3. The PSB consists of a Trace Memory A, Trace Memory B, Comms Port A,
and Comms Port B.

Devices Icon PLC Model

PC↔ PLC Comms

PLC Icon

PLC Memory

PSB Icon

Monitors and edits I/O memory in the PLC.

Trace Memory A/B

Comms Port A/B

For starting the
trace function and
reading data.

For setting
communica-
tion port of the
PSB.Set by users.

Monitor

Outline of operation
Select the Devices icon and double-click the left button to set the PLC model and
the conditions of communications between the PLC and personal computers.

Select the PLC icon in the left pane and click the left button to connect the PLC
on-line.

1, 2, 3... 1. Double-click on the PLC Memory in the right pane to monitor or edit the I/O
memory in the PLC.

2. Uploading and displaying the protocol in the PSB is also possible.

Select the PSB icon in the right or left pane and double-click the left button to set
or transfer the Comms Port A/B of the PSB or to start or read the Trace Memory
A/B.

6-2 Computer-to-PLC Communications
Use the following procedures to change the computer to PLC communications.

1, 2, 3... 1. Double-left-click on the devices icon.

2. Double-left-click on the Current Configuration setting to select a PLC. Press
Return or select Accept form the Edit menu, or press Alt+E followed by A.
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3. Double-left-click on the PC ↔ PLC Comms icon to use the SYSMAC-CDM
application to amend the PLC. Within the SYSMAC-CDM application, the
Change PLC dialog is displayed.

4. The Change PLC dialog allows the configuration of a PLC to be modified.
The Network settings may be altered using the Network: drop-down list and
the adjacent Setup... push-button.

Caution Do not change the settings in the PLC Name: field and Device Type: drop-down
list unless necessary. The PLC Name; field cannot be edited.

5. Select the OK push-button to accept the settings. Select the Cancel
push-button to leave the settings unchanged. Once the settings have been
accepted, an error message is displayed if the PLC Type and CPU does not
conform to the selected PLC, or the PLC Type and CPU does not conform to
the PLC and CPU supporting the PSB. The selected PLC is displayed as the
PLC Type: setting.

The Network can be amended by selecting the Setup... push-button adjacent to
the Network: drop-down list.
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Use the following procedure to amend the Network settings.

1, 2, 3... 1. Enter the Unit Number associated with the network being configured in the
Unit Number: field.

2. Enter the Destination Network Address in the Destination Network Address:
field and Destination Node Number for the network node (or connection
point) in the Destination Node Number: field.

3. If necessary, enter configuration information to ensure that data is trans-
mitted correctly over the network, by selecting the Setup... push-button.
The Driver Configuration dialog is displayed.

Select the Port Name, Baud Rate, data Bits, Parity and Stop Bits from the
associated drop-down lists. Alternatively, select the Make Default push-button.
Select the OK push-button to accept the settings. Select the Cancel push-but-
ton to leave the settings unchanged. The Network Settings dialog is re-dis-
played.

4. Select the OK push-button to accept the settings. Select the Cancel push-
button to leave the settings unchanged.

6-2-1 Connection to PLC via Modem
Use the following procedure when connecting to the PLC via modem.

1, 2, 3... 1. Select Modem in the Network filed.
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2. Click the Setup push-button located to the right of the Network field. Net-
work Settings [Modem] dialog will be displayed.

3. Click the Setup push-button located to the right of Driver Configuration.
Driver Configuration [Modem] dialog will be displayed. Input the commu-
nications conditions and phone number.

4. Click the Modem push-button to set commands for the modem. Modem
Configuration dialog will be displayed. Input an appropriate command in
each one of the following fields; Initialization, Reset, Dial Prefix, Hangup,
and Connect Timeout(s).

5. Press the OK push-button.
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PLC Connection Example via Modem
The following section describes the modem setting procedure for a PLC connec-
tion via modem. AT commands and S register settings are explained for use with
an OMRON MD144FB5V modem. (With the MD144FB5V, baud rate can be set
up to 9,600 bps.) When using other modems, refer to the manual supplied with
the modem and make similar settings.

Modem Settings on the Personal Computer Side

Setting Items

Set the following items as shown in the table. Other settings vary depending on
the type of telephone line or the modem model and, therefore, must be appropri-
ately set for the system in use.

Item Settings

Baud rate (see note 1) 2,400, 4,800, 9,600 or 19,200 bps

Data length (see note 1) 7 bits

Parity (see note 1) Even

Stop bit (see note 1) 1 bit

Data error correction, data compression
(see note 2)

Data error correction: Yes
Data compression: No
MNP class 4 or V.42

Flow control (see note 2) No (CS/RS: No, XON/OFF control: No)

Automatic reception (see note 2) No

Terminal speed fixed (see note 2) No

Abort timer (see note 2) For example, set to a 10-minute interval

Note Do not perform data compression.
Do not fix the terminal speed.

Note 1 Set these items on the Driver Configuration [Modem] dialog box.

2 Set these items on the Modem Configuration dialog box.

The following special symbols are used in the Modem Configuration dialog box.

Symbol Meaning

^ Issues an AT command

! Waits 0.1 second
µ Waits 1.1 second

Setting Example

Input an AT command. In this example, input:
AT%C0*C0ON3&M5OQ0S26=10X3OV2OJ1^

If the telephone line is in pulse mode, input ATDP.

Default settings can be used. No need to change them.

Be sure to add a suffix of “^” to the AT command to be input in the Initialization,
Preset, Dial Prefix, and Hangup fields. If this suffix is not added, the line cannot
be connected or disconnected.
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Note Depending on the modem, continuous issue of the AT commands might cause
an error. If such an error occurs, input “!” in the Reset and Dial Prefix fields.
For example: !ATDT

Meanings of the AT commands and S registers used in the just-described exam-
ple:

Command Function Settings

AT&F Initializes the modem.

AT%C0 MNP class setting MNP class 4
(No data compression)

AT*C0 V.42bis compression setting No compression

ATON3 MNP setting Auto-reliable mode

AT&M5 V.42 setting Auto-reliable mode

ATOQ0 Flow control between the
terminal and modem

No flow control

ATS26=10 Abort timer 10 minutes

ATX3 Display of baud rate, busy and
dial tone detection

Yes

ATOV2 Error correction (Yes/No)
display

Yes

ATOJ1 Terminal speed fixing No

Modem Settings on the PLC Side
Setting Items
Set the following items as shown in the table. Other settings vary depending on
the type of telephone line or the modem model and, therefore, must be set as
suited for the system in use.

Note Be sure to write the modem settings on the PLC side into the nonvolatile
memory.

Item Settings

Data length 7 bits

Parity Even

Stop bit 1 bit

Data error correction, data compression Data error correction: Yes
Data compression: No
MNP class 4 or V.42

Flow control No (RTS/CTS: No, XON/OFF control:
No)

Automatic reception No

ER signal Always ON

Terminal speed fixed No

Abort timer For example, set to a 10-minute interval

Note Do not perform data compression.
Do not fix the terminal speed.
When setting the baud rate, set Automatic Speed Response at Reception to
Yes.

Setting the Nonvolatile Memory
Save the AT commands and S registers in the nonvolatile memory using the
communications software as described below.

1, 2, 3... 1. Turn OFF the power supply to the modem.
2. Start the communications software and input as follows:
AT%C0*C0ON3&M5OQ0S0=1S26=10X3OV2OJ1&D0&W1↵
OK
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Note “OK” is a message from the modem which indicates that the command has en-
ded.

Meanings of the AT commands and S registers used in the just-described exam-
ple:

Command Function Settings

AT%C0 MNP class setting MNP class 4 (No data
compression)

AT*C0 V.42bis compression setting No compression

ATON3 MNP setting Auto-reliable mode

AT&M5 V.42 setting Auto-reliable mode

ATOQ0 Flow control between the
terminal and modem

No flow control

ATS0=1 Automatic reception and
reception calls setting

Automatic reception: Yes
Number of calls: 1

ATS26=10 Abort timer 10 minutes

ATX3 Display of baud rate, busy and
dial tone detection

Yes

ATOV2 Error correction (Yes/No)
display

Yes

ATOJ1 Terminal speed fixing No

AT&D0 ER signal Always ON

AT&W1 Writing to the nonvolatile
memory area 1

Writes the contents of the
present value area in the
nonvolatile memory area.

6-2-2 Cable Connection between Modem and PLC
Cable connection varies depending on the communications port to be used.
Connect cables appropriately for the system to be used.

Cable Connection between Modem and Internal Host Link Port of PLC

FG
SD

RD
RS
CS
SG
DR

ER

1
2

3
4
5

7
6

20

1
2

3
4
5

7
9

8

FG
SD

RD
RS
CS
SG
---

---

Shield

Modem

Connector hood FG

PLC

Connector hood FG

25-pin D-sub plug (Male) 9-pin D-sub plug (Female)
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Cable Connection between Modem and Internal Peripheral Port of PLC
Connect the CQM1-CIF02 Connecting Cable to the peripheral port of the PLC
and connect the modem connecting cable to the other end of the CQM1-CIF02
Connecting Cable.

FG
SD
RD
RS
CS
SG
DR
ER

1
2
3
4
5
7
6

20

1
2
3
4
5

7
9

8

FG
SD
RD
RS
CS
SG

To modem To PLC

CQM1-CIF02Connection Cable

---
---

CQM1-CIF02

Connector hood FG

Modem

Connector hood FG Shield

25-pin D-sub plug (Male) 9-pin D-sub plug (Male)

Note For connecting the modem to a personal computer, use the cable supplied with
the modem.

6-3 PLC Configuration

6-3-1 PLC Selection
Use the following procedure to select a PLC.

1, 2, 3... 1. Double-left-click on the devices icon.
2. Double-left-click on the Current Configuration setting or alternatively click

on the Current Configuration setting and press Return or select Field from
the Edit menu.

3. Select a PLC from the drop-down list and press Return, or select Accept
from the Edit menu.

4. If required, double-left-click on the PC ↔ PLC Comms icon to use the
SYSMAC-CDM application to amend the PLC.

6-3-2 Online Connection
Use the following procedure for online connection.

1, 2, 3... 1. Double-left-click the Devices icon.
2. If No selected PLC is displayed in the Current Configuration field of the PLC,

double-left-click the display and select the applicable CPU Unit model from
the drop-down list. Press Return, or select Accept from the Edit menu.

3. If the PC <-->PLC Comms does not coincide with the communications set-
tings of the port connected to the CPU Unit, change the communications
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settings between the PC and PLC or change the settings on the CPU Unit
side.

4. Left-click the PLC icon in the left or right pane. The PC mode will change
from Offline to Online and the PC tool bar will change from Offline to Pro-
gram, Monitor, or Run.

Caution The SYSMAC-PST and SYSMAC-CPT cannot be connected online when using
both at the same time.
If the online connection of the SYSMAC-PST is attempted while the SYSMAC-
CPT is connected online, the message “Unable to open the PLC” will be dis-
played, and online connection will not be possible.
If the SYSMAC-CPT has been started and connected online, therefore, set the
SYSMAC-CPT offline and then connect the SYSMAC-PST online.

Set the SYSMAC-CPT offline according to the following procedure:
Select Go Offline from the Online on the main menu. Refer to SYSMAC-CPT
User Manual (W333).

When connecting the SYSMAC-CPT online, set the SYSMAC-PST offline and
then connect the SYSMAC-CPT online. For setting the SYSMAC-PST offline,
refer to the following section.

6-3-3 Switching to Offline Connection
For changing the SYSMAC-PST connection from online (Program, Monitor, or
Run) to offline, follow either one of the following procedures. The PC tool bar will
change to Offline.
• Click an icon or object (from Project to Devices) located above the PLC icon.
• Perform a file operation (Create File, Open, Read Standard Protocol, Close)

using the main menu or project tool bar.

6-3-4 PLC Mode Selection
Use the following procedure to change the current mode of the PLC.

1, 2, 3... 1. Double-left-click on the devices icon.
2. Double-left-click on the PLC icon to enable the PLC Mode push-button on

the toolbar.
3. Select the PLC Mode push-button from the display area.
4. Select Run, Monitor, or Program from the pop-up menu. The mode of the

PLC changes accordingly.

Caution Confirm that no adverse effect will occur in the system before changing the oper-
ating mode of the PLC. Not doing so may result in an unexpected operation.

Note 1 If no PLC is connected, the mode of the PLC is Offline. For a project to be
online, the devices icon must be selected.

2 When a project is online, any other projects that are opened are offline and
need to be changed manually.

6-3-5 PSB Selection
Use the following procedure to select the PSB.
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1, 2, 3... 1. Double-left-click on the devices icon.

2. Double-left-click on the PLC icon.

3. Double-left-click on the PSB icon.

4. Select the Comms Port A icon or the Comms Port B icon, according to the
PSB setup.

6-3-6 PSB Communications

Use the following procedure to set the PSB communication settings for Port A or
Port B.

1, 2, 3... 1. Select the appropriate PSB Port, as described in Section 6-2-3 PSB
Selection.

2. Double-left-click on the appropriate PSB Port, either Port A or Port B.
Alternatively, select Edit Settings from the right mouse button menu. The
PSB Communications Port Settings dialog is displayed.

Edit the fields as appropriate. Click the OK push-button to accept the
settings. Select the Cancel push-button to close the dialog without
changing the settings.

The number of fields that can be edited is dependant on the communications
method. The dialogs are identical for Port A and Port B.
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Communications Method Options that can be Set Remarks

Non-standard Host Link Unit # field
Delay (× 10 ms) field
CTS Enable field
Baud Rate field
Stop Bits field
Parity field
Data Length field

Standard Host Link Unit # field
Delay (×10 ms) field
CTS Enable field

The Baud Rate, Stop Bits, Parity and Data Length
fields are applicable, but the default settings cannot be
changed

Non-standard RS232C Delay (× 10 ms) field
Start Code field
End Code field
CTS Enable field
Baud Rate field
Stop Bits field
Parity field
Data Length field

If the Start Code field or End Code field is set to ‘Yes’,
then the adjacent Code (00 - FF) field can also be set.
If the End Code field is set to ‘No’, then the adjacent
Length (1 - 256) field can be set.

Standard RS232C Delay (× 10 ms) field
Start Code field
End Code field
CTS Enable field

If the Start Code field or End Code field is set to ‘Yes’,
then the adjacent Code (00 - FF) field can also be set.
If the End Code field is set to ‘No’, then the adjacent
Length (1 - 256) field can be set.

The Baud Rate, Stop Bits, Parity and Data Length
fields are applicable, but the default settings cannot be
changed.

1:1 Link Slave CTS Enable field

1:1 Link Master Data Link Area field
CTS Enable field

1:1 NT Link None

1:N NT Link Max PT Unit # field

Non-standard Protocol Macro Baud Rate field
Stop Bits field
Parity field
Data Length field

Standard Protocol Macro None The Baud Rate, Stop Bits, Parity and Data Length
fields are applicable, but the default settings cannot be
changed.

6-3-7 Transferring Port Settings to the PSB
Transferring Port Settings to the PLC

Transfer the communications port settings to the PSB according to the following
procedure.

1, 2, 3... 1. Select the Comms Port A or B.
2. Left-click the Download Port Settings icon on the tool bar or click the right

button and select the Download Settings to PLC from the popup menu.
3. The message “Downloading Port Settings to PLC” will be displayed. When

the transfer has been completed, the dialog “Downloaded PSB communica-
tions Settings OK” will be displayed.

Caution Confirm that no adverse effect will occur in the system before changing the oper-
ating mode of the PLC. Not doing so may result in an unexpected operation.

Caution Confirm that no adverse effect will occur in the system before transferring the
communication port A/B settings to the PSB.

Reading Port Settings from the PSB
Read the communications port settings from the PSB according to the following
procedure.
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1, 2, 3... 1. Select the Comms Port A or B.
2. Left-click the Upload Port Settings icon on the tool bar or click the right but-

ton and select the Upload Settings from PLC from the popup menu. When
reading has been completed, the dialog “PSB Communications Port Set-
tings” will be displayed.

Note Read or write the contents of DM 6550 to DM 6654 (Port B) or DM 6555 to
DM 6559 (Port A) set by PLC Setup in the CPU Unit according to the above pro-
cedure. This setting operation can also be performed by the peripheral devices
of the PLC Unit.

6-4 Printer Setup
The printer configuration can be setup using the Print Setup dialog. Use the fol-
lowing procedure to set up the printer configuration from within SYSMAC-PST.

1, 2, 3... 1. Select Print Setup... from the File menu or press Alt+F followed by R.
2. The Print Setup dialog is displayed.

Select the printer from the Name: drop-down list. Use the Properties
push-button to display the Properties dialog to configure the specific printer
settings.

3. Select the paper size from the Size: drop-down list in the Print Setup dialog
or from the Properties dialog for the selected printer.

4. Select the paper source from the Source: drop-down list in the Print Setup
dialog or from the Properties dialog for the selected printer.

5. Select the orientation from the Orientation options in the Print Setup dialog
or from the Properties dialog for the selected printer.

6. Click the OK push-button to accept the settings or click the Cancel
push-button to leave the settings unchanged.

Refer to specific Printer documentation for further details on printer configura-
tion.
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SECTION 7
Protocol Creation and Editing

This section describes how to edit and manage protocols and sequences.
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7-1 Overview of Protocol Sequence Creation
The protocol macro function allows a user to create original communications
procedures. Users can freely edit communications procedures (called se-
quences) for various external devices, such as general-purpose components
connected to RS-232C or RS-422/485 interfaces. These procedures are initi-
ated by the PMCR instruction contained within a running PLC program.

The structure of a protocol is as follows:

Protocol list
Protocol

Sequence
Step

Send Message List
Send Message

Receive Message List
Receive Message

Matrix List
Matrix

Matrix Case

7-1-1 Sequence Settings
Up to 1,000 (0 to 999) sequences can be registered and used, although only 60
can be allocated to one protocol. Each sequence consists of up to 16 steps.

7-1-2 Sequence Settings
The settings that can be made for sequences using SYSMAC-PST are shown in
the following table.
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Level Item Action Settings
Sequence Link Words Set words for which data is

shared between the PLC and
a PSB.

CIO, LR, HR, AR, DM or EM
effective starting address and
length for Input or Output Area
1 or 2.

Transmission
Control

Set transmission control
method such as Xon/Xoff flow
control or RTS/CTS flow
control.

Xon/Xoff control, RTS/CTS
control, modem control,
delimiter control, and
contention control.

Response Type Set the response method for
writing data to the PLC.

Scan mode, Fixed Interrupt
notification or Receive Case
Interrupt notification.

Timers Set the period for monitoring
sent/receive processing.

Receive wait time, receive
finish time, send finish time.
Units (0 to 99) of 0.01 s, 0.1 s,
1 s, or 1 min.

Step Repeat Counter Set the step repeat counter. Reset or hold (Reserve).
Constants 1 to 255, CIO
channel, LR channel, HR
channel, AR channel, DM
channel, EM channel, I1, I2,
O1, O2 or Operand effective
address.

Command Set the communications
commands.

Send, Receive, or Send &
Receive.

Retry Count Set an error retry count when
the command setting is Send
& Receive.

0 to 9.

Send Wait time Set the wait time required to
send data at transmission.

Units (0 to 99) of 0.01 s, 0.1 s,
1 s, or 1 min.

Send Message Set send data when the
command is Send or Send &
Receive.

The settings detail can be
viewed in the Send Message
setting drop-down list for a
step or the Send Message
List.

Receive Message Set expected received data
when the command is Receive
or Send & Receive.

The settings detail can be
viewed in the Receive
Message setting drop-down
list for a step or the Receive
Message List.

Receive Matrix Set expected received data
(up to 15 sets) and change the
processing according to the
received data when the
command is Receive or Send
& Receive.

The matrix settings can be
viewed in the Matrix list
(matrix columns cannot be
seen in the Step List).

With/Without
Response Writing

Set whether to save the
receive data to the PLC.

No or Yes.

Next Process Set the next step to which
control is to be passed when a
step is terminated normally.

Goto (0 to 15), End, Abort,
Next.

Error Process Set the next step to which
control is to be passed when a
step is terminated abnormally.

Goto (0 to 15), End, Abort,
Next.

7-1-3 Creating Sequences

The following diagram shows an example of how the setting of a sequence and
the entire setting procedure could flow. Refer to Section 7-2 Edit a Protocol List
and Section 7-3 Edit a Protocol for individual settings and setting procedures.
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Fixed Interrupt Receive Case Interrupt
(synchronous write)(synchronous write)

Response type (receive
data write method)

Receive finish time: Tfr Send finish time: Tfs

Set Send wait time Set Send wait time
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7-2 Edit a Protocol List

7-2-1 Display a Protocol List
Use the following procedure to display a protocol list for a project.

1, 2, 3... 1. Click on the project icon in the left pane to show the name of the protocol list.

2. Double-left-click on the protocol list icon to show all protocols in the protocol
list.

Note Alternatively, double-left-click on the protocol list icon in the right pane.

7-2-2 Create a New Protocol in the List
Use the following procedure to create a new protocol in the protocol list.

1, 2, 3... 1. Click on the project icon.

2. Select the protocol list to add a new protocol into.

3. Select the protocol list icon in the left pane, more than one protocol in the
right pane, or a free area in the right pane, outside the protocol list, with the
right mouse button and select Create Protocol....

7-2-3 Rename a Protocol in the List
Use the following procedure to rename a registered protocol.

Note The “System” type protocols cannot be changed.

1, 2, 3... 1. Double-left click on the appropriate Protocol Name setting in the protocol list
or select the Protocol Name setting and press Return. Alternatively, select
the Protocol Name setting and select Field from the Edit menu. The current
protocol name becomes an editable field.

2. Type in a new name for the protocol and press Return or select Accept from
the Edit menu. It is possible to select a portion of the current protocol name
and overtype. The new protocol name may not exceed 30 characters.

7-2-4 Delete a Protocol from the List
Use the following procedure to delete a protocol. ‘System’ type Protocols cannot
be deleted.
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1, 2, 3... 1. Select the icon of the protocol to be deleted from the protocol list. More than
one protocol can be selected by pressing Shift and selecting another
protocol to extend the selection, or by pressing Ctrl and selecting another
protocol to add to the selection.

2. Select the Delete button from the toolbar or press Delete. Alternatively,
select Delete from the Edit menu or press Alt+E followed by D. Select the
OK push-button from the confirmation dialog to confirm deletion or the
Cancel push-button to cancel the deletion.

A protocol can also be deleted by selecting the Cut button from the Toolbar or
pressing Ctrl+X or press Alt+E followed by T. Alternatively, select Cut from the
right mouse button dialog or Cut from the Edit menu. Select the Paste button
from the Toolbar or press Ctrl+V or press Alt+E followed by P to retrieve the last
delete action using the Cut operation. Alternatively, select Paste from the right
mouse button dialog or Paste from the Edit menu. The pasted protocols are
placed at the end of the protocol list.

7-2-5 Set the Protocol Sequence Number Range
Use the following procedure to specify the range of sequence numbers that are
used by a specified protocol. An error occurs if the specified range is smaller
than the range associated with the registered sequence.

Note Sequence number ranges belonging to “System” type protocols cannot be
changed.

1, 2, 3... 1. Double-left-click on the Seq Start setting associated with the protocol in the
protocol list. Alternatively, select the Seq Start setting and press Return or
select the Seq Start setting and select Field from the Edit menu. The current
sequence start becomes an editable field.

2. Enter a starting number and press Return or select Accept from the Edit
menu.

3. If necessary, double-left-click on the Seq End setting associated with the
protocol in the protocol list. Alternatively, select the Seq End setting and
press Return or select the Seq End setting and select Field from the Edit
menu. Enter an end number and press Return or select Accept from the Edit
menu.

If an illegal number is entered in either the Seq Start or Seq End fields for the
associated protocol, the number turns red.

Note 1. If the Seq Start setting is changed, then all communication sequences within
that protocol are renumbered by the same amount. For instance, if the Seq
Start setting is changed from 200 to 210, all communication sequences
within that protocol are incremented by ten.

2. The Seq Start setting and Seq End setting range must be large enough to
hold all existing communication sequences.
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7-2-6 Retrieve an Existing Protocol
SYSMAC-PST is supplied with a number of predefined coded system protocols.
Select the Open System Protocols button from the toolbar to retrieve the
predefined protocols. Alternatively, select Open System Protocols from the File
menu or press Alt+F followed by Y. The protocols and their contents cannot be
edited directly, but can be copied to a user defined protocol.

7-2-7 Copy Protocol
Use the following procedure to copy a protocol. ‘System’ type protocols can be
copied, but the protocol type changes to ‘User’ once pasted into a new protocol
list.

1, 2, 3... 1. Select the icon of the protocol to be copied from the protocol list in the right
pane. More than one protocol can be selected by pressing Shift and
selecting another protocol to extend the selection, or by pressing Ctrl and
selecting another protocol to add to the selection.

2. Select the Copy button from the Toolbar or press Ctrl+C or press Alt+E
followed by C. Alternatively, select Copy from the right mouse button dialog
or select Copy from the Edit menu.

3. Select a protocol list or display the protocols in the right pane into which to
paste the copied protocol or protocols.

4. Select the Paste button from the Toolbar or press Ctrl+V or press Alt+E
followed by P. Alternatively, select Paste from the right mouse button dialog
or select Paste from the Edit menu. The pasted protocols are placed at the
end of the protocol list.

Note The entire protocol is copied, including the sequences, steps, messages and
matrices.

7-3 Edit a Protocol

7-3-1 Edit a Sequence List

Use the following procedure to display a sequence list within a protocol.

1, 2, 3... 1. Double-left-click on the protocol list to show all protocols.

Display a Sequence List
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2. Double-left-click on the protocol containing the sequences in the left pane or
double-left-click the protocol in the right pane to list all sequences contained
within the protocol.

Use the following procedure to create a new sequence in the protocol.

1, 2, 3... 1. Double-left-click on the protocol list to show all protocols.
2. Select the protocol to which to add a new sequence.
3. Select the protocol icon in the left pane, or more than one communications

sequence in the right pane, or a free area in the right pane outside the
sequence list, with the right mouse button and select Create
Communications Sequence...

Use the following procedure to rename a sequence that has been registered.

Note Sequences belonging to “System” type protocols cannot be changed.

1, 2, 3... 1. Double-left-click on the appropriate Communication Sequence setting from
the associated protocol. Alternatively, select the Communication Sequence
setting and press Return or select the Communication Sequence setting
and select Field from the Edit menu. The current sequence name becomes
an editable field.

2. Type in a new name for the sequence and press Return or select Accept
from the Edit menu. It is possible to select a portion of the current sequence
name and overtype. The new sequence name may not exceed 30
characters.

Use the following procedure to edit the communications sequence number in a
sequence list.

1, 2, 3... 1. Display the sequence list.
2. Double-left-click on a # setting within the sequence. Alternatively, select the

# setting and press Return or select the # setting and select Field from the
Edit menu. The current sequence number becomes an editable field.

Create a New Sequence
in the List

Rename a Sequence in
the List

Edit a Sequence List
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3. Type in a new sequence number and press Return or select Accept from the
Edit menu. It is possible to select a portion of the current sequence number
and overtype. The new sequence number must not exceed the limit
expressed in the Seq Start and Seq End protocol settings. The new
sequence number must not be a sequence number currently in use.

Note It is not possible to directly edit a sequence belonging to a protocol of type
‘System’, unless it is copied to a protocol of type ‘User’.

Use the following procedure to copy a sequence.

1, 2, 3... 1. Select the icon of the sequence to be copied in the right pane. More than
one sequence can be selected by pressing Shift and selecting another
sequence to extend the selection, or by pressing Ctrl and selecting another
sequence to add to the selection.

2. Select the Copy button from the Toolbar or press Ctrl+C or press Alt+E
followed by C. Alternatively, select Copy from the right mouse button dialog
or select Copy from the Edit menu.

3. Select a protocol or display the sequence list in the right pane into which to
paste the copied sequence or sequences.

4. Select the Paste button from the Toolbar or press Ctrl+V or press Alt+E
followed by P. Alternatively, select Paste from the right mouse button dialog
or select Paste from the Edit menu. The pasted sequences are placed at the
end of the appropriate protocol and are given the next available sequence
numbers.

Use the following procedure to delete a sequence. Sequences within protocols
that are of type System cannot be deleted.

1, 2, 3... 1. Select the icon of the sequence to be deleted. More than one sequence can
be selected by pressing Shift and selecting another sequence to extend the
selection, or by pressing Ctrl and selecting another sequence to add to the
selection.

2. Select the Delete button from the toolbar or press Delete. Alternatively,
select Delete from the right mouse button dialog or select Delete from the
Edit menu or press Alt+E followed by D. Select the OK push-button from the
confirmation dialog to confirm deletion or the Cancel push-button to cancel
the deletion.

A sequence can also be deleted by selecting the Cut button from the Toolbar or
pressing Ctrl+X or press Alt+E followed by T. Alternatively, select Cut from the
right mouse button dialog or select Cut from the Edit menu. Select the Paste
button from the Toolbar or press Ctrl+V or press Alt+E followed by P to retrieve
the last delete action using the Cut operation. Alternatively, select Paste from
the right mouse button dialog or Paste from the Edit menu. The pasted
sequences are placed at the end of the appropriate sequence and are given the
next available sequence numbers.

Note 1. Once a sequence has been pasted, the referred message data within the
step is lost.

2. It is not possible to paste all the sequences if the number of sequences
exceeds the maximum of 60.

7-3-2 Set Sequence List Attributes
The settings that can be made for sequence list attributes using SYSMAC-PST
are shown in the following table.

Cut/Copy/Paste
Sequences in the List
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Attribute Content
Link Word Link 1 IN IN Area None, CIO, LR,

HR, AR, DM, EM.
Address
Length

OUT OUT Area None, CIO, LR,
HR, AR, DM, EM.

Address
Length

Link 2 IN IN Area None, CIO, LR,
HR, AR, DM, EM.

Address
Length

OUT OUT Area None, CIO, LR,
HR, AR, DM, EM.

Address
Length

Transmission
Control

RTS/CTS None, Send, Receive, Send & ReceiveTransmission
Control XON/XOFF None, Send, Receive, Send & Receive

Modem (see note 1)
Contention Send Request Code Code, ASCII, HEX
Delimiters Delimiter Send Code Code, ASCII, HEXDelimiters

Delimiter Receive Code Code, ASCII, HEX
Response
Type

Scan, Interrupt mode:
Fixed #, Interrupt
mode: Receive Matrix
Case #

Timer Tr Value 00 to 99Timer Tr

Timer Unit 0.01s, 0.1s, 1s, 1 min
Timer Tfr Value 00 to 99Timer Tfr

Timer Unit 0.01s, 0.1s, 1s, 1 min
Timer Tfs Value 00 to 99Timer Tfs

Timer Unit 0.01s, 0.1s, 1s, 1 min

Note 1. Default Setting

Specifies a data area which is shared between the PLC and the PSB. The
settings for Link Words are as follows.
• Word area in the PLC

This specifies the PLC area type to be used as link words.
• First link word

This specifies the first word of the link words.
• Total number of link words

This specifies the total number of link words.
The Area and Range settings depend upon the PLC selected. If no PLC is se-
lected, the values shown in the following table are used by default.

Area Range

CIO 000 to 511

LR 00 to 63

HR 00 to 99

AR 00 to 27

DM 0000 to 6655

EM 0000 to 6143

None Not used

Link Words for Data
Shared by the PSB and
PLC
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Caution Changing the PLC selection may force these settings to become invalid. Invalid
settings are not highlighted or checked at download.

Use the following procedure to set the link words for data shared by the PSB and
PLC.

1, 2, 3... 1. Double-left-click on a Link Word setting for a sequence. Alternatively, select
the Link Word setting and press Return or select Field from the Edit menu or
press Alt+E followed by F.

The Link Word Information dialog is displayed.

2. For link words required for received data, select the Area from the IN Area
drop-down list.

3. Select the effective address of the first word of the link words to receive data
in the IN Addr field.

4. Select the total number of words to be allocated from the first word that
stores the received data in the IN Len field. This value must be less than 128
bytes.

5. Repeat steps 2 to 4 for the OUT Area drop-down list, OUT Addr field and
OUT Len field for link words used for send data. The Len value must be less
than 128 bytes.

6. Repeat steps 2 to 5 if a second link word is required.
7. Select the OK push-button to accept the settings, or select the Cancel push-

button to leave the settings unchanged.

Five transmission control methods are available as indicated in the following
table. Set the same transmission control method as that specified by the
external device (communications partner).

Transmission Control
Method
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Transmission control Function

RTS/CTS flow control Controls data flow using signals called
RTS and CTS so that the data size does
not exceed the buffer size when a large
amount of data is transmitted.

Xon/Xoff flow control Controls data flow using the Xon code
(13H) and Xoff code (11H) so that the
data size does not exceed the buffer
size when a large amount of data is
transmitted.

Modem control (default setting) Used for handshaking with a modem.
This transmission control method is also
used for 1:N connection on a
RS422/485 transmission line.

Contention control Used to obtain the transmission right in
point to point contention
communications (SECS protocol, etc.).

Delimiter control Used to transmit a large amount of data
by delimiting the data into multiple
frames using a delimiter.

Use the following procedure to set the transmission control method for a se-
quence.

1, 2, 3... 1. Double-left-click on a Control setting for a sequence. Alternatively, select
the Control setting and press Return or select Field from the Edit menu or
press Alt+E followed by F.

2. The Transmission Control dialog is displayed.

Amend the transmission control settings as appropriate (these are discussed in
the following paragraphs).

3. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.
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RTS/CTS
Data can be transmitted through RTS/CTS flow control. Select a RTS/CTS
control method from the drop-down list.

If the RTS/CTS field is set to ‘None’, RTS/CTS flow control is not performed.

If the RTS/CTS field is set to ‘Send’, RTS/CTS flow control is performed only
when sending.

If the RTS/CTS field is set to ‘Receive’, RTS/CTS flow control is performed only
when receiving.

If the RTS/CTS field is set to ‘Send & Receive’, RTS/CTS flow control is per-
formed for both send and receive processing.

XON/XOFF
Data can be transmitted through Xon/Xoff flow control. Select an Xon/Xoff
control method from the drop-down list: None, Send, Receive and Send
& Receive are available.

If the XON/XOFF field is set to ‘None’, Xon/Xoff flow control is not performed.

If the XON/XOFF field is set to ‘Send’, Xon/Xoff flow control is performed only
when sending.

If the XON/XOFF field is set to ‘Receive’, Xon/Xoff flow control is performed only
when receiving.

If the XON/XOFF field is set to Send & Receive, Xon/Xoff flow control is per-
formed for both send and receive processing.

Modem
Data can be transmitted through modem control. Select the Modem check box
to either enable or disable modem control.

If the Modem check box is not set, modem control is not performed. If the Mo-
dem check box is set, modem control is performed.

Contention
Data can be transmitted under contention control. Select the Contention check
box to either enable or disable contention control.

If the Contention check box is not set, contention control is not performed.

If the Contention check box is set, contention control is performed. This means
that in order to obtain the right to send, a ‘send request code’ must be trans-
mitted.

A send request code can be sent as Code, ASCII or Hexadecimal. The send
request code can be selected from the drop-down list.
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[Code]
If the send request code is set to ‘Code’, a control code is used as the send
request code. Select the Edit... push-button to construct the control code.

The Input Control Code dialog is displayed. Select a push-button associated
with one of the special codes. Up to four special codes may be entered, these
appear at the top of the dialog. If a fifth special code is entered, the oldest entry is
lost. Any of the four codes can be directly amended by selecting the codes. This
inserts a cursor: the amended code is inserted at this point. Select the Clear
push-button to clear all special codes and start again. Select the Delete push-
button to delete the last special code entered. Select the OK push-button to ac-
cept the special codes entered or the Cancel push-button to leave the settings
unchanged.
Accepted codes are subsequently displayed in the Transmission Control dialog.
[ASCII]
If the send request code is set to ‘ASCII’, ASCII characters are used as the send
request code.

Type in ASCII characters (up to four characters) in the associated field to be sent
as the send request code and press Tab.
[HEX]
If the send request code is set to ‘HEX’, hexadecimal digits are used as the send
request code. Select the Edit... push-button to construct the HEX data.

The HEX Entry dialog is displayed. Select a push-button associated with one of
the Hexadecimal digits or press 0 to 9, A to F. Up to eight digits may be entered,
these appear at the top of the dialog. A zero is added to a Hex entry for an odd
number of digits entered. If the buffer is full, the values are shifted left and the
truncating indicator in the status bar is momentarily displayed. Any of the eight
digits can be directly amended by selecting the digits to insert a cursor. The next
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digit entered is inserted at this point. Select the Clear push-button to clear all
digits and start again. Select the Back push-button to delete the last digit en-
tered. Select the OK push-button to accept the digits entered or the Cancel
push-button to leave the settings unchanged.

Accepted codes are subsequently displayed in the Transmission Control dialog.

Delimiters
Data can be transmitted through delimiter control. Select the Delimiters check
box to either enable or disable delimiter control.

If the Delimiters check box is not set, delimiter control is not performed.
If the Delimiters check box is set, delimiter control is performed.

The delimiter set in the send and receive code can be specified as Code, ASCII
or Hexadecimal. These can be selected from the Delimiter Send Code and De-
limiter Receive Code drop-down lists.
[Code]
If a delimiter code is set to ‘Code’, a control code is used as the send request
code. Select the Edit... push-button to construct the code.

The Input Control Code dialog is displayed. Select a push-button associated
with one of the special codes. Up to four special codes may be entered, these
appear at the top of the dialog. If a fifth special code is entered, the oldest entry is
lost. Any of the four codes can be directly amended by selecting the codes. This
inserts a cursor. The amended code is inserted at this point. Select the Clear
push-button to clear all special codes and start again. Select the Delete push-
button to delete the last special code entered. Select the OK push-button to ac-
cept the special codes entered or the Cancel push-button to leave the settings
unchanged.
Accepted codes are subsequently displayed in the Transmission Control dialog.

[ASCII]
If a delimiter code is set to ‘ASCII’, ASCII characters are used as the code.
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Type in ASCII characters (up to four characters) in the associated field to be sent
as the delimiter code and press Tab.
[HEX]
If a delimiter code is set to ‘HEX’, hexadecimal digits are used as the code.
Select the Edit... push-button to construct the HEX data.

The HEX Entry dialog is displayed. Select a push-button associated with one of
the Hexadecimal digits or press 0 to 9, A to F. Up to eight digits may be entered,
these appear at the top of the dialog. A zero is added to a Hex entry for an odd
number of digits entered. If the buffer is full, the values are shifted left and the
truncating indicator in the status bar is momentarily displayed. Any of the eight
digits can be directly amended by selecting the digits to insert a cursor. The next
digit entered is inserted at this point. Select the Clear push-button to clear all
digits and start again. Select the Back push-button to delete the last digit en-
tered. Select the OK push-button to accept the digits entered or the Cancel
push-button to leave the settings unchanged.
Accepted codes are subsequently displayed in the Transmission Control dialog.

Use the following procedure to set the timing for writing data that was received
and the notification method of it to the PLC. This setting is valid only when the
write area is indicated in the third operand of the PMCR instruction and Yes is
specified for the setting of the With/Without response writing. The Notification
Types Scan, Interrupt mode: Fixed # and Interrupt mode: Receive Case # are
available.

1, 2, 3... 1. Double-left-click on a Response setting for a sequence. Alternatively, select
the Response setting and press Return or select Field from the Edit menu or
press Alt+E followed by F.

2. The Response Type dialog is displayed.

Select an option button: Scan mode, Interrupt mode: Fixed # or Interrupt mode:
Receive Case # option button. Additionally, if the Interrupt mode: Fixed # option
button is set, specify an interrupt program number between 0 and 255 in the
corresponding field.

Response Type
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Scan mode
The timing of writing received data in the memory area of the PLC depends on
the PLC scan (receive processing and write processing are performed
asynchronously).

Interrupt mode: Fixed #
An interrupt is issued for the PLC whenever data is received and immediately
written to the memory area. In this case, the executed interrupt program number
is a Fixed number (0 to 255).

Interrupt mode: Receive Case #
An interrupt is issued for the PLC whenever data is received and received data is
immediately written to the memory area. In this case, the executed interrupt
program number (0 to 255) is automatically calculated according to the
execution state of the PSB.

The interrupt program number is calculated as follows:
Upper digit (HEX): Step No. of executed sequence
Lower digit (HEX): Step No. of executed receive matrix

Example: Interrupt number is 2B (HEX) = 43 (dec)
when receive matrix case 11 (0BH) is executed for step 2 (02H)

Lower digit is 0 when receive matrix is not used.

By creating an interrupt program according to the calculation expression de-
scribed above, the related interrupt program can be executed according to the
execution state of the PSB.

3. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

The following procedure can be used to set monitor times for transmission
processing. Four units of time can be enabled and the precision is 1 ms
maximum. When the time exceeds the monitor time, the retry process and error
process for each step is performed.

Monitor Time Ranges
The following table lists the units and ranges of monitor times that can be set.

Time Unit Value

0.01 s (10 ms) 00 to 99

0.1 s (100 ms) 00 to 99

1 s 00 to 99

1 min 00 to 99

The following table lists the items that can be set for monitoring.

Type Contents

Receive wait time: Tr Monitors the time until the first byte
(start character) is received after the
receive command of the step is
recognised.

Receive finish time: Tfr Monitors the time from reception of the
first byte (start character) to reception of
the last byte of the data (end character).

Send finish time: Tfs Monitors from transmission of the first
byte (start character) to transmission of
the last byte of the data (end character).

Monitor Times for
Message Processing

Contents Monitored
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Monitor Time Timing Chart
The monitor time timing chart for each send and receive process is shown
below:

1, 2, 3... 1. Double-left-click on a timing setting for a sequence, either Timer Tr, Timer
Tfr or Timer Tfs. Alternatively, select the timing setting and press Return or
select Field from the Edit menu or press Alt+E followed by F.

2. The dialog for the appropriate timing setting is displayed.

For receive wait time, Tr, set in the Value field a monitor time (0 to 99) from
recognition of a receive command to reception of the first byte of data (start
character).

For receive finish time, Tfr, set in the Value field a monitor time (0 to 99) from
reception of the first byte of the data (start character) to the last byte of the
data (end character).
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For send finish time, Tfs, set in the Value field a monitor time (0 to 99) from
the transmission of the first byte of the data (start character) to the last byte
of the data (end character).

3. Set a time unit in the Time Unit field.
4. Select the OK push-button to accept the settings, or the Cancel push-button

to leave the settings unchanged.

Note Send Wait Time (Ts) is defined in a step, refer to Section 7-3-4 Edit a Step.

7-3-3 Edit Step List
Use the following procedure to display the steps within a sequence list.

1, 2, 3... 1. Double-left-click on the protocol icon to show all sequences within the
protocol. Alternatively, select the protocol in the left pane.

2. Double-left-click on a sequences icon button to show all steps within a
sequence. Alternatively, select the sequence in the left pane.

Use the following procedure to create a new step in the sequence.

1, 2, 3... 1. Select the protocol icon.
2. Select the sequence to which to add a new step.
3. Select the sequence icon in the left pane, or more than one step in the right

pane, or a free area outside the step list in the right pane, with the right
mouse button and select Create Step....

The order of the steps can be changed by moving a selected step. Use the
following buttons to change the order of the steps.

Note Step lists belonging to “System” type protocol cannot be changed.

Select a step and use the Up button on the toolbar to move the step up one.
Select a step and use the Down button on the toolbar to move the step down
one.
Select a step and use the Top button on the toolbar to move the step as the first
step.
Select a step and use the Bottom button on the toolbar to move the step as the
last step.

Note It is possible to move a step by selecting the step and dragging it to the position to
which the step is to be moved.

Display the Step List

Create a New Step in the
Step List

Edit the Step List
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Use the following procedure to delete a step.

Note Steps within “System” type protocols cannot be deleted.

1, 2, 3... 1. Select the icon of the step to be deleted. More than one step can be selected
by pressing Shift and selecting another step to extend the selection, or by
pressing Ctrl and selecting another step to add to the selection.

2. Select the Delete button from the toolbar or press Delete. Alternatively,
select Delete from the right mouse button dialog or select Delete from the
Edit menu or press Alt+E followed by D. Select the OK push-button from the
confirmation dialog to confirm deletion or the Cancel push-button to cancel
the deletion.

A step can also be deleted by selecting the Cut button from the Toolbar or
pressing Ctrl+X or press Alt+E followed by T. Alternatively, select Cut from the
right mouse button dialog or Cut from the Edit menu. Select the Paste button
from the Toolbar or press Ctrl+V or press Alt+E followed by P to retrieve the last
delete action using the Cut operation. Alternatively, select Paste from the right
mouse button dialog or Paste from the Edit menu. The pasted steps are placed
at the end of the appropriate sequence and are given the next available step
numbers.
Ensure that another Copy or Cut operation does not take place during this
procedure as this erases the current copy operation.
Use the following procedure to copy and paste a step.

1, 2, 3... 1. Select the icon of the step to be copied. More than one step can be selected
by pressing Shift and selecting another step to extend the selection, or by
pressing Ctrl and selecting another step to add to the selection.

2. Select the Copy button from the Toolbar or press Ctrl+C or press Alt+E
followed by C. Alternatively, select Copy from the right mouse button dialog
or select Copy from the Edit menu.

3. Select a sequence or display the step list in the right pane into which to paste
the copied Step or Steps.

4. Select the Paste button from the Toolbar or press Ctrl+V or press Alt+E
followed by P. Alternatively, select Paste from the right mouse button dialog
or Paste from the Edit menu. The pasted steps are placed at the end of the
appropriate sequence and are given the next available step numbers.

Note 1. Once a step has been pasted, the referred message data within the step is
lost.

2. It is not possible to paste all the steps if the number of steps exceeds the
maximum of 16.

7-3-4 Edit a Step
The settings that can be made for step attributes using SYSMAC-PST are
shown in the following table.

Delete/Cut/Copy/Paste
Steps in the Step List



7-3SectionEdit a Protocol

167

Attribute Content
Repeat Type Reset / Hold (Reserve)Repeat

Counter Constant (1 to 255)Counter

Channel
Command Send, Receive, Send & Receive

Retry 0 to 9

Send Wait Value 00 to 99

Time Unit 0.01s, 0.1s, 1s, 1 min

Send Message Refer to Section 8, Editing Send & Receive Messages
and Receive Matrices

Receive Message Refer to Section 8, Editing Send & Receive Messages
and Receive Matrices

Response Yes, No

Next End, Next, Goto, Abort

Error End, Next, Goto, Abort

Set the number of times the step is to be repeated. The count can be set by
entering a constant (1 to 255) or by specifying the address of a word, the content
of which is the count (without conversion). When a constant is set in the repeat
counter, the value of counter N will be incremented whenever the step is
executed. The Repeat Types of Reset, Hold (Reserve) are available. The
Counter of Constant (1 to 255) or Channel are available.

1, 2, 3... 1. Double-left-click on a Repeat setting for a step. Alternatively, select the
Repeat setting and press Return or select Field from the Edit menu or press
Alt+E followed by F.

2. The Repeat Counter Information dialog is displayed.

Select a repeat type from the Type drop-down list.

If the ‘Reset’ option is selected, the step is executed the specified number of
times after the value of counter N is initialized to 0.

If the ‘Hold (Reserve)’ option is selected, the step is executed the specified num-
ber of times while retaining the current value of counter N.

3. To specify a repeat counter, select the Constant option button and enter the
number of times (1 to 255) the step is to be repeated in the Constant field.

To specify a word address, select the Channel option button and select the
Edit... push-button to construct the word address.

Message Repeat Counter
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The Channel dialog is displayed.

Note The maximum number of EM banks that can be specified in the EM Bank # field
is dependent on the PLC selected.

Amend the settings as necessary, described following, and select the OK push-
button to accept the settings from the Channel dialog, or the Cancel push-button
to leave the settings unchanged.

4. Select the OK push-button to accept the settings from the Repeat Counter
Information dialog, or the Cancel push-button leave the settings
unchanged.

When specifying a word address, the address types that can be selected from
the Address drop-down list are ‘Channel’, ‘I1’, ‘I2’, ‘O1’, ‘O2’ or ‘Operand’. If
Channel is selected as the Address Type, a setting in the Area drop-down list
and a value for the Channel # field are required.
For a Send Message, the Area and Channel # settings should correspond to the
area specified in the second operand of the PMCR instruction and the effective
address of the first word.
For a Receive Message, the Area and Channel # settings should correspond to
the area specified in the third operand of the PMCR instruction and the effective
address of the first word.
The parameters for the Primary Expression (yN+x) fields define the channel off-
set.

Set one of the following three transmission commands for execution in a step.
Send
The send messages set in the step are sent.
Receive
The receive messages that were set in the step, or messages that were sent
based on the receive matrix, are received.
Send & Receive
After the send messages that were set in the step are sent, the receive
messages that are set in the step and the messages that were sent based on the
receive matrix are received.

Command
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The following table lists the items that can be set for each command.

Setting item CommandSetting item

Send Receive Send &
Receive

Sequence Link words Yes Yes YesSequence

Receive wait time: Tr --- Yes Yes
Receive finish time:
Tfr

--- Yes Yes

Send finish time: Tfs Yes --- Yes
Response Type --- Yes Yes
Transmission control Yes Yes Yes

Step Repeat counter Yes Yes YesStep

Retry count No No Yes
Send wait time Yes No Yes
Send messages Yes No Yes
Receive messages No Yes Yes
With/Without
Response Writing

Yes Yes Yes

Next process No. Yes Yes Yes
Error process No. Yes Yes Yes

1, 2, 3... 1. Double-left-click on a Command setting for a step. Alternatively, select the
Command setting and press Return or select the Command setting and
select Field from the Edit menu or press Alt+E followed by F.

2. Select the appropriate transmission command from the drop-down list and
press Return or select Accept from the Edit menu or press Alt+E followed by
A.

A retry count is valid only when Send & Receive is set for the transmission
commands. When a retry occurs, the current step is re-executed. When the
step is executed for the specified number of retries, control is passed to the error
process if a retry occurs again.

0 to 9 (when 0 is specified, no retries are executed).

Retry factors
• The send finish time has been reached.

• The receive wait time has been reached.

• The receive finish time has been reached.

• A transmission error occurred during receive processing (a factor that turned
CIO28304 or CIO28312 ON).

• A message, excepting the message set in receive messages, is received.

• An error occurred in the Error Check code.

Note For retries, send processing is executed regardless of the wait time.

Retry Count

Allowed retry counts
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1, 2, 3... 1. Double-left-click on a Retry setting for a step. Alternatively, select a Retry
setting for a step and press Return or select the Retry setting and select
Field from the Edit menu or press Alt+E followed by F.

2. Enter the number of retries (0 to 9) and press Return or select Accept from
the Edit menu or press Alt+E followed by A.

If an illegal number is entered, the original number of retries is displayed
once the count has been set.

Set the time to be waited until a send message is sent for send processing. The
counting of a wait time starts from the following point and the accuracy is 10 ms
maximum.

• Send or Send & Receive of the step is recognized.

• The entire processing has completed when repetition is specified for the step.

The send wait time setting range is from 0 to 99 (0: no wait). The setting unit can
be selected from the following four types.

Time Unit Value

0.01 s (10 ms) 00 to 99

0.1 s (100 ms) 00 to 99

1 s 00 to 99

1 min 00 to 99

1, 2, 3... 1. Double-left-click on a Send Wait setting for a step. Alternatively, select the
Send Wait setting for a step and press Return or select Field from the Edit
menu or press Alt+E followed by F.

2. The Send Wait Time (Ts) dialog is displayed.

Set a time value in the Value field.

3. Set a time unit in the Time Unit field.

4. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

Select a Message from the Send Message List

Use the following procedure to select a send message reference for a step. This
setting is only valid for a step whose command is Send or Send & Receive.

Send Wait Time: Ts

Send Message
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1, 2, 3... 1. Double-left-click on a Send Message setting for a step. Alternatively, select
the Send Message setting and press Return or select Field from the Edit
menu or press Alt+E followed by F.

2. Select a send message reference from the drop-down list and press Return
or select Accept from the Edit menu or press Alt+E followed by A.

The send message references are taken from the send message list, located
after the sequences in a protocol. Use the procedures described in the following
paragraphs for amending send messages in the context of a step. Refer to Sec-
tion 8 Editing Send & Receive Messages and Receive Matrices for further in-
formation.

Use the following procedure to create a new send message.

1, 2, 3... 1. Double-left-click on a Send Message setting for a step. Alternatively, select
the Send Message setting and press Return or select Field from the Edit
menu or press Alt+E followed by F.

2. Select the New... option from the drop-down list and press Return or select
Accept from the Edit menu or press Alt+E followed by A.

3. The Message Data dialog is displayed. Type in a message name in the
Message Name field.

4. Create the message as appropriate. Refer to Section 8 Editing Send &
Receive Message and Receive Matrices for details on how to construct a
message.

5. Click the OK push-button to accept the settings. Click the Cancel
push-button to leave the settings unchanged.

Use the following procedure to edit a message from the send message list.

1, 2, 3... 1. Double-left-click on a Send Message setting for a step. Alternatively, select
the Send Message setting and press Return or select Field from the Edit
menu or press Alt+E followed by F.

2. Select the send message from the drop-down list.
3. Select Accept from the Edit menu or press return, or press Alt+E followed by

A.
4. The Edit....item in the drop-down list includes the name of the selected mes-

sage.
5. Select Edit....followed by the message name from the drop-down list and

press Return or select Accept from the Edit menu or press Alt+E followed by
A.

6. The Message Data dialog is displayed. Edit the message as appropriate.
Refer to Section 8 Editing Send & Receive Message and Receive Matrices
for details on how to construct a message.

Create a New Send
Message

Edit an Existing Send
Message
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7. Click the OK push-button to accept the settings. Click the Cancel
push-button to leave the settings unchanged.

Select a Message or Matrix from the Receive Message List
Use the following procedure to select a receive message reference for a step.
This setting is only valid for a step whose command is Receive or Send &
Receive.

1, 2, 3... 1. Double-left-click on a Receive Message setting for a step. Alternatively,
select the Receive Message setting and press Return or select Field from
the Edit menu or press Alt+E followed by F.

2. Select a receive message reference from the drop-down list and press
Return or select Accept from the Edit menu. A receive matrix can also be
selected from this drop-down list.

The receive message or receive matrix references are respectively taken from
the receive message list or receive matrix list, located after the sequences in a
protocol. Use the procedures described in the following paragraphs for amend-
ing receive messages in the context of a step. Refer to Section 8 Editing Send &
Receive Messages and Receive Matrices for further information.

Note It is not possible to create a new receive matrix from the reference.

Use the following procedure to create a new receive message.

1, 2, 3... 1. Double-left-click on a Receive Message setting for a step. Alternatively,
select the Receive Message setting and press Return or select Field from
the Edit menu or press Alt+E followed by F.

2. Select the New... option from the drop-down list and press Return or select
Accept from the Edit menu or press Alt+E followed by A.

3. The Message Data dialog is displayed. Type in a message name in the
Message Name field.

4. Create the message as appropriate. Refer to Section 8 Editing Send &
Receive Message and Receive Matrices for details on how to construct a
message.

5. Click the OK push-button to accept the settings. Click the Cancel
push-button to leave the settings unchanged.

Use the following procedure to edit an existing receive message or receive
matrix.

1, 2, 3... 1. Double-left-click on a Receive Message setting for a step. Alternatively,
select the Receive Message setting and press Return or select Field from
the Edit menu or press Alt+E followed by F.

2. Select the receive message from the drop-down list.

Receive
Message/Receive Matrix

Create a New Receive
Message

Edit a Receive Message
or Receive Matrix
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3. Select Accept from the Edit menu and press Return, or press Alt+E followed
by A

4. The Edit....item in the drop-down list includes the name of the selected mes-
sage.

5. Select Edit....followed by the message name from the drop-down list and
press Return or select Accept from the Edit menu or press Alt+E followed by
A.

6. The Message Data dialog is displayed. Edit the message as appropriate.
Refer to Section 8 Editing Send & Receive Message and Receive Matrices
for details on how to construct a message.

7. Click the OK push-button to accept the settings. Click the Cancel
push-button to leave the settings unchanged.

Use the following procedure to create a new receive matrix.

1, 2, 3... 1. Select the protocol icon in the right pane or a free area in the right pane with
the right mouse button, outside the sequence list, Send Message list,
Receive Message list or matrix list, and select Create Matrix. Alternatively,
select the matrix list or more than one sequence in the right pane and select
Create Matrix from the right mouse button menu.

Set whether received data are to be stored in PLC memory. This setting is valid
only when received data are stored by the third operand of the PMCR
instruction.
• Response: Yes. Received data is stored in PLC memory. A Response Type

must be set in the sequence list attributes.
• Response: No. Received data is Read-only (not stored in memory).

1, 2, 3... 1. Double-left-click on a With/Without Response Writing setting for a step.
Alternatively, select the Response setting and press Return or select Field
from the Edit menu or press Alt+E followed by F.

2. Select either ‘Yes’ or ‘No’ from the drop-down list and press Return or select
Accept from the Edit menu or press Alt+E followed by A.

Use the following procedure to set the next transit step.
If a receive matrix is set for the receive message, control is passed to the next
step based on the next process set in the receive matrix.
The following four types of contents can be set.

Next process Processing details

End When this step is terminated, the
sequence is terminated.

Next When this step is terminated, the next
step is executed.

Goto ** When this step is terminated, control is
passed to the step number specified
in **.

Abort When this step is terminated, the step is
aborted and the sequence is terminated.

Note If the position of a case with a Goto # instruction is changed or the position of a
case referenced by a Goto # instruction is changed, the corresponding Goto
number is automatically updated.

Create a New Receive
Matrix

With/Without Response
Writing Required

Next Process
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1, 2, 3... 1. Double-left-click on a Next setting for a step. Alternatively, select the Next
setting and press Return or select Field from the Edit menu or press Alt+E
followed by F.

2. The Next Process dialog is displayed.

Select the next process from the Jump option buttons. In the event of ‘Goto’
being selected, enter a case number in the corresponding field. The Next
option cannot be selected for the last step.

3. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

Use the following procedure to set the next transit step when the step is
terminated abnormally. When a step is terminated normally, control is passed to
the next step based on the specification of the next process.

If a receive matrix is also set in a receive message, control is passed to the next
step based on the setting in the error process for error termination.

The following four types of contents can be set.

Error process Processing details

End When this step is abnormally
terminated, the sequence is terminated.

Next When this step is abnormally
terminated, the next step is executed.

Goto ** When this step is abnormally
terminated, control is passed to the step
number specified in **.

Abort When this step is abnormally
terminated, the step is aborted and the
sequence is terminated.

Note If the position of a case with a Goto # instruction is changed, or the position of a
case referenced by a Goto # instruction is changed, the corresponding Goto
number is automatically updated.

1, 2, 3... 1. Double-left-click on an Error setting for a step. Alternatively, select the Error
setting and press Return or select Field from the Edit menu, or press Alt+E
followed by F.

Error Process
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2. The Error Process dialog is displayed.

Select the next process from the Jump option buttons. In the event of ‘Goto’
being selected, enter a case number in the corresponding field. The Next option
cannot be selected for the last step.

3. Select the OK push-button to accept the settings, or the Cancel push-button
to abort the operation.
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SECTION 8
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8-1 Edit a Message

8-1-1 Display a Message
Use the following procedure to display a message within the message list.

1, 2, 3... 1. Double-left-click on the protocol list to show all protocols.

2. Double-left-click on the protocol containing the send and receive message
lists, located after the sequences.

3. Double-left-click on the send message list icon or receive message list icon
to display all messages in the right pane.

Each setting associated with a message can be edited. The Copy and Paste
operations can be used to set the same settings of one of the messages already
in existence, or to set similar settings of one of the messages already in
existence. Refer to Section 8-2-3 Cut/Copy/Paste Messages in a Message List
for further information.

8-1-2 Amend a Message
The settings that can be made for messages using SYSMAC-PST are shown in
the following table.

Attribute Content
Header <h> Type None, Code, ASCII, HEXHeader <h>

Data
Terminator <t> Type None, Code, ASCII, HEXTerminator <t>

Data
Check Code <c> Type None, LRC, CRC-CCITT, CRC-16, SUM (1 byte), SUM (2 bytes),

SUM2 (1 byte), SUM2 (2 bytes)
Default 0 to 255 if Type is LRC, SUM (1 byte), SUM2 (1 byte)

0 to 65535 if Type is SUM (2 bytes), SUM2 (2 bytes) or CRC-16. Not
applicable for CRC-CCITT.

Conversion Reverse OrderConversion

Data Type: BIN, ASCII
Length <l> Type None, 1 byte, 2 bytesLength <l>

Default 0 to 255 if Type is 1 byte; 0 to 65535 if Type is 2 bytes
Conversion BIN, ASCII

Address <a> Type None, Constant, ASCII, Constant HEX, Variable, Variable ASCII, Variable
HEX, Variable (Reverse), Variable ASCII (Reverse), Variable HEX (Reverse)

Data
Data Message Part

Use the following procedure to set the Header (data that indicates the beginning
of the message). Data types ASCII, HEX and Code are available.

1, 2, 3... 1. Double-left-click on a Header <h> setting for a message. Alternatively,
select the Header <h> setting and press Return or select Field from the Edit
menu or press Alt+E followed by F.

Header <h>
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2. The Message Header <h> dialog is displayed.

Select a header type in the Type drop-down list (refer to Code, ASCII and
HEX following) and set Data field.

3. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

None
If ‘None’ is selected in the Type drop-down list, no data is set to a header.

Code
If ‘CODE’ is selected in the Type drop-down list, a special code can be assigned
to the header by selecting the Edit... push-button.

The Input Control Code dialog is displayed. Select a push-button associated
with one of the special codes. Up to four special codes may be entered, these
appear at the top of the dialog. If a fifth special code is entered, the oldest entry is
lost. Any of the four codes can be directly amended by selecting the codes. this
inserts a cursor. The amended code is inserted at this point. Select the Clear
push-button to clear all special codes and start again. Select the Delete push-
button to delete the last special code entered. Select the OK push-button to ac-
cept the special codes entered or the Cancel push-button to leave the settings
unchanged.

Accepted codes entered are subsequently displayed in the Data field within the
Message Header <h> dialog.

ASCII
If ‘ASCII’ is selected in the Type drop-down list, an ASCII character can be
assigned to the header. Type in ASCII characters (up to four characters) in the
Data field and press Tab.
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HEX
If ‘HEX’ is selected in the Type drop-down list, hexadecimal data can be
assigned to the header by selecting the Edit... push-button.

The HEX Entry dialog is displayed. Select a push-button associated with one of
the Hexadecimal digits or press 0 to 9, A to F. Up to eight digits may be entered,
these appear in the field at the top of the dialog. A zero is added to a Hex entry for
an odd number of digits entered. If the buffer is full, the values are shifted left and
the truncating indicator in the status bar is momentarily displayed. Any of the
eight digits can be directly amended by selecting the digits to insert a cursor. The
next digit entered is inserted at this point. Select the Clear push-button to clear
all digits and start again. Select the Back push-button to delete the last digit en-
tered. Select the OK push-button to accept the digits entered or the Cancel
push-button to leave the settings unchanged.

Accepted codes entered are subsequently displayed in the Data field within the
Message Header <h> dialog.

Use the following procedure to set the Terminator (data that indicates the end of
the message). The Data types Code, ASCII and HEX are available.

1, 2, 3... 1. Double-left-click on a Terminator <t> setting for a message. Alternatively,
select the Terminator <t> setting and press Return or select Field from the
Edit menu, or press Alt+E followed by F.

2. The Message Terminator <t> dialog is displayed.

Select a terminator type in the Type drop-down list and set Data field. (these
are discussed in the Header <h> paragraphs previously).

3. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

Use the following procedure to specify an error check code calculation method.
The Check Code types LRC, CRC-CCITT, CRC-16, SUM (1 byte), SUM (2
bytes), SUM2 (1 byte), SUM2 (2 bytes), are available.

Terminator <t>

Check Code <c>
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1, 2, 3... 1. Double-left-click on a Check code <c> setting for a message. Alternatively,
select the Check Code <c> setting and press Return or select Field from the
Edit menu, or press Alt+E followed byF.

2. The Error Check Code <c> dialog is displayed.

Select a check code type in the Type drop-down list. For all types except
‘CRC-CCITT’ the Default fields become active. For all types except ‘None’,
the Data Type options become active.

3. For types ‘LRC’, ‘CRC-16’, ‘SUM (1 byte)’, ‘SUM (2 byte)’, ‘SUM2 (1 byte)’
and SUM2 (2 bytes), enter the Default number of words for the check code
calculation range. For ‘LRC’, ‘SUM (1 byte)’ and ‘SUM2 (1 byte)’ the range is
0 to 255. For ‘SUM (2 byte)’ and ‘SUM2 (2 byte)’, ‘CRC-16’ the range is 0 to
65535.

4. For all types other than ‘None’, select the BIN conversion type or ASCII
conversion type. For ‘LRC’, ‘SUM (1 byte)’ and ‘SUM2 (1 byte)’, BIN refers
to a binary data type (1 word) and ASCII refers to an ASCII data type (2
words). For ‘CRC-CCITT’, ‘CRC-16’, ‘SUM (2 byte)’ and ‘SUM2 (2 byte)’,
BIN refers to a binary data type (2 words) and ASCII refers to an ASCII data
type (4 words).

5. Select the Reverse Order check box to set the reverse check code. This
check box is not applicable if the Type setting is ‘LRC’, ‘SUM (1 byte)’,
‘SUM2 (1 byte)’ and the Data Type setting is set to BIN.

6. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

Use the following procedure to set the Length (the number of bytes of the
message). The data length is the length following the Length <l> setting in a
frame and is calculated automatically at send processing. The Length <l> data
is added when sending. The Length types 1 byte or 2 bytes are available. The
Conversion types BIN and ASCII are available.

1, 2, 3... 1. Double-left-click on a Length <l> setting for a message. Alternatively, select
the Length <l> setting and press Return or select Field from the Edit menu,
or press Alt+E followed by F.

Length <l>
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2. The Message Length <l> dialog is displayed.

Select a length type in the Type drop-down list. For ‘1 Byte’, the data size of
the length is set to one word. For ‘2 Bytes’, the data size of the length is set to
two words.

3. Enter the length in the Default field. The range is 0 to 255 for ‘1 Byte’ or 0 to
65535 for ‘2 Bytes’.

4. Select the BIN conversion type or ASCII conversion type.
5. Select the OK push-button to accept the settings, or the Cancel push-button

to leave the settings unchanged.

Use the following procedure to set the effective address (unit number or other
information to be used as the message destination). The effective Address
types ‘None’, ‘Constant ASCII’, ‘Constant HEX’, ‘Variable’, ‘Variable ASCII’,
‘Variable HEX’, ‘Variable (Reverse)’, ‘Variable ASCII (Reverse)’ and ‘Variable
HEX (Reverse)’ are available.

1, 2, 3... 1. Double-left-click on an Address <a> setting for a message. Alternatively,
select the Address <a> setting and press Return or select Field from the Edit
menu or press Alt+E followed by F.

2. The Message Address <a> dialog is displayed.

Select an effective address type in the Type drop-down list.
3. For the ‘Constant ASCII’ type, enter up to four ASCII characters

For the ‘Constant HEX’ type, select the Edit HEX... push-button to enter
HEX values into the Data field (the Edit HEX... push-button appears in place
of the Edit Variable... push-button and Edit Length... push-button).

Address <a>
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The HEX Entry dialog is displayed. Select a push-button associated with
one of the Hexadecimal digits or press 0 to 9, A to F. Up to eight digits may be
entered, these appear at the top of the dialog. A zero is added to a Hex entry
for an odd number of digits entered. If the buffer is full, the values are shifted
left and the truncating indicator in the status bar is momentarily displayed.
Any of the eight digits can be directly amended by selecting the digits to
insert a cursor. The next digit entered is inserted at this point. Select the
Clear push-button to clear all digits and start again. Select the Back
push-button to delete the last digit entered. Select the OK push-button to
accept the digits entered or the Cancel push-button to leave the settings
unchanged.
For the ‘Variable’ types, compose a data size using the Edit Variable...
push-button and Edit Length... push-button. The Channel dialog is
displayed.
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Setting of Variables

X, Y

Top address

Data

+

Linear expres-
sion including N

Note Area code for word designation
CIO: I/O relay, internal auxiliary relay, and special auxiliary relay
LR: Link relay
HR: Holding relay
AR: Auxiliary memory relay
DM: Data memory

Editing data size (Y)
Type: R ( )
Type: yN+x
Type: *

Editing effective address (X)

(Word unit)
Type: R ( ), W ( )

Address:

Type: yN+x
Designate y and x
y=0 to 255
x=0 to 255

Type: *

Example
Direct designation: R (CIO 0000+N+1)
Link word designation: R (I1+2N+1)

(Byte unit)

yN+x

Designate y and x
y=0 to 255
x=0 to 255

When selecting
words: Designate
the area (CIO, LR,
HR, AR, DM, EM)
(see note) and the
word.

No designation
when I1, I2, O1, or
O2 is selected.

No designation
when an operand is
selected.

Setting [Channel] Dialog Box

a) Select Read R ( ) or yN+x in the [Type] field.

b) Select an effective address type (“Channel”, ”I1”, ”I2”, ”O1”, ”O2”, or
”Operand”) from the [Address] drop-down list in the [Data (D)] field. If
“Channel” is selected, select an area code (CIO, LR, HR, AR, DM or
EMxx) from the [Area] drop-down list. Set a value in the [Channel #] field.

c) Designate an offset from the top word (designated in the above [Data]
field) in the [Primary Expression (yN+x)] field. Input y and x.

d) Press the [OK] button to confirm the [Channel] dialog box or [Cancel] but-
ton to cancel the process.

Note If the [EMxx] option is selected from the [Area] drop-down list, be sure to input
the bank number (0 to F) in the [EM Bank #] field. The maximum number of the
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EM bank that can be designated in the [EM Bank #] field depends on the se-
lected PC.

Address Setting Examples

Variable $(R(1), 2) Effective Address (X): R (1)

Data size (Y): 2

4. Press the [OK] button to confirm the setting or [Cancel] button to cancel the
process.

Note The maximum number of EM banks that can be specified in the EM Bank # field
is dependant on the PLC selected.

Amend the settings as necessary, described following, and select the OK
push-button to accept the settings from the Channel dialog, or the Cancel
push-button to leave the settings unchanged.

5. Select the OK push-button to accept the settings from the Message Address
<a> dialog, or the Cancel push-button to leave the settings unchanged.

When specifying a word address, the address types that can be selected from
the Address drop-down list are ‘Channel’, ‘I1’, ‘I2’, ‘O1’, ‘O2’ or ‘Operand’. If
Channel is selected as the Address Type, a setting in the Area drop-down list
and a value for the Channel# field are required.

For a Send Message, the Area and Channel# settings should correspond to the
area specified in the second operand of the PMCR instruction and the effective
address of the first word.

For a Receive Message, the Area and Channel# settings should correspond to
the area specified in the third operand of the PMCR instruction and the effective
address of the first word.

The parameters for the Primary Expression (yN+x) fields define the channel off-
set.

Use the following procedure while editing a Send Message.
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1, 2, 3... 1. Select the variable type from the Type options. If the Read R () option is se-
lected, specify an address type from the ADDRESS drop-down list. Area
setting and Channel# setting.

2. Enter the y and x parameters in the Primary Expression (yN+x) fields. If the
Read R() option is selected, the permitted ranges are as follows:
If the ‘Operand’ address type is selected, the y parameter must not exceed
128. If the y parameter is 0, the x parameter must not exceed 128. If the y
parameter is greater than 0. the x parameter must not exceed 127.
If one of the other address types is selected, the x and y parameters must not
exceed 127.
If the yN+x option is selected, the x and y parameters must not exceed 255.

Use the following procedure while editing a Receive Message.

1, 2, 3... 1. Select the variable type from the Type options. If the Read R () option or the
Write W () option is selected, specify an address type from the Address
drop-down list. Area setting and Channel# setting.

2. Enter the y and x parameters in the Primary Expression (yN+x) fields. If the
Read R () option or the Write W () option is selected, the permitted ranges
are as follows:
If the ‘Operand’ address type is selected, the y parameter must not exceed
128. If the y parameter is 0, the x parameter must not exceed 128. If the y
parameter is greater than 0, the x parameter must not exceed 127.
If one of the other address types is selected, the x and y parameters must not
exceed 127.
If the yN+x option is selected, the x and y parameters must not exceed 255.

Use the following procedure to set the message.

1, 2, 3... 1. Double-left-click on a Data setting for a message. Alternatively, select the
Data setting and press Return and select Field from the Edit menu, or press
Alt+E followed by F.

2. The Message Data dialog is displayed.

The Message data dialog allows the composition of a message to be edited.
Insert a message name in the Message Name field.

Data
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3. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.

The Data settings are color coded: message data associated with a Check Code
is displayed in blue, message data associated with a Length is displayed in red,
message data associated with both Check Code and Length is displayed in ma-
genta.

The Insert toolbar provides the following operations to be included in the mes-
sage.

The Header <h> button inserts the header setting into the message via the
Message Header <h> dialog described previously. The header is automatically
placed at the top of the list. If a header already exists in the message, it is not
possible to select this button.

The Terminator <t> button inserts the terminator setting into the message via
the Message Terminator <t> dialog described previously. The terminator is
automatically placed at the bottom of the list. If a terminator already exists in the
message, it is not possible to select this button.

The Check Code <c> button inserts the check code setting into the message via
the Message Check Code <c> dialog described previously. If a check code is
entered after the terminator, the check code is placed at the bottom of the list. If a
check code already exists in the message, it is not possible to select this button.

The Length <l> button inserts the length setting into the message via the
Message Length <l> dialog described previously. If a length already exists in the
message, it is not possible to select this button.

The Address <a> button inserts the effective address setting into the message
via the Message Address <a> dialog described previously. If an effective
address already exists in the message, it is not possible to select this button.

The Control Code button allows a special code to be inserted into the message
via the Input Control Code dialog, described previously.

The HEX button allows hexadecimal characters to be inserted into the message
via the HEX Entry dialog, described previously.

The ASCII button allows ASCII characters to be inserted into the message via
the ASCII Entry dialog.

Insert valid ASCII characters into the field. Select the OK push-button to accept
the characters, or the Cancel push-button to abort the operation.

The Message Variable button allows a message address to be inserted into the
message via the Message Variable dialog.

Use the following procedure to set the message variable. The message variable
types ‘Variable’, ‘Variable ASCII’, ‘Variable HEX’, ‘Variable (Reverse)’, ‘Variable
ASCII (Reverse)’ and ‘Variable HEX (Reverse)’ are available.
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1, 2, 3... 1. Left-click the Message Variable button to display the Message Variable dia-
log.

2. Select a Variable Type in the Type drop-down list.
3. Compose a data size using the Edit Variable push-button and Edit Length

push-button.
4. Edit the settings in the Channel dialog, as described previously for editing

the Message Address <a>.
5. Select the OK push-button to accept the settings in the Message Variable

dialog, or select the Cancel push-button to close the dialog without saving
the changes.

Note If an insertion is made in the Message Data dialog when a message part has
already been selected, the insertion is placed before the selection.

Provided either a check code or length has been specified in the message, a
check code or length can be associated to a message entry by selecting a
message entry and clicking on the Check Code push-button or the Length
push-button. A check code or length can be applied to a range of message
entries by pressing Shift and selecting another message entry to extend the
selection. Only items that appear above the Check Code in the list can be
assigned the Check Code. Only items that appear below the Length in the list
can be assigned the Length. Message entries that have a Check Code or Length
specified are displayed with a ‘*’ in the appropriate column in the dialog, <c> or
<l>.
To delete a message entry, select the message entry and click on the Delete
push-button.
To complete, select the OK push-button to accept the message data, or the Can-
cel push-button to leave the message data unchanged.

Note Message output data must be less than 257 bytes.
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8-2 Edit Message Lists

8-2-1 Display the Send Message and Receive Message Lists
Use the following procedure to display a message within a protocol.

1, 2, 3... 1. The send message list and receive message list are listed in the left and right
pane of the window following all the sequences.

2. Left-click on the send message or receive message list icon in the left pane
to show all messages within a message list. Alternatively, double-left-click
on the send message list or receive message list icons. Messages are listed
in the right pane of the window.

8-2-2 Rename Messages in the List
Use the following procedure to rename a message in the send or receive
message lists. Messages belonging to ‘System’ type protocols cannot be
changed.

1, 2, 3... 1. Double-left-click on the Message Name setting to be renamed from the
message list. Alternatively, select the Message Name setting and press
Return or select Field from the Edit menu or press Alt+E followed by F. The
current message name becomes an editable field.

2. Type in a new name for the message and press Return or select Accept from
the Edit menu, or press Alt+E followed by A. It is possible to select a portion
of the current message name and overtype. The new message name must
not exceed 10 characters.

8-2-3 Cut/Copy/Paste Messages in a Message List
Use the following procedure to copy a message. Messages within ‘System’ type
protocols can be copied, but the protocol type changes to ‘User’ once pasted
into a message list.

1, 2, 3... 1. Select the icon of the message to be copied, either from the send message
list or the receive message list. More than one message can be selected by
pressing Shift and selecting another message to extend the selection, or by
pressing Ctrl and selecting another message to add to the selection.

2. Select the Copy button from the Toolbar or press Ctrl+C or press Alt+E
followed by C. Alternatively, select Copy from the right mouse button dialog
or select Copy from the Edit menu.

3. Select a message list or display the messages in the right pane, to which the
copied message or messages are to be pasted.
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4. Select the Paste button from the Toolbar or press Ctrl+V or press Alt+E
followed by P. Alternatively, select Paste from the right mouse button dialog
or select Paste from the Edit menu. The pasted messages are placed at the
end of the associated message list.

Ensure that another Copy or Cut operation does not take place during this proce-
dure as this erases the current copy operation.
Use the following procedure to cut a message. Messages within ‘System’ type
protocols cannot be deleted.

1, 2, 3... 1. Select the icon of the message to be deleted, either from the send message
list or the receive message list. More than one message can be selected by
pressing Shift and selecting another message to extend the selection, or by
pressing Ctrl and selecting another message to add to the selection.

2. Select the Delete button from the toolbar or press Delete or press Alt+E
followed by D. Alternatively, select Delete from the right mouse button
dialog or select Delete from the Edit menu. Select the OK push-button from
the confirmation dialog to confirm deletion or the Cancel push-button to
cancel the deletion.

A message can also be deleted by selecting the Cut button from the Toolbar or
pressing Ctrl+X or press Alt+E followed by T. Alternatively, select Cut from the
right mouse button dialog or Cut from the Edit menu. Select the Paste button
from the Toolbar or press Ctrl+V , or press Alt+E followed by P to retrieve the last
delete action using the Cut operation. Alternatively, select Paste from the right
mouse button dialog or select Paste from the Edit menu. The pasted messages
are placed at the end of the message list.

8-3 Edit a Receive Matrix
Use the procedures described in the following paragraphs to set a receive matrix
when more than one received message is expected and the next process is to be
changed for each receive message.

8-3-1 Display a Receive Matrix
Use the following procedure to copy a message in a receive matrix case.
Messages within ‘System’ type protocols can be copied, but the protocol type
changes to ‘User’ once pasted into a message list.

1, 2, 3... 1. Double-left-click on the protocol list icon to show all protocols. Alternatively,
select the protocol list in the left pane.

2. Double-left-click on the protocol icon containing the send and receive
message lists, located after the sequences. Alternatively, select the
protocol in the left pane.

3. Double-left-click on the matrix list icon to display the matrix cases in the right
pane. Alternatively, select the matrix list in the left pane.

4. Double-left-click on the matrix cases icon to display the individual cases in
the right pane. Alternatively, select the matrix in the left pane.

8-3-2 Creating a New Case for a Receive Matrix
Use the following procedure to create a new message in a receive matrix.

1, 2, 3... 1. Double-left-click on the matrix list icon. Alternatively, select the matrix list in
the left pane.

2. Select a matrix with the right mouse button and select Create Matrix Case.

8-3-3 Specifying a Message in a Receive Matrix from the Receive
Message Lists

Use the following procedure to add a message to a receive matrix.
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1, 2, 3... 1. Double-left-click on a matrix case to show all cases. Alternatively, select the
matrix in the left pane.

2. Double-left-click on a Receive Message setting. Alternatively, select the
Receive Message setting and press Return or select Field from the Edit
menu or press Alt+E followed by F.

3. Select a message from the drop-down list. Select New... from the
drop-down list to create a new receive message, or select Edit... from the
drop-down list to edit an existing receive message. The Message Data
dialog is displayed, as described previously.

8-3-4 Cut/Copy/Paste Cases in a Receive Matrix
Use the following procedure to copy a receive matrix case in a receive matrix list.

1, 2, 3... 1. Select the icon of the case to be copied. More than one case can be
selected by pressing Shift and selecting another case to extend the
selection, or by pressing Ctrl and selecting another case to add to the
selection.

2. Select the Copy button from the Toolbar or press Ctrl+C or press Alt+E
followed by C. Alternatively, select Copy from the right mouse button dialog
or select Copy from the Edit menu.

3. Select a receive matrix or display the matrix case in the right pane, into
which the copied receive matrix case or cases are to be pasted.

4. Select the Paste button from the Toolbar or press Ctrl+V or press Alt+E
followed by P. Alternatively, select Paste from the right mouse button dialog
or select Paste from the Edit menu. The pasted cases are placed at the end
of the associated message list.

Use the following procedure to cut a message in a receive matrix case. Mes-
sages within ‘System’ type protocols cannot be deleted.



8-3SectionEdit a Receive Matrix

192

1, 2, 3... 1. Select the icon of the case to be deleted. More than one case can be
selected by pressing Shift and selecting another case to extend the
selection, or by pressing Ctrl and selecting another case to add to the
selection.

2. Select the Cut button from the Toolbar or press Ctrl+X or Alt+E followed by T.
Alternatively, select Cut from the right mouse button dialog or select Cut
from the Edit menu.

Select the Paste button from the Toolbar or press Ctrl+V or press Alt+E followed
by P to retrieve the last delete action using the Cut operation. Alternatively,
select Paste from the right mouse button dialog or select Paste from the Edit
menu. The pasted cases are placed at the end of the associated matrix case.

8-3-5 Define the Next Case in a Receive Matrix
Use the following procedure to define a new case in a matrix.

1, 2, 3... 1. Select the matrix icon in the left pane, or more than one case in the right
pane or a free area in the cases list of the right pane, with the right mouse
button and select Create Matrix Case....

Use the following procedure to edit the next process.

1, 2, 3... 1. Double-left-click on a matrix to show all cases. Alternatively, select the
matrix in the left pane.

2. Double-left-click on a Next Process setting. Alternatively, select the Next
Process setting and press Return or select Field from the Edit menu, or
press Alt+E followed by F.

3. The Next Process dialog is displayed.

Select the next process from the Jump option buttons. In the event of ‘Goto’
being selected, enter a case number in the corresponding field. An invalid
case number entered in this field results in a Goto statement passing control
to the last case in the matrix.

4. Select the OK push-button to accept the settings, or the Cancel push-button
to leave the settings unchanged.
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SECTION 9
Managing Protocol Data

This section describes how to manage, save, and retrieve protocol data that has been created, and how to transfer the protocol
data to the PLC.

9-1 Import Protocol Data from PSS-Dos Files 194. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
9-2 Transfer Protocol Data Between the Computer and the PSB 195. . . . . . . . . . . . . . . . . . . . . . .

9-2-1 Transfer Data from the Computer to the PSB 195. . . . . . . . . . . . . . . . . . . . . . . . . . . .
9-2-2 Transfer Data from the PSB to the Computer 196. . . . . . . . . . . . . . . . . . . . . . . . . . . .
9-2-3 Display Data on the PSB 197. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

9-3 Compare Protocol Data 199. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
9-4 Print Protocols 200. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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9-1 Import Protocol Data from PSS-Dos Files
Protocol data from the SYSMAC-PST predecessor application ‘PSS Dos’ can
be imported into SYSMAC-PST by loading PSS-Dos files into SYSMAC-PST
(PSS-Dos files may be loaded into SYSMAC-PST, but the file may not be
changed).
The PSS-Dos application is able to save and retrieve many types of files. These
files are listed as follows, and are opened in SYSMAC-PST as a Project so that
protocol data may be copied.

Type of PSS-Dos file File extension

PSS-Dos Protocol files *.pts

A PSS-Dos Protocol file *.pt1

PSS-Dos Trace files *.ptr

Use the following procedure to import Protocol data from PSS-Dos files.

1, 2, 3... 1. Select Open from the File menu or click on the Open button from the
Toolbar. Alternatively, a PSS-Dos file can be opened by pressing Ctrl+O or
press Alt+F followed by O.

2. The Open dialog is displayed.

Select a file type from the Files of type: Drop-down list box.
3. Select a file from the Open dialog list that corresponds with the PSS-Dos file

type. The current folder can be changed by selecting another folder from the
Look in: Drop-down list.

4. Click the Open push-button to import a PSS-Dos file with the specified
filename, file type and location. Click the Cancel push-button to close the
Open dialog without opening a project.

The PSS-Dos file that has been opened does not alter in content, and is made
into a project with the exception of a PSS-Dos trace file. For instance, opening a
PSS-Dos protocol file in SYSMAC-PST, a new project is created containing that
protocol, with heading details from the *.pt1 file within the project properties.
PSS-Dos trace files must be uploaded to a project, refer to Section 10 Trace/
Monitor although they can be viewed when opened as part of a SYSMAC-PST
project.

Note The setting data imported from the PSS system setting file cannot be copied to
another communications port.
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9-2 Transfer Protocol Data Between the Computer and the
PSB

In order to transfer protocol data between the computer and the PSB, ensure
that the computer is connected to a PLC, and that configuration and communica-
tion settings are correct. Refer to Section 6. Hardware Configuration for details.

9-2-1 Transfer Data from the Computer to the PSB

Caution Confirm safety at the destination node before transferring a protocol to another
node or editing the I/O area. Doing either of these without confirming safety may
result in injury.

Caution Confirm that no adverse effect will occur in the system before changing the oper-
ating mode of the PLC. Not doing so may result in an unexpected operation.

Caution Check the user protocol for proper execution before actually running it in the
Unit. Not checking the protocol may result in an unexpected operation.

Use the following procedure to download protocols to the PSB from the comput-
er.

1, 2, 3... 1. Double-left-click the protocol list icon to list the protocols in the right pane.
Alternatively, select the protocol list in the left pane.

2. Select a protocol to download. Multiple protocols can be selected for
printing by pressing Shift and selecting another protocol to extend the
selection, or by pressing Ctrl and selecting another protocol to add to the
selection.

3. Select the Download Protocols button on the toolbar. Alternatively, select
Download Protocols To PSB from the File menu, or press Alt+F followed by
D. The Protocol Download To PSB dialog is displayed.

4. Prior to download, a password can be applied to protect the protocol. Select
the Password Protection Required check box to enable password
protection. Enter a password in the Password field (up to eight characters).
Enter the password in the Confirmation field to confirm the action.

5. Click the OK push-button to accept the settings and download the protocol.
Click the Cancel push-button to close the dialog without changing the
settings.

6. If the protocols already in the PSB are password protected, the user is
required to enter the password before the new protocols can be
downloaded.

The downloading of protocols to the PSB can be dependent on the capacity limit
of the PSB. To reduce the size of protocol data downloaded to the PSB, ensure
the Include Protocol Source field of the Protocol Download To PSB dialog is not
set. The amount of protocol data to be downloaded can be analysed via the Ob-
ject Code Size dialog.
Use the following procedure to analyse the amount of protocol data to be down-
loaded to the PSB.
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1, 2, 3... 1. Select the Object Code Size button from the toolbar. Alternatively, select
Display Object Code Size from the File menu or press Alt+F followed by B.

2. The Object Code Size dialog is displayed.

All the protocols within the protocol list are listed in this dialog. Select a protocol.
Multiple protocols can be selected by pressing Shift and selecting another proto-
col to extend the selection, or by pressing Ctrl and selecting another protocol to
add to the selection. As the number of protocols selected increases, the Object
code size field and the PSB Memory progress indicator updates to provide a to-
tal amount to download. When the amount nears the PSB limit, the red box by
the progress indicator illuminates.

3. To reduce the size of protocol data downloaded to the PSB, ensure the
Include Source field is not set.

Note To reduce the protocol data size to be transmitted to the PSB, turn off
the check mark in the [Include Source] box. Once the [Include
Source] box is turned off, protocol data cannot be read from the PSB.

4. On completion, select the Close push-button. A download to the PSB can
now take place.

Note IF ‘Invalid’ appears in the Obj (byte) or Obj+Src (byte) values, the object could
not be created.

9-2-2 Transfer Data from the PSB to the Computer
Use the following procedure to upload protocols to the computer from the PSB.

1, 2, 3... 1. Double-left-click on the devices icon.

2. Double-left-click on the associated PLC icon.

3. Select the PSB icon with the right mouse button and click on the Upload
Protocols From PSB option or select Upload Protocols From PSB from the
File menu, or press Alt+F followed by U.
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4. If the protocol data was originally downloaded with password protection, the
password must be entered in the PSB Password dialog prior to upload.

“Uploading Protocol from PSB” will be displayed in the status bar. Once upload-
ing is completed, uploaded protocols are uploaded into a new project window.
Uploaded data cannot be directly edited but instead can be pasted into a project
for editing. The uploaded information is saved as an Uploaded Protocol Data file
and can be opened at a later time in the same manner as a project.

Caution If the data format of each message item is set to the control code/ASCII format,
that portion will be displayed in the hexadecimal format when the protocol is read
from the PSB to the personal computer.
Example: “1” when read to a personal computer: [31]. . . . . . . . . . .

SOH when read to a personal computer: [01]. . . . . . . . . . . . . . . . . .

9-2-3 Display Data on the PSB
Use the following procedure to display protocol data within the PSB.

1, 2, 3... 1. Double-left-click on the devices icon.
2. Double-left-click on the associated PLC icon.
3. Select the PSB icon with the right mouse button and click on the Display

PSB Protocols option or select Display PSB Protocols from the File menu or
press Alt+F followed by L.

4. The PSB Protocol List dialog is displayed, listing the protocols on the PSB
and the sequence range.
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Click the OK push-button to close the dialog.
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9-3 Compare Protocol Data
Protocol data saved in the computer can be compared with the protocol data that
is stored in a PLC.
Use the following procedure to compare protocol data.

1, 2, 3... 1. Select the Compare button on the toolbar. Alternatively, select Protocol
Compare from the File menu or press Alt+F followed by T.

2. The Compare dialog is displayed.

Select the Open 1... push-button on the left side of the dialog or press Alt+1 to
open a project to compare. Alternatively, select the System Protocols
push-button or press Alt+S to open the predefined coded system protocols.

3. If the Open 1... push-button is selected, the Open dialog is displayed.
Select a project to open. Refer to Section 5 Project Creation and Display for
instructions on how to open a project. The protocols within the opened
project are listed on the left side of the dialog.

4. Select the Open 2... push-button on the right side of the dialog or press Alt+2
to open a project to compare against the first, ensuring the project names
are the same. Alternatively, select the Upload PSB Protocols push-button
or press Alt+U to open the protocols from the PSB (refer to Section 9-3
Transfer Protocol Data Between the PLC and the PSB for further
information).

5. If the Open 2... push-button is selected, the Open dialog is displayed.
Select a project to open. Refer to Section 5 Project Creation and Display for
instructions on how to open a project. The protocols within the opened
project are listed on the right side of the dialog.

6. Set the Ignore Source Information check box or press Alt+I to exclude
source information, such as meaningful names specified to protocols, as
part of the comparison. Set the Ignore Protocol Type (System/User) check
box or press Alt+T to exclude the protocol type as part of the comparison (for
instance, a system protocol that is copied as a user protocol with identical
content would be raised as a difference if this check box was not set).

7. Select the Compare push-button or press Alt+M to compare the two sets of
protocols. The results of the comparison are displayed within the Compare
dialog.

8. Select the Close push-button or press Alt+C to close the dialog.
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9-4 Print Protocols

Protocols can be printed directly from the Protocol Support Software. Use the
following procedure to print a protocol.

1, 2, 3... 1. Double-left-click the protocol list icon to list the protocols in the right pane.
Alternatively, left-click the protocol list icon in the right pane.

2. Select a protocol to print. Multiple protocols can be selected for printing by
pressing Shift and selecting another protocol to extend the selection, or by
pressing Ctrl and selecting another protocol to add to the selection.

3. If desired, the protocols can be previewed by selecting Print Preview from
the File or pressing Alt+F followed by V. The Preview dialog is displayed

The following functions can be accessed.

• Select the Next Page push-button or Prev Page push-button to navigate
through the pages of the print-out.

• Select the Two Page push-button to view two pages of the print-out at once.
This push-button then changes to the One Page push-button to revert back.

• Select the Zoom In push-button and the Zoom Out to push-button zoom in
and out of the print-out. Once the Zoom In push-button has been selected, the
One Page push-button is disabled until the default size is re-selected using the
Zoom Out pushbutton.

• Select the Close push-button to close the dialog.

4. Select the Print button from the toolbar. Alternatively, select Print from the
File menu or press Ctrl+P or press Alt+F followed by P. It is also possible to
print directly from the Print Preview dialog by pressing the Print
push-button.
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5. The Print dialog is displayed.

Select the printer from the Name: drop-down list. Use the Properties
push-button to display the Properties dialog and configure the specific printer
settings. Set the Print to file check box to create a print file instead of printing
hard copy.

6. Select the required print range.
7. Select the required number of copies from the Number of copies: field and

set the collation method in the Collate check box if two or more copies are to
be printed.

Note The Collate check box is only enabled if supported by the Printer hardware.

8. Click the OK button to print the protocol. Click the Cancel button to close the
dialog without printing the protocol.

Refer to specific Printer documentation for further details on printer
configuration.

Note Message data may extend beyond the printing frame depending on its length. If
this happens, select [Printer Setting] from the [File Menu] and change the print-
ing setting to landscape or change the printer type.
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SECTION 10
Trace/Monitor

This section describes monitoring PLC words and the transmission line tracing.

10-1 Tracing Transmission Lines 204. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-1 Start/Stop a Trace 204. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-2 Read Trace Data from the PSB 205. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-3 Analyse Trace Data 206. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-4 Adding a Trace to a Project 207. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-5 Save Trace Data to File 207. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-6 Retrieve Trace Data 208. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-1-7 Print Trace Data 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

10-2 Monitoring PLC words 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-2-1 Selecting PLC Data Areas 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
10-2-2 Editing PLC Data Area Words 211. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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10-1 Tracing Transmission Lines
Transmission data and transmission signals of up to 670 characters can be
traced to debug sequences.

The following two tracing methods are available.
• Continuous Traces

The trace is executed until stopped. When the trace buffer becomes full during
tracing, data will be discarded starting from the oldest data.

• One-shot Traces
The trace is terminated when the trace buffer becomes full. The entire trace
data from the start of trace remains in the trace buffer.

Trace related flags are listed in the following table.

Type Port Effective
Address

State

Continuous Trace Start/Stop Bit Port A 28902 The continuous trace starts on the rising edge and is
terminated on the falling edge.

Port B 28903
terminated on the falling edge.

This bit is invalid during one-shot traces.

One-shot Trace Start/Stop Bit Port A 28904 The one-shot trace starts on the rising edge and is
terminated on the falling edge.

Port B 28905
terminated on the falling edge.

This bit is invalid during continuous traces.

Trace Execution/Completion Flag Port A 28600 ON: Continuous or one-shot trace being executed.

OFF: One-shot trace stopped by full buffer (whenPort B 28601 OFF: One-shot trace stopped by full buffer (when
One-shot Trace Start/Stop Bit is still on.

Note a) The ON/OFF status of control signals is not sampled accurately.
Use the results as reference only.

b) The ON/OFF status of the RTS, CTS, DTR and DSR signals is
sampled when one character of transmission data is sent or
received. Changes without data transmission or changes during
transmission of one character are not sampled.

c) The ON/OFF status of the CTS and DSR signals may be different
before or after the reception of the finished data of a receive
message.

10-1-1 Start/Stop a Trace
Use the following procedure to start and stop a trace.

1, 2, 3... 1. Double-left-click on the devices icon.
2. Double-left-click on the Current Configuration setting to select a PLC.

Alternatively, select the Current Configuration setting and press Return or
select Field from the Edit menu or press Alt+E followed by F.

3. Select the required PLC from the drop-down list and press Return or select
Accept from the Edit menu, or press Alt+E followed by A.

4. Double-left-click on the associated PLC icon.
5. Double-left-click on the PSB icon.

Select the Trace Memory A icon or the Trace Memory B icon, according to
the PLC setup with the right mouse button and click on Start Trace followed

Tracing Method

Trace-related bits
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by either Continuous or One-shot from the right mouse button dialog.
Alternatively, select the Continuous or One-shot buttons from the toolbar.

The Description setting shows the current activity on the PSB.

Caution Change the operating mode of the PLC only after checking that there will be no
influence on the facility. Changing the mode abruptly can have serious or
unexpected results.

6. To stop a trace, Select the Trace Memory A icon or the Trace Memory B icon
with the right mouse button as in step 5, and click on Stop Trace or select the
Stop Trace button.

Refer to Section 6 Hardware Configuration for further details of PLC Selection.

10-1-2 Read Trace Data from the PSB

Previously traced data can be uploaded from the PSB to the project. Use the
following procedure to read trace data from the PSB.

1, 2, 3... 1. Double-left-click on the devices icon.

2. Double-left-click on the Current Configuration setting to select a PLC.
Alternatively, select the Current Configuration setting and press Return or
select Field from the Edit menu.

3. Select the required PLC from the drop-down list and press Return or select
Accept from the Edit menu, or press Alt+E followed by A.

4. Double-left-click on the associated PLC icon.

5. Double-left-click on the PSB icon.

6. Select the Trace Memory A icon or the Trace Memory B icon, according to
the PLC setup with the right mouse button and click on Upload Trace from
the right mouse button menu or select the Upload button from the toolbar.

Refer to Section 6 Hardware Configuration for further details of PLC Selection.
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10-1-3 Analyse Trace Data
Trace information is displayed to assist debugging sequences once it has been
uploaded (refer to Section 10-1-2 Read Trace Data from the PSB).

• Data displayed above is traced from left to right with the leftmost point being
the trace starting point.

• The numbers 0 to 66 at the top row indicate every 10 bytes.
• The send message is shown above and the receive message below. HEX data

is displayed below the ASCII statement.

• Execution step No. will be displayed. If an error occurs when receiving mes-
sages, either “e” or “f” will be displayed in the step number.

• The RS, CS, ER, and DR signals are indicated in red above the dotted baseline
and in blue below the dotted baseline.

Note The ON/OFF state of the control signal is not sampled correctly. Use the sam-
pling results only for reference. The ON/OFF state of the RS, CS, ER, or DR sig-
nal is sampled when one character of the Send or Receive data is sent or re-
ceived. Changes of signals that are not sent or received or changes in one-char-
acter signals that are sent or received are not sampled.
The ON/OFF state of the CS or DR signal may differ depending on whether the
message transmission has been completed or not.

The information displayed for Send Message (HEX) or Receive Message (HEX)
is colored red if an error has occurred. The RTS, CTS, DTR and DSR signals are
colored blue on the dotted baseline, and red if above it.
Use the following buttons to analyse trace data.
To go to the start of the trace, select the Start of Trace button. Alternatively,
select Start of Trace from the right mouse button menu.
To skip the next full page of trace data from the right, select the Fast Rewind
button. Alternatively, select Fast Rewind from the right mouse button menu.
To step the trace from the right, select the Rewind button. Alternatively, select
Rewind from the right mouse button menu.
To step the trace from the left, select the Forward button. Alternatively, select
Forward from the right mouse button menu.

To skip to the next full page of trace data from the left, select the Fast Forward
button. Alternatively, select Fast Forward from the right mouse button menu.
To go to the end of the trace, select the End of Trace button. Alternatively, select
End of Trace from the right mouse button menu.
The scroll bars at the bottom of the display can also be used to analyse the trace
left and right.
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10-1-4 Adding a Trace to a Project
An uploaded trace can be added to, and be saved as part of a project. Use the
following procedure to add a trace to a project.

1, 2, 3... 1. Upload the trace from the PSB as described in Section 10-1-2 Read Trace
Data from the PSB.

2. The trace is displayed. Click in the trace with the right mouse button and
select Properties. The Trace Properties dialog is displayed.

Enter a meaningful description for the trace and click on the OK
push-button. Click on the Cancel push-button to abort.

3. Select the uploaded trace with the right mouse button and click on Add to
Project. The trace appears in the project Trace list and can be saved with
the project.

10-1-5 Save Trace Data to File
Use the following procedure to save trace data to a file.

1, 2, 3... 1. Select Save As from the File menu, or press Alt+F followed by A.
2. The Save As dialog is displayed.

To ensure only trace data is saved, ensure the Save As type: field is set to
“PSSDOS Trace Files (*.ptr)”. The current folder can be changed by
selecting another folder from the Save in: Drop-down list.
Type a name in the File name: field. Trace data can be overwritten by
selecting any trace data from the Save As dialog list.
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3. Click the Save push-button to save the trace with the specified filename, file
type and location. Click the Cancel push-button to close the Save As dialog
without saving the trace file.
Confirmation is required if a trace file is overwritten. Select the Yes
push-button to overwrite the existing trace file. Select the No push-button to
leave the existing trace file unchanged.

10-1-6 Retrieve Trace Data
Trace data can be retrieved from a file or from a project. Use the following proce-
dure to retrieve a trace from the trace list.

1, 2, 3... 1. Left-click on the project icon to show the name of the protocol list.
2. Double-left-click on the trace list icon.
3. Double-left-click on a trace within the trace list.

Use the following procedure to open existing trace data. Trace data retrieved
from file cannot be added to a project.

1, 2, 3... 1. Select Open from the File menu or click on the Open button from the Tool-
bar. Alternatively, existing trace data can be opened by pressing Ctrl+O, or
press Alt+F followed by O.

2. The Open dialog is displayed.

To ensure only trace data is opened, the Files of type: field is preset to
“PSSDOS Trace Files (*.ptr)”. Select a trace file from the list. The current
folder can be changed by selecting another folder from the Look in: Drop-
down list.

3. Click the Open push-button or double-left-click on the selected file to open
the trace with the specified filename, file type and location. Click the Cancel
push-button to close the Open dialog without opening a trace file.
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Note A *.ptr file can only be opened and added to a project if the session of the project
during which the trace was created is still open. When this session is closed, the
*.ptr file cannot be added to a project.

10-1-7 Print Trace Data
Traces can be printed directly from SYSMAC-PST. Use the following procedure
to print a trace.

1, 2, 3... 1. Double-left-click the trace list icon to list the traces in the right pane.
2. Double-left-click on a trace to display it. A trace can be printed if opened

from file.
3. If desired, the trace can be previewed by selecting Print Preview from the

File menu or press Alt+F followed by V. The Preview dialog is displayed

The following functions can be accessed.
• Select the Print... push-button to amend the setup of the print-out. Refer to

Section 6 Hardware Configuration for further details.
• Select the Next Page push-button or Prev Page push-button to navigate

through the pages of the print-out.
• Select the Two Page push-button to view two pages of the print-out at once.

This push-button then changes to the One Page push-button to revert back.
• Select the Zoom In push-button and the Zoom Out push-button zoom in and

out of the print-out. Once the Zoom In push-button has been selected, the One
Page push-button is disabled until the default size is re-selected using the
Zoom Out push-button.

• Select the Close push-button to close the dialog.
4. Select the Print button from the toolbar.

10-2 Monitoring PLC words
PLC words can be monitored or changed to a new value. This is used to edit or
monitor the message data which is sent from the PLC data memory or received
into the PLC memory.

10-2-1 Selecting PLC Data Areas
Use the following procedure to select a PLC data area for monitoring.
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1, 2, 3... 1. Double-left-click on the devices icon.
2. Double-left-click on the Current Configuration setting. Alternatively, select

the Current Configuration setting and press Return or select Field from the
Edit menu, or press Alt+E followed by F.

3. Select a PLC from the Current Configuration drop-down list and press Re-
turn or select Accept from the Edit menu or press Alt+E followed by A.

4. Double-left-click on the associated PLC icon.
5. Double-left-click on the associated PLC Memory icon. The monitor window

is displayed.

The higher digits of the effective address are listed down the left side of the
tab, with the lowest digit of the effective address displayed along the top.

6. Select the tab for the data area to be monitored, or press Tab or Shift+Tab to
navigate through each tab in-turn. Only data areas available for the chosen
PLC are displayed. Not all PLC’s have EM. The CIO data is displayed initial-
ly.

Note The ranges for the PLC data areas are as follows:

• CIO: 0000 to 0511
• LR: 0000 to 0063
• HR: 0000 to 0099
• AR: 0000 to 0027
• DM: 0000 to 6655
• EM: 0000 to 6143 (if the PLC has EM)
The chosen EM bank number is shown in the corresponding EM tab.
Refer to Section 6 Hardware Configuration for further details of PLC Selection.
It is possible to display more than one data area at the same time. Use the fol-
lowing procedure to display more than one data area at the same time:

1, 2, 3... 1. Open a second monitor window.

Note When opening the second monitor window, if an icon other than the PLC icon or
PSB icon is selected in the left pane (hierarchy screen), an offline condition will
occur and the first window will be closed.
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2. Select the tab for the data area to be monitored, or press Tab or Tab to navi-
gate through each tab in-turn.

3. Select Tile from the Window menu or press Alt+W followed by T.

10-2-2 Editing PLC Data Area Words
Use the following procedure to edit the HEX value of a data area word.

Note ASCII values are read-only.

1, 2, 3... 1. Navigate the monitor window using the scroll bars or press PageUp and Pa-
geDown to display the desired word.

2. Double-left-click on the word or select the word and press Return. The Edit
Data dialog is displayed if the PLC is in Monitor Mode or Program Mode.
Word values cannot be changed if the PLC is offline in Run Mode or the word
is read-only. Refer to Section 6 Hardware Configuration for more informa-
tion about PLC mode selection.

3. Type a new HEX value in the New HEX Value: field.
4. Select the OK push-button to change the word Value or to accept the current

Value. The new value is transferred to the PLC. Select the Cancel push-but-
ton to leave the value unchanged.

WARNING Confirm safety at the destination node before transferring a protocol to another
node or editing the I/O area. Doing either of these without confirming safety may
result in injury.

Caution Confirm that no adverse effect will occur in the system before changing the pres-
ent value of any word in the memory area. Not doing so may result in an unex-
pected operation.
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The cursor keys can also be used to supplement the amendment of PLC data
area words:
• Home. Moves the cursor to column 0. If the cursor is in column 0, the Home

key moves the display to row Address 0000.
• End. Moves the cursor to the end of the current row. If the cursor is already at

the end of the current row, the End key moves the display to the end of the data
area.

• Ctrl+left arrow. Scrolls the display to the left.
• Ctrl+right arrow. Scrolls the display to the right.
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SECTION 11
Help System

This section describes the on-line help services provided with SYSMAC-PST.

11-1 Help by Topic 214. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-1-1 Index 214. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-1-2 Find 215. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-1-3 On-line Help Display 216. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-1-4 Print 216. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

11-2 Context-sensitive Help 217. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-3 About SYSMAC-PST 217. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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11-1 Help by Topic
Procedures for using SYSMAC-PST can be verified using on-line help. Use the
following procedure to use on-line help.

1, 2, 3... 1. Select Help Topics from the Help menu or press Alt+H followed by H.

The Help Topics: SYSMAC-PST Help dialog is displayed. On-line help can
be retrieved from this dialog using the Index and Find tabs.

2. Select the Cancel push-button if necessary to close the Help Topics:
SYSMAC-PST Help dialog.

11-1-1 Index

Use the following procedure to retrieve on-line help from the Index tab of the
Help Topics: SYSMAC-PST Help dialog.

1, 2, 3... 1. Select the Index tab.

2. Enter a text query into the first step field. The second step field is refreshed
according to the query entered in the first step field.

3. Select an entry in the second step field and select the Display push-button,
or double-left-click on the index entry.

4. If an entry is linked to two or more topics, the names of the topics are
displayed in the Topics Found dialog. Select a topic and choose the Display
push-button or double-left-click on the topic.
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11-1-2 Find

Use the following procedure to retrieve on-line help from the Find tab of the Help
Topics: SYSMAC-PST Help dialog.

1, 2, 3... 1. Select the Find tab.

2. Enter a text query into the first step field. The second step field is refreshed
according to the query entered in the first step field. Previous text queries
can be retrieved by selecting from the drop-down list in the first step field.

3. Select a word that matches the query - some words may be automatically
selected. More than one word can be selected by pressing Shift and
selecting another word to extend the selection, or by pressing Ctrl and
selecting another word to add to the selection. The third step field is
refreshed according to the word or words selected. The number of topics
found are shown at the bottom of the dialog.

4. Select a topic from the third step field and select the Display push-button, or
double-left-click on the topic from the third step field. Select the Clear
push-button to restart the find operation.

The Find operation can be enhanced by the use of the Options... push-button
and Rebuild... push-button. Refer to Microsoft Windows 95 documentation for
further information.
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11-1-3 On-line Help Display
Once the desired on-line help topic has been selected, the topic is displayed.

The display has additional operations than can enhance the use of on-line help.
Refer to Microsoft Windows 95 documentation for further information.

11-1-4 Print
An on-line help topic can be printed. Use the following procedure to print an on-
line help topic.

1, 2, 3... 1. Open an on-line topic using a method discussed in this section.
2. Select Print from the File menu in SYSMAC-PST Help or press Alt+F

followed by P in SYSMAC-PST Help.
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3. The Print dialog is displayed.

Select the printer from the Name: drop-down list. Use the Properties
push-button to display the Properties dialog and configure the specific
printer settings.

4. Click the OK button to print the on-line topic. Click the Cancel button to
close the Print dialog without printing a topic.

Refer to specific Printer documentation for further details on printer
configuration.

11-2 Context-sensitive Help
SYSMAC-PST supports the use of context-sensitive help. The relevant on-line
help topic is provided automatically by selecting the current area of the display
responsible for carrying out those actions.

Use the following procedure to access on-line help for the current action.

1, 2, 3... 1. During the course of using SYSMAC-PST, select the Help button on the
toolbar.

2. Select the area of the display to receive on-line help. The relevant on-line
help topic is displayed.

Alternatively, it is possible to access on-line help by selecting the area of display
and pressing F1.

11-3 About SYSMAC-PST
Use the following procedure to view the SYSMAC-PST About box.

1, 2, 3... 1. Select About SYSMAC-PST from the Help menu or select the About button
from the toolbar. Alternatively, press Alt+H followed by A.

The About box is displayed. It provides a copyright statement and version
number of SYSMAC-PST.
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SECTION 12
Troubleshooting

This section describes the symptoms of errors and the methods for handling them.

12-1 Protocol Troubleshooting 220. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-2 Sequence and Step Troubleshooting 221. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-3 Message and Matrix Troubleshooting 222. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-4 Trace Troubleshooting 224. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-5 Monitor Troubleshooting 225. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-6 PLC Troubleshooting 226. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-7 PSB Troubleshooting 227. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-8 SYSMAC-CDM Troubleshooting 228. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-9 Communications Troubleshooting 229. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-10 General Troubleshooting 230. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



12-1SectionProtocol Troubleshooting

220

12-1 Protocol Troubleshooting
The errors described in the following table are associated with protocols. Refer
to Section 12-7 PSB Troubleshooting for errors associated with the transfer of
protocols to and from the PSB.

Error Message/Symptom Cause Action

Maximum protocol reached. Only
20 protocols per project.

The project limit of protocols has
been reached.

Reconfigure the project to ensure
the problem is not encountered in
the future.

No sequence numbers available
within this protocol...

The sequence start and sequence
end of a protocol does not permit
the addition of new sequences.

Increase the range of the
sequence start and sequence end
for the protocol and try again.
Increase the sequence end first.
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12-2 Sequence and Step Troubleshooting

The errors described in the following table are associated with sequences and
their steps.

Error Message/Symptom Cause Action

Channel Number out of range. A Channel Number has been
entered for the Repeat Counter that
is outside the range for the
selected Channel area.

Enter a valid Channel Number.

Combination of Link Channel
Address and Length beyond
selected data area.

The combination of the effective
starting address and the specified
length is beyond the limit of the
selected data area.

Change the starting address and/or
the Length so that they are within
the permitted range.

Communications sequence name
already in use...

A name has been supplied to a
sequence which is identical for an
existing sequence.

Change the sequence name so
that it is unique within the protocol.

Contention Send Request Code not
valid.

The Contention Send Request
Code has been selected but not
entered.

Enter the Contention Send
Request.

Delimiter Send/Receive request
code not valid.

The Delimiter Send Request Code
or Delimiter Receive Request Code
has been selected but not entered.

Enter the Delimiter Send Request
or Delimiter Receive Request
code.

Expression constant out of range. A primary expression constant has
been entered for the Repeat
Counter that is greater than 128.

Enter a valid expression constant.

Goto number too large. An invalid step number has been
specified with the Goto selection for
the Next Process or Error Process.

Enter a valid step number.

Invalid Goto number. A step number has been entered
into the Next setting or Error setting
for a step that does not exist in the
current step list.

Enter a valid step number.

Link Channel Address out of range. Effective starting address out of
permitted range for a selected
area.

Change the effective starting
address so it is within range.

Link Channel Length larger
than 128.

Link Channel Address Length
longer than the maximum of 128
words.

Change the Length so it is within
the permissible range.

Maximum sequence reached. Only
60 Sequences per Protocol.

The protocol limit of sequences has
been reached.

Reconfigure the project to ensure
the problem is not encountered in
the future. For instance, move
sequences to another protocol.

Maximum step reached. Only 16
Steps per Sequence.

The sequence limit of steps has
been reached.

Reconfigure the project to ensure
the problem is not encountered in
the future. For instance, move
steps to another sequence.

Message not selected. The Edit.... setting has been
selected in a Send/Receive
Message reference for a step
without selecting a message.

Select a message first.

Repeat Counter Channel number
out of range.

A channel number has been
entered for the Repeat Counter
Channel that is out of range for the
selected data area.

Enter a valid number.

Repeat Counter constant out of
range.

A value greater than 255 has been
entered for the Repeat Counter
constant.

Enter a valid value.

The sequence number is already in
use by another sequence.

The sequence number specified is
the same as another sequence.

Specify a sequence number not
used by the other sequences in the
protocol.
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12-3 Message and Matrix Troubleshooting
The errors described in the following table are associated with send and receive
messages, and receive matrices.
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Error Message/Symptom Cause Action

Channel Number larger than
selected data area size.

A Channel Number has been
entered for the Variable or Length
that is out of range for the data
area.

Enter a valid Channel Number.

Check Code <c> defined in
message but no check code area
selected.

A Check Code <c> entry has been
made in the Message Data dialog,
but the check code has not been
specified for an appropriate entry.

Specify a Check code area to an
entry.

Expression constant is outside the
permitterd range.

An expression factor has been
entered for the Variable or Length
that is out of range for the selected
address type.

Enter a valid expression.

Expression factor is outside the
permitted range.

An expression factor has been
entered for the Variable or Length
that is outside the range for the
selected address type.

Enter a valid expression.

Inconsistent constant data - setting
message address.

Constant ASCII or Constant
selected for Address <a> but no
valid data entered.

Enter valid data.

Length <l> defined in message but
no length area selected.

A Length <l> entry has been made
in the Message Data dialog, but the
length has not been specified for
an appropriate entry.

Specify a Length area to an entry.

Matrix name already in use... A name has been supplied to a
matrix which is identical for an
existing matrix.

Change the matrix name so that it
is unique within the protocol.

Maximum case reached. Only 16
cases per protocol.

The matrix limit of cases has been
reached.

Reconfigure the project to ensure
the problem is not encountered in
the future. For instance, create a
new protocol for the additional
matrices.

Maximum matrix reached. Only
100 matrices per protocol.

The protocol limit of matrices has
been reached.

Reconfigure the project to ensure
the problem is not encountered in
the future. For instance, create a
new protocol for the additional
matrices.

Maximum message reached. Only
300 messages per protocol.

The protocol limit of Send/Receive
messages has been reached.

Reconfigure the project to ensure
the problem is not encountered in
the future. For instance, create a
new protocol for the additional
messages.

Message name already in use... A name has been supplied to a
message which is identical for an
existing message.

Change the message name so that
it is unique.

The total output message size must
be less than 257 bytes, your
message data contains output data
which is xxx in length...

Message output size exceeds limit. Reduce the size of the output data
for a single message.

The total output size must be less
than 257 bytes, your message
output exceeds this value...

Message output size exceeds limit. Reduce the size of any constants
or reduce unnecessary output data
(variable output expressions must
also be less than 256 characters).

This matrix has the following
references which must be removed
before this object can be deleted or
cut.

Attempting to remove a matrix from
the project that is referred to by
steps within the project.

Check the message references
within each step that refers to each
message. If desired, remove the
step and try again.

This message has the following
references which must be removed
before this object can be deleted or
cut.

Attempting to remove a message
from the project that is referred to
by steps within the project.

Check the message reference
within each step that refers to the
message. If desired, remove the
step and try again.
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12-4 Trace Troubleshooting
The errors described in the following table are associated with tracing.

Error Message/Symptom Cause Action

Connected to a PLC of a different
type to that selected. Proceed with
Trace operation anyway.

Attempting to trace a PLC not
currently selected.

Select the Yes push-button to
continue. Select the No
push-button to abort the operation.
Check the Current Configuration
settings. Check that the correct
PLC is connected.

File is not a valid SYSMAC-PST
Trace file.

Attempting to open a *.ptr file that
does not contain trace information.

Select another *.ptr file.

Start, Stop and Upload Trace
operations disabled on buttons
menu.

The PLC is offline. Re-establish PLC communications
by selecting the Devices icon
followed by the PLC icon or PSB
icon.

There is no Communications Trace
in progress on Port A/B.

Attempting to stop a trace before it
has started for the selected port.

Start a new trace. Check
connections.

There is no Trace data available for
the specified port.

Attempting to access trace data for
a port that has no trace data.

Start a new trace for that port.

Unable to complete a trace. The application ladder has not
been downloaded.

Download the application ladder.

Unable to complete a trace. The correct value has not been set
in the PLC memory.

Set the correct value to the PLC
memory.

Unable to start Communications
Trace on Port A/B.

Attempting to trace from a port
without the expected response.

Try again on the other port. Check
connections.

Unable to Stop Communications
Trace on Port A/B.

Attempting to stop a trace from a
port without the expected
response.

Check connections.

Unable to upload Trace data from
Port A/B.

Attempting to upload a trace
without a response from the PSB.

Check the connections and try
again.
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12-5 Monitor Troubleshooting
The errors described in the following table are associated with monitoring.

Error Message/Symptom Cause Action

Connected to a PLC of a different
type to that selected. Proceed with
Monitor data anyway.

Attempting to monitor a PLC not
currently selected.

Select the Yes push-button to
continue. Select the No
push-button to abort the operation.
Check the Current Configuration
settings. Check that the correct
PLC is connected.

Monitoring cannot be started for the
selected PLC...

Attempting to monitor a selected
PLC not currently connected.

Check the Current Configuration
settings. Check that the correct
PLC is connected.

Unable to edit data. Address is
read-only.

Attempting to edit read-only data. Refrain from editing the data.

Unable to edit data. PLC is in RUN
mode.

Trying to edit data whilst the PLC is
in ‘Run’ mode.

Change the mode of the PLC to
‘Monitor’ or ‘Program’.

Unable to edit data. PLC is offline. Communications have failed. Check PLC connections and try
again.
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12-6 PLC Troubleshooting
The errors described in the following table are associated with the PLC
connection.

Error Message/Symptom Cause Action

An error has occurred in the
Special I/O Units.

PLC error. Refer to the PLC operation
manual.

Batteries are not connected or the
batteries have run out or
discharged.

PLC error. Refer to the PLC operation
manual.

Connected PLC is not a valid type
for use with SYSMAC-PST.

Attempting to connect to a PLC
Type not supported by
SYSMAC-PST.

Connect and select a PLC that is
supported by SYSMAC-PST.

Connected to a PLC of a different
type to that selected. Proceed with
download protocol anyway.

Attempting to download to a PSB
with conflict of selected and
connected PLC.

Select the Yes push-button to
continue. Select the No
push-button to abort the operation.
Check the Current Configuration
settings. Check that the correct
PLC is connected.

No PLC connected. A PLC is not connected to the
computer.

Connect a PLC to the computer.

PLC Error light. PSB RDY light is flashing following
a FAL9C error.

Refer to PLC Operating Manual.

PLC not selected. Attempting to download protocols
to the PSB without selecting a PLC.

Select a PLC.

The cycle time execution of the
program was too long.

PLC error. Refer to the PLC operation
manual.

The I/O table does not match the
actual state of the I/O Units that are
installed.

PLC error. Refer to the PLC operation
manual.

The number of I/O units exceeded
the limit.

PLC error. Refer to the PLC operation
manual.

The PLC cannot be opened. It may
be in use by another application.

Connection has failed. Reboot the computer and try again.

The PLC must be in PROGRAM
mode to download the Protocol to
the PSB...

Attempting to download protocols
to the PSB whilst in ‘Program’
mode.

Select the Yes push-button to
switch the PLC to ‘Program’ mode.

The program contains no END
instruction.

PLC error. Refer to the PLC operation
manual.

The user memory of the PLC
contains an error.

PLC error. Refer to the PLC operation
manual.

There is an error between the CPU
and an I/O Unit.

PLC error. Refer to the PLC operation
manual.

There must be a PLC selected
before any changes may be made
to the communications settings.

Attempting to change
communication settings before
selecting PLC.

Select a PLC and try again.

Unable to establish
communications to the selected
PLC...

SYSMAC-PST cannot
communicate with the selected
PLC.

Check the Current Configuration
settings. Check the PLC
connections.

You must change the ‘PC ↔ PLC
Comms’ Device/CPU type to match
the ‘PLC Current Config’.

The PLC Device Type dialog
settings do not match the Current
Configuration setting.

Change the Current Configuration
settings to match the Current
Configuration settings.
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12-7 PSB Troubleshooting
The errors described in the following table are associated with the PSB
connection and the transfer of protocols to and from the PSB.

Error Message/Symptom Cause Action

Cannot download protocols to the
PSB: Too large Protocol size: xxx,
PSB memory size: yyy.

The protocol data selected for
download to the PSB is in excess
of the capacity of the PSB.

Use the Object Code Size dialog to
monitor the amount of protocol
data to download and try again.
Set the Include Source option to
OFF and then try again.

Error occurred during the upload of
Trace data from the PSB.

Attempting to upload a trace
without the expected response
from the PSB.

Check the connections and try
again.

No connected PSB available... Connection has failed. Reboot the computer and try again.

The PSB does not support the
PMCR instruction.

The PSB firmware does not
support the protocol Macro (PMCR)
instruction. SYSMAC-PST
protocols cannot be downloaded or
executed.

Replace the PSB with a suitable
COM04, COM05 or COM06 model
which supports the PMCR
instruction.

The PSB Protocol password has
not been correctly entered. The
PSB transfer cannot proceed.

The protocol in the PSB has a
password assigned to it. An
incorrect password has been
entered.

To upload the protocol from the
PSB or to download a new protocol
to the PSB, type in the correct
password.

The Upload Protocols from PSB
option does not upload any data.

There are no protocols currently on
the PSB.

No action.

Unexpected delay transferring
protocols to or from the PSB.

Either: more data is being
transferred than was expected;
communications have failed; slow
performance computer.

Disconnect the cable to stop the
transfer.
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12-8 SYSMAC-CDM Troubleshooting
The errors described in the following table are associated with SYSMAC-CDM.

Note SYSMAC-CDM is a communications-associated application software used in
the SYSMAC-PST.

Error Message/Symptom Cause Action

SYSMAC-CDM failed to initialise
correctly - no further PLC
communications may be
performed...

Connection has failed. Reboot the computer and try again.

SYSMAC-CDM has encountered
an internal error condition in trying
to complete an operation.

Connection has failed. Reboot the computer and try again.

SYSMAC-CDM has reported that
the PLC device is currently locked
by another communications activity.

Connection has failed. Exit SYSMAC-PST and check that
no other communications software
is using or locking the PLC. If this
fails, reboot the computer and try
again.

SYSMAC-CDM has returned an
unknown error status.

Connection has failed. Reboot the computer and try again.

SYSMAC-CDM Initialisation Failed. SYSMAC-PST could not initialise
SYSMAC-CDM and the application
and therefore cannot function
properly.
The possible causes are as follows:
1) Path setting of the
communications driver (CDM) is
incorrect.
2) SYSMAC-PST has not been
properly installed or the necessary
files do not exist.
3) If the above items 1) and 2) are
not applicable, the Windows
operating system (file system,
registry, etc.) may have been
destroyed.

Exit the application and try again.
If this fails, reboot the computer
and try again. If the failure persists
reinstall SYSMAC-PST.
1) Check the contents of the
\Windows\Cdm.ini file using a text
editor such as a memo file, change
the PATH entry settings of the
[SYSTEM] section as shown
below, and then start the
SYSMAC-PST.
Contents of the Cdm.ini
(When installed in C:\Program
Files\SYSMAC):
[SYSTEM]
PATH=C:\Program
Files\SYSMAC\CDM
2) Reinstall SYSMAC-PST.
3) Reinstall Windows (or repair it
using a software tool sold in the
market) and then install
SYSMAC-PST.

SYSMAC-CDM is unable to
complete the PLC command
because the PLC is not open, or
because the command is not
supported by the PLC.

Connection has failed. Exit SYSMAC-PST and check that
no other communications software
is using or locking the PLC. If this
fails, reboot the computer and try
again.

Unable to open SYSMAC-CDM
project file. SYSMAC-PST unable
to communicate to PLC devices.
SYSMAC-PST performs automatic
shutdown.

The file pst.cdm is not in the
application folder or pst.cdm is set
as read-only.

Ensure pst.cdm is in the
application folder and is not
read-only. If not, locate pst.cdm
and move back to application
folder. If pst.cdm cannot be found,
reinstall SYSMAC-PST.
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12-9 Communications Troubleshooting
The errors described in the following table are associated with communication
failures and settings.

Error Message/Symptom Cause Action

A message references a link word
not specified in the Link Channel
Information dialog.

Attempting to download a message
in a protocol that references a word
not specified in the Link Channel
Information dialog.

Alter the reference.

A matrix case does not contain a
message reference.

Attempting to download a matrix
case in a protocol that does not
contain a message reference.

Enter a message reference.

Address is larger than the selected
data area size. Enter a value up to
xxx.

Attempting to specify an effective
address that is larger than the data
area.

Specify an effective address not in
excess of xxx.

Cannot select O1 or O2 when
variable type is write.

The address O1 or O2 has been
selected for a Write channel type.
This is not permitted.

Select a different address for a
Write channel type.

Channel number is larger than the
selected data area size.

Attempting to specify a Channel
number that is larger than the data
area.

Specify a channel number not in
excess of xxx.

Combination of address and length
extend beyond the selected data
area.

Attempting to specify a Length or
an effective address that is larger
than the data area.

Specify a length and effective
address not in excess of xxx.

Communications error with the
PLC.

Communications have failed. Reboot the computer and try again.

Length is larger than the maximum
allowed value. Enter a value up to
xxx.

Attempting to specify a Length that
is larger than the data area.

Specify a length not in excess of
xxx.

Matrix case contains non-existent
or invalid message reference.

Attempting to download a matrix
case in a protocol that contains a
non-existent or invalid message
reference.

Modify the reference.

Matrix contains a reference to a
non-existent case in the Next
Process column.

Attempting to download a matrix in
a protocol that contains a reference
to a non-existent case in the Next
Process column.

Modify the reference.

Protocol does not contain any
messages.

Attempting to download a protocol
that does not contain any
messages.

Enter messages in the protocol.

PSB does not support CRC-16. Attempting to download to a PSB
that does not support CRC-16.

Change the check code type or
change PSB for one that supports
this facility.

Sequence does not contain any
steps.

Attempting to download a
communications sequence in a
protocol that does not contain any
steps.

Enter steps into the
communications sequence.

Step does not contain a message
reference.

Attempting to download a step in a
protocol that does not contain a
message reference.

Enter a message reference in the
step.

The PSB does not allow a check
code to appear after a terminator in
a message.

Attempting to download to a PSB
that does not allow a check code to
appear after a terminator in a
message.

Change the order of the message
or change the PSB for one that
supports this facility.
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Error Message/Symptom ActionCause

Unable to determine PLC mode.
Cannot proceed with downloading
protocols to the PSB...

Communications have failed. Check PLC connections and try
again.

You must terminate PLC
communications before the
communications settings for the
PLC may be changed.

Attempting to change
communication settings with a PLC
selected.

Select the OK push-button to
terminate the communications and
change the settings. select the
Cancel push-button to abort the
operation.

12-10 General Troubleshooting
The errors described in the following table are associated with other
miscellaneous items.

Error Message/Symptom Cause Action

Internal application error in file... Internal error. Reboot the computer and try again.
If this fails, reinstall SYSMAC-PST.
If the problem persists, contact the
vendor.

OLE initialisation has failed.
SYSMAC-PST cannot continue.

Microsoft Windows’ OLE (Object
Linking and Embedding) library has
failed to initiate.

Reinstall Windows 95. Reinstall
SYSMAC-PST and try again.

Disk full while accessing xxx. Failure when saving a project file
due to insufficient disk space.

Resave on the hard disk.
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Appendix A
Creating the Protocol Applications

Communication between PLCs via Modems: example
In this chapter, a protocol is created which implements communications between PLCs via telephone line using
modems. The connection structure and the flow of the protocol creation procedure are as shown below:

Connection Structure
PLC PLC

Protocol Creation Procedure

Creating the status transition
chart of communications

sequence.

Disassembling of the process
contents into the sequences and
the steps editable by the Protocol

Support Tool.

Configuring of the communication
messages contents.

Setting the transmission control
mode

Setting the monitor time

Describing the ladder program
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Creating the Status Transition Chart of Communications
Sequence.
When the data sending and receiving between PLCs are conducted via telephone line using modems, the outline
of the communications sequences is as shown below:

PLC PLC

Note The information about the AT commands to be sent to the modem i.e. the initialization command, the dial
command, the escape code sending, the line disconnection command, etc. and the result codes (response)
is described in the manual of the modem in use. The modem used in this example is “MD24FB10V (made by
OMRON)”. AT commands and result codes supported by the modem are listed below.
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• List of Commands Used in This Example

AT command Setting item Settings
Modem initialization
ATE0V0X4\V2\N3%CO*C

Command echo Not availableModem initialization
ATE0V0X4\V2\N3%CO*C
O\X1

Result code display
format

Numerical

Speed display when
connection has been
completed

Available

Busy, dial tone detection Available
Display of error
corrections and
compressed data when
connection has been
completed

Available

MNP setting Available (auto reliable
mode)

MNP class Class 4
V.42 compression, error
setting

Not available

Flow control between
terminal modems

Not available

ER signal control Always ON
Escape code +

Dial command ATDT dial
number

Dial class Tone

Escape signal code
transmission ++++

Mode selection Online mode to escape
mode

Line off command ATH0 Line off

• List of Result Codes

Numerical format Character format Content

0 OK Properly ended

1 CONNECT Connection completed

2 RING Signal receive detection

3 NO CARRIER Line off

4 ERROR Command error

5 CONNECT 1200 Connection to 1,200 bps

6 NO DIAL TONE No-dial-tone detection

7 BUSY Busy detection

8 NO ANSWER No answer detection

9 HAND SET IN USE Busy

234 CONNECT 2400/REL4 Connection to 2400 MNP
class

Disassembling of the Process Contents into the “Sequences”
and the “Steps” Editable by the Protocol Support Tool
The above communications sequences are firstly disassembled into the following sequences by the process
block.

Sequence No. 000: Modem initialization
001: Dial operation
002: Send message/Receive data, Switch modes, Line disconnection

Then the steps are configured for each sequence.



Appendix ACreating the Protocol Applications

234

Sequence No. 000: Modem initialization
Step No. 00

Normal
The system sends the modem initialization command and waits the result code from the modem. Because there is
more than result code, the following receive matrix is set:
0: End for the normal end of the initialization.
4: This is a command error. The cause will be a wrong setup for the initialization command. The abort and the

correct setup for the initialization command are necessary.
Other: Abort.

Note Although the next process of “4” (command error) is same with that of “Other”, it is set as a separate receive
Matrix case. This is because the checking of the matrix number from the flag at an error occurrence allows
the confirmation of the error cause and eases the debugging.

Abnormal
By the setting of the retry count (three times), the system automatically retries the same step up to three times at
the following error occurrences:
• The send finish monitoring time Tfs, the receive wait monitoring time Tr, or the receive finish monitoring time Tfr is

up.
• A transmission error (CIO28304 or 28312 is ON) occurs at the receiving.
• Wrong receive message
• An error occurs in the error check code
If the initialization fails even after the maximum three times of retry, it is handled by the error process.
An error at this stage may be caused by wrong PLC system setup or wrong wiring, which step description cannot
handle. Therefore, the abort is set for this error process.
Sequence No. 000: Modem initialization

Step
No.

Repeat
Counter

Command Retry
Count

Send
Wait

Send
Message

Receive
Message

Response
Notification

Next
Process

Error
Process

00 R/001 Send&Recv 3 -- Initialization
Command

0 End -- -- Abort

4 Abort

Other Abort

Note The partner machine creates similar steps and executes the initialization of the local modem.
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Sequence No. 001: Dial Operation

Normal
When the modem is initialized, the system dials the telephone number and secures the communication line with
the partner PLC. Besides the line connection completion “1 (CONNECT)”, there are several result codes for the
dial command. For example, 7 (BUSY) is the connection failure because of the busy line this case, if the other step
(to redial after one minute) is configured specifying its step number with “goto”, the sequence execution is not
aborted but can be continued.

1 (CONNECT): Line connection completion End
4 (ERROR): Command error Abort4 (ERROR):

Confirm the contents of the dial command setup
6 (NO DIALTONE): No dialtone detected Abort6 (NO DIALTONE):

Confirm the dial type (tone or pulse)
7 (BUSY): Connection failure for the busy line.7 (BUSY):

Redial after one minute Goto01
8 (NO ANSWER): No answer tone detected Abort8 (NO ANSWER):

Confirm if the partner modem is receivable.
9 (HAND SET IN USE): Connection failure for the telephone calling.9 (HAND SET IN USE):

Redial after one minute Goto01
234 (CONNECT 2400/REL4 Line connection completion End

Others Abort

Note In the second and later retry process executions, the send wait time is ignored. Therefore, another step 01 is
created whose send wait time is one minute for the case the result code is 7 (BUSY). Thus the retry process
should not be set in such process that needs to put the send wait time.
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Abnormal
An error cause other than the receive matrix may be caused by wrong modem’s transmission rate or abnormal line
status. Because any step description can not avoid these errors, it is necessary to abort and to confirm the trans-
mission rate and the line condition when the communication fails even in the third retry.
Sequence No. 001: Dial operation

Step
No.

Repeat
Counter

Command Retry
Count

Send
Wait

Send
Message

Receive
Message

Response
Notification

Next
Process

Error
Process

00 R/001 Send&Recv 3 -- Dial
number

1 End -- -- Abort00 R/001 Send&Recv 3 -- Dial
number 4 Abort

-- -- Abort

6 Abort
7 Goto01
8 Abort
9 Goto01
234 End
Other Abort

01 R/001 Send&Recv 3 One
minute

Dial
number

1 End -- -- Abort01 R/001 Send&Recv 3 One
minute

Dial
number 4 Abort

-- -- Abort

6 Abort
7 Goto02
8 Abort
9 Goto02
234 End
Other Abort

02 R/001 Send&Recv 3 One
minute

Dial
number

1 End -- -- Abort02 R/001 Send&Recv 3 One
minute

Dial
number 4 Abort

-- -- Abort

6 Abort
7 Goto02
8 Abort
9 Goto02
234 End
Other Abort
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SendOK Message Sending/Data Receiving, Mode Switch, Line
Disconnection (Sequence No. 002)

Normal
When the connection with the communication partner is established, the system sends the message (SendOK)
and waits the data from the partner machine. The communication partner sends four words data stored in from
DM0100 to DM0105 after the receipt of the “SendOK” message.
When the system receives the four words data, it writes them from DM0200, sends the escape code (+++) after the
end of the receipt. Then, it switches the escape mode to receive AT command from the on-line mode, and sends
the line disconnection command.

Abnormal
Most presumable errors here would be the time-up error of the monitoring time, the receiving error on the transmis-
sion, the wrong message reception, the error check code error. For these errors, the three times of retry process is
set. Further error occurs, the system aborts and checks the modem’s transmission rate and line condition.
Following are both steps configurations:
(The sequence configuration of the sending PLC)
Sequence No. 002:
The message sending/the data receiving, the mode switch, and the line disconnection

Step
No.

Repeat
Counter

Command Retry
Count

Send
Wait

Send
Message

Receive
Message

Response
Notification

Next
Process

Error
Process

00 R/001 Send&Recv 3 -- SendOK Writing from
DM0200
(W(1), 8)

-- Next Abort

01 R/001 Send&Recv 3 -- Escape code 0 (result
code)

-- Next Abort

02 R/001 Send&Recv 3 -- Line
disconnection
command

8 (result
code)

-- End Abort
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(The sequence configuration of the receiving PLC)

Sequence No. 000: The message receiving/the data sending

Step
No.

Repeat
Counter

Command Retry
Count

Send
Wait

Send
Message

Receive
Message

Response
Notification

Next
Process

Error
Process

00 R/001 Recv 3 -- -- SendOK -- Next Abort

01 R/005 Send 3 -- Contents of
four words
starting from
DM0200
(R(1), 8)

-- -- End Abort

Configurating the Communication Messages Contents
For the communication messages setup, the send and receive data storing mode and the message format are
necessary to be set up.

The Send and Receive Data Storing Mode
There are four kinds of modes as the send and receive data storing modes as follow:

• Constant addressing

• Operand addressing (with/without response method)

• Link word addressing

• Direct addressing

In this example, each mode is differentiated according to the features of communication data as follows:

Communication Data Feature Storing Method

Initialization command It is directly set up in the message due to no need to
change during the same modem use.

Constant addressing

Dial command It is desirable to be dynamically set up for the possible
change in accordance with the environment.

Operand addressing

Send data (SendOK) It is directly set up in the message due to no need to
change.

Constant addressing

Five words of send data It is desirable to be dynamically set up for the possible
change in accordance with the environment.

Operand addressing

Receive result code It is directly set up in the message due to no need to
change during the same modem use.

Constant addressing

Message Format
In the modem control procedure, the communication is done by the instruction (AT command) from a terminal (the
PLC in this example) and the modem’s response (result code) to the instruction. Because AT commands and the
result codes consist of a character string delimited by CR and CR/LF, the message format is as follows:
Data + Terminator (CR or CR/LF)

Note The header, the address, the length, and the error check code are not set.

• Constant addressing

In the constant addressing communication message, CR or CR/LF shall be set after the initialization command,
the send data (SendOK), the receive result code, etc.

Example of the initialization command setting:

ATEOVOX4\V2\N3%CO*CO\X1+CR or CR/LF

AT command
Terminator



Appendix ACreating the Protocol Applications

239

Example of the sent data (SendOK) setting:

SENDOK+CR or CR/LF

SENDOK
(Message)

Terminator

Example of the result code setting:

1+CR or CR/LF

Result code

Terminator

• Operand addressing
For the operand addressing communication data, the communication data must be stored in the area set by the
PMCR instruction after PMCR instruction specification (the both beginning word numbers of the send data storing
and the received data storing) are determined. The configuration of the operand addressing communication data
used in this example is as follows:
Example of the dial command setting:
• The send message content to be described in the step No. 00 to 02 of the sequence No. 001 for the PLC which

sends SendOK message

(R(1), 16) + CR or CR/LF

Number of bytes
to be sent

Terminator

The beginning word to be sent (CH (DM0010)+1CH
addressed by the second operand of the PMCR instruction)

Read option (non-conversion, forward direction)

• Actual data sent and stored in the addressed word

DM0010
0009
9

DM0011
4154
AT

DM0012
4454
DT

DM0013
3033
03

DM0014
2D30
--0

DM0015
3132
12

DM0016
332D
3--

DM0017
3435
45

DM0018
3637
67

Set in the first word is the total number of words of the data to be sent

Example of the setting for four-word receive data stored in DM0201
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• The received message described in the step No. 00 of the sequence No. 002 for the PC which sent the SendOK
message.

(W(1),8) + CR or CR/LF

Number of received bytes
Terminator

The beginning word received (CH (DM0020)+1CH addressed
by the third operand of the PMCR instruction)

Read option (non-conversion, forward direction writing)

• The received data actually written in the addressed word

DM0200
0005

DM0201
3130
10

DM0202
3135
15

DM0203
3230
20

DM0204
3532
52

Number of words to be received (set automatically)

5

Example of setting for four words data sending:
• The send message described in the step No. 01 of the sequence No. 000 for the PC which receives SendOK

message

(R(1),8) + CR or CR/LF

Number of bytes
to be sent

Terminator

The beginning word to be sent(CH (DM0100)+1CH
addressed by the second operand of the PMCR instruction)

Read option (non-conversion, forward direction)

• The send data content to be actually stored in the addressed word

DM0100
0005

DM0101
3130
10

DM0102
3135
15

DM0103
3230
20

DM0104
3532
52

Set the total number of words of the data to be sent

5

Setting the Transmission Control Mode
“Modem Control” is specified as the transmission control mode for the one-to-one communication between PLCs
via modems. The modem control mode is held by the instructions from terminals (PLCs) and the modems’ re-
sponses to the instructions. Those instructions (AT commands) and the responses (result codes) consist in a char-
acter string delimited by delimiters, CR and CR/LF.
For the modem control, the RS/CS flow control or the Xon/Xoff flow control can be set as a flow control. However,
these flow controls are not set in this example, because the communication messages are short.

Note 1. For the details of the setup method for the transmission control modes, refer to 4-3 Transmission Control
Mode Setup.
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2. The protocol is created by Hayes-compatible AT mode in this example, while there are AT mode and
V.25bis mode for the modem control.

Setting Monitoring Time
If the monitor time (the send finish monitoring time: Tfs, the receive wait monitoring time: Tr, and the receive finish
monitoring time: Tfr) has been set, when the send or receive process is not executed in the monitor time, the error
is detected and the process can be switched to the error process or the retry process immediately before the step
finishes (in the send or receive step).
If it is used in the combination with the retry process, when the following retry factors occurred, the step can be
re-executed without any description of the error process and the protocol or the ladder program description can
remarkably be simplified.
• The send finish monitoring time Tfs, the receive wait time Tr, or the receive finish monitoring time Tfr is up.
• A transmission error (CIO28304 or 28312 is ON) occurs at the receiving.
• The received message is different from the setup one.
• An error occurs with the error check code
In this example, the monitoring time is set as shown below. For the calculation method of the monitoring time, refer
to 4-5 Calculation Method of Monitoring Time.

Tr Tfr

Note 1. The retry count can be set only for the step in which Send&Recv command are set.
2. If both the repeat counter and the retry count are set, the counter does not increment while the step is

being retried by the number of the retry count. When the retry factor resolved or the step was executed
by the number of retry count, the counter increments.
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Creating the Ladder Program
The ladder program to execute the created protocol is described and transferred to the PLC. An example of the
ladder program is shown below:

Constant
DM0000

DM0000

DM0010

00102

Dummy channel

Constant

Send initialization command

Execute sequence No. 000 by usingPort A

Send the dial number
Execute sequence No. 001 by using Port A

The beginning word number of the send data

Communication data
Execute sequence No. 002 by using Port A

The beginning word of the received data stored

00101

00100
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Appendix B
PC Setup and PSB Settings

PC Setup
Word(s) Bit(s) Function Default

RS-232C Port Settings (DM 6645 to DM 6649)

The following settings are accessed continually while the PC is ON.
DM 6645 00 to 03 Port settings

0: Standard (1 start bit, 7-bit data, even parity, 2 stop bits, 9,600 bps)
1: Settings in DM 6646

Standard

04 to 07 CTS control setting
0: Disable CTS control
1: Enable CTS control

Disable

08 to 11 Words linked for 1:1 link
0: LR 00 to LR 63; 1: LR 00 to LR 31; 2: LR 00 to LR 15

Maximum PT node number for 1:N NT Link
1 to 7 BCD (1 to 3 with a C200HE-CPUjj-E PC)

LR 00 to LR 63

12 to 15 Communications mode
0: Host link; 1: RS-232C; 2: 1-to-1 link slave; 3: 1-to-1 link master;
4: NT link (1:1); 5: NT link (1:N)

Host Link

DM 6646 00 to 07 Baud rate
00: 1.2K, 01: 2.4K, 02: 4.8K, 03: 9.6K, 04: 19.2K

1.2 K

08 to 15 Frame format
Start Length Stop Parity

00: 1 bit 7 bits 1 bit Even
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit None
03: 1 bit 7 bits 2 bit Even
04: 1 bit 7 bits 2 bit Odd
05: 1 bit 7 bits 2 bit None
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit None
09: 1 bit 8 bits 2 bit Even
10: 1 bit 8 bits 2 bit Odd
11: 1 bit 8 bits 2 bit None

1 start bit, 7-bit
data, 1 stop bit,
even parity

DM 6647 00 to 15 Transmission delay
0000 to 9999: BCD in 10-ms units.

0 ms
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Word(s) DefaultFunctionBit(s)

Peripheral Port Settings (DM 6650 to DM 6654)

The following settings are accessed continually while the PC is ON.
DM 6650 00 to 03 Port settings

0: Standard (1 start bit, 7-bit data, even parity, 2 stop bits, 9,600 bps)
1: Settings in DM 6651

Standard

04 to 11 Reserved ---
12 to 15 Communications mode

0: Host link; 1: RS-232C
Host Link

DM 6651 00 to 07 Baud rate
00: 1.2K, 01: 2.4K, 02: 4.8K, 03: 9.6K, 04: 19.2K

1.2 K

08 to 15 Frame format
Start Length Stop Parity

00: 1 bit 7 bits 1 bit Even
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit None
03: 1 bit 7 bits 2 bit Even
04: 1 bit 7 bits 2 bit Odd
05: 1 bit 7 bits 2 bit None
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit None
09: 1 bit 8 bits 2 bit Even
10: 1 bit 8 bits 2 bit Odd
11: 1 bit 8 bits 2 bit None

1 start bit, 7-bit
data, 1 stop bit,
even parity

DM 6652 00 to 15 Transmission delay (Host Link)
0000 to 9999: in 10-ms units.

0 ms

DM 6653 00 to 07 Node number (Host link)
00 to 31 (BCD)

0

PSB Settings
Word(s) Bit(s) Function Default

PSB Port B Settings (DM 6550 to DM 6554)

The following settings are accessed continually while the PC is ON.
DM 6550 00 to 03 Port settings

0: Standard (1 start bit, 7-bit data, even parity, 2 stop bits, 9,600 bps)
1: Settings in DM 6551

Standard

04 to 07 CTS control setting
0: Disable CTS control
1: Enable CTS control

Disable

08 to 11 Words linked for 1:1 link (Can’t be changed once set in the 1:1 link Master.)
0: LR 00 to LR 63; 1: LR 00 to LR 31; 2: LR 00 to LR 15

Maximum PT node number for 1:N NT Link
1 to 7 BCD (1 to 3 with a C200HE-CPUjj-E PC)

LR 00 to LR 63

12 to 15 Communications mode
0: Host link; 1: RS-232C; 2: 1-to-1 link slave; 3: 1-to-1 link master;
4: NT link (1:1); 5: NT link (1:N); 6: Protocol Macro

Host Link
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Word(s) DefaultFunctionBit(s)
DM 6551 00 to 07 Baud rate

00: 1.2K, 01: 2.4K, 02: 4.8K, 03: 9.6K, 04: 19.2K
1.2 K

08 to 15 Frame format
Start Length Stop Parity

00: 1 bit 7 bits 1 bit Even
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit None
03: 1 bit 7 bits 2 bit Even
04: 1 bit 7 bits 2 bit Odd
05: 1 bit 7 bits 2 bit None
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit None
09: 1 bit 8 bits 2 bit Even
10: 1 bit 8 bits 2 bit Odd
11: 1 bit 8 bits 2 bit None

1 start bit, 7-bit
data, 1 stop bit,
even parity

PSB Port A Settings (DM 6555 to DM 6559)

The following settings are read continually while the PC is ON.
DM 6555 00 to 03 Port settings

0: Standard (1 start bit, 7-bit data, even parity, 2 stop bits, 9,600 bps)
1: Settings in DM 6556

Standard

04 to 07 CTS control setting
0: Disable CTS control
1: Enable CTS control

Disable

08 to 11 Words linked for 1:1 link (Can’t be changed once set in the 1:1 link Master.)
0: LR 00 to LR 63; 1: LR 00 to LR 31; 2: LR 00 to LR 15

Maximum PT node number for 1:N NT Link
1 to 7 BCD (1 to 3 with a C200HE-CPUjj-E PC)

LR 00 to LR 63

12 to 15 Communications mode
0: Host link; 1: RS-232C; 2: 1-to-1 link slave; 3: 1-to-1 link master;
4: NT link (1:1); 5: NT link (1:N); 6: Protocol Macro

Host Link

DM 6556 00 to 07 Baud rate
00: 1.2K, 01: 2.4K, 02: 4.8K, 03: 9.6K, 04: 19.2K

1.2 K

08 to 15 Frame format
Start Length Stop Parity

00: 1 bit 7 bits 1 bit Even
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit None
03: 1 bit 7 bits 2 bit Even
04: 1 bit 7 bits 2 bit Odd
05: 1 bit 7 bits 2 bit None
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit None
09: 1 bit 8 bits 2 bit Even
10: 1 bit 8 bits 2 bit Odd
11: 1 bit 8 bits 2 bit None

1 start bit, 7-bit
data, 1 stop bit,
even parity
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Appendix C
Wiring RS-232C Cable Connectors

See the diagrams for the lengths required in each set.

1, 2, 3... 1. Cut the cable to the required length.

2. Peel the sheath using a razor blade without damaging the shield weaving.

40 mm (RS-232C)

3. Remove the shield using scissors.

4. Peel the core wire of each wire using a stripper.

5. Fold back the shield wire.

6. Wrap aluminum foil tape on top of the folded shield.

Aluminum
foil tape.

Cable Processing (End
Connected to FG)
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Solder as described next.

1, 2, 3... 1. Place a heat-shrinking tube around each wire.
2. Presolder each wire and to its connector pin.
3. Solder each wire firmly in place.

Soldering iron

Heat-shrinking tube
(Internal diameter: 1.5, r=10)

1 mm

4. Move the heat-shrinking tube to the soldered section and shrink the tube by
heating it.

Heat-shrinking tube

Assembling Hood Assemble the connector hood as shown below.

Connected to FG

Aluminum foil tape

Not connected to FG

Soldering
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Revision History

A manual revision code appears as a suffix to the catalog number on the front cover of the manual.

Cat. No. W319-E1-1

Revision code

The following table outlines the changes made to the manual during each revision. Page numbers refer to the
previous version.

Revision code Date Revised content
1 August 1997 Original production
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